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What is Application Builder?

Definition

Application Builder is a graphical software program that enables you to crea
multimedia applications. Callers access these functions by dialing telephon
numbers.

About Application Builder

Use the basic version of Application Builder to create applications that cont
only voice. Use the fax option feature to create applications that contain voi
items, fax items, or a combination of both.

Examples of applications

The following are examples of a voice application and a fax application.

Voice application
A voice application is any application that gives callers information through 
voice recordings only.

An automated attendant is a typical application that you can create in 
Application Builder. This application enables callers to access different peo
or departments through several menu options. The application can also rou
callers to services based on the time of the day or the day of the week.

An automated attendant begins with the following type of greeting: “Welcom
ABC Company. To transfer to our marketing department, press 1. To transf
sales, press 2.” As one of its options, a menu can enable callers to dial a pe
For example, callers hear the following message: “To dial the number of the
person you want to reach, press 3.” After pressing 3, callers hear the follow
message: “Enter the phone number of the person you want to reach, followe
number sign.”
14 CallPilot
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Fax application
A fax application is any application that gives callers information through both 
voice recordings and faxes.

For example, the automated attendant gives callers the option to receive a fax 
showing a map of ABC Company’s location. Callers hear the following 
message: “To receive a map via fax that shows where we are located, press 4.” 
After pressing 4, callers hear a confirmation prompt that describes the fax: “Map 
of ABC Company’s location in New York City.” To select the fax for delivery, 
callers press the appropriate number on their phoneset keypads.

See also

For information about creating applications, see Chapter 2, “Creating 
applications.”
Application Builder Guide 15
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What’s new in this guide

AutoSave

This feature allows you to specify the interval, in minutes, between the 
automatic saving of the application on which you are working. All of the data
saved on the local client machine. To make this application available to new
callers, save it to the server via the toolbar or the File menu.

AutoName

This feature automatically generates a block name when you add that block
your application. The name of the block depends on the type of block being
added.

You can use this command to speed application development or to test call
scenarios. This option is not recommended for inservice applications as the
should use meaningful names to indicate the behavior of that application.

Most recently used files list

This option is located under the File menu and displays the ten most recen
used files.

Cursor keys

The following cursor operations are now supported:

� Page Up

� Page Down

� Page Left

� Page Right

� Home

This list is located under the View menu.
16 CallPilot
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Rotary outputs

Rotary outputs are now shown on the following blocks:

� Menu block

� Thru-dial block

� Password Check block

� Fax Select block

Previously, callers using a rotary dial phoneset were transfered, by default, t
Rotary Dial block if they did not provide input during a call. Administrators c
override this default behavior by reconnecting the Rotary output of each of 
blocks listed above.
Application Builder Guide 17
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Related information products

Introduction

The following list of CallPilot technical documents are stored on the CD-RO
that you receive with your system. You can search the entire suite of 
documentation online, or you can print part or all of a guide. 

Planning and engineering guides

Use these guides before you install CallPilot to help plan your system, and 
plan a migration of data from Meridian Mail to CallPilot. 

Installation and configuration guides

These guides describe how to install hardware and software for the CallPilo
server, client, and desktop messaging. Instructions for configuring the switch
also provided.

Document Title

Planning and Engineering Guide

Meridian Mail to CallPilot Migration Utility Guide

Document Title

200i Installation and Configuration Guide

702t Installation and Configuration Guide

1001rp Installation and Configuration Guide

Desktop Messaging Software Installation and Maintenance Guide
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Administration guides

These guides provide specialized information to help you configure CallPilo
administer and maintain it, and use its features. 

Networking guides

These guides describe how to plan, install, set up, and troubleshoot networ
services. 

Document Title

Getting Started Quick Reference Card

Administrator's Guide

Reporter Guide

Application Builder Guide

Monitoring and Security for the Administrator

Document Title

Network Planning Guide

AMIS Implementation and Administration Guide

Integrated AMIS Implementation and Administration Guide

NMS Implementation and Administration Guide

Enterprise Implementation and Administration Guide

VPIM Implementation and Administration Guide
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End user guides

These guides are intended for end users of CallPilot, such as phoneset use
desktop messaging users.

Troubleshooting reference

This reference provides step-by-step troubleshooting procedures for CallPil

Using the online Help, guides, and tutorials

CallPilot contains three online sources for information:

� Online Help provides brief answers to the questions “What’s this?” and
“How do I...?”

� Online guides provide detailed conceptual information, as well as 
information on how to perform detailed tasks.

� Online tutorials provide a complete product overview, as well as specifi
information on how to use Application Builder.

You can access all information using either the Help menu or Help buttons.

Contacting technical support

Contact your distributor’s technical support organization to get help with 
troubleshooting your system.

Document Title

Multimedia Messaging User Guide

Speech Activated Messaging User Guide

Desktop Messaging Quick Reference Guide

Document Title

CallPilot Troubleshooting Reference
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Contacting Nortel Networks

If you have comments or suggestions for improving CallPilot and its 
documentation, please contact Nortel Networks at the following web addres

http://www.nortelnetworks.com/callpilot_feedback
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Application Builder in a client and server 
environment

Introduction

Before you begin to create applications, you must understand the relationsh
between a client and the server.

Client

You create applications, such as automated attendants, on the PC, which is
called a client. A client runs Application Builder and communicates with the
CallPilot Server. Other clients can also access the server and its application
a result, administrators at other sites can help you to maintain applications.

Server

The CallPilot Server stores all the new applications. 

An application can be opened or used by only one client at a time. If you try
open an application that is already open, the server denies you access and
notifies you that another client is using the application.

In the example on the next page, Client 25 has Application 2051 open, Clien
has Application 1020 open, and Client 3 has Application 2050 open. Theref
Client 8 cannot access Application 2051, Application 2050, or Application 
1020.
22 CallPilot
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What are applications?

Definition

An application contains voice and fax functions that callers can access by di
phone numbers.

Parts of an application

An application is made up of blocks, voice recordings, and faxes.

Blocks
Each block in an application has a specific function. For example, the 
Announcement block provides the primary way to play voice. To build an 
application, arrange the blocks and link them. The combination of blocks cre
the application.

Voice recordings
Callers hear voice recordings as they interact with an application. Add voice
recordings to an application and associate the recordings with blocks.

Faxes
Faxes are files in the application that callers can select and receive. Usually
fax has a voice recording, or confirmation prompt, for identification. For 
example, a recording might say, “ABC Company’s profits for last quarter.” A
faxes and confirmation prompts to an application and associate the faxes a
prompts with blocks.

Call flow

When you look at an application, you see linked blocks. The combined bloc
like a flowchart, show the paths that callers can take through the application
caller’s path is known as the call flow.
24 CallPilot
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How to make applications available to calle rs

Only applications that are in service are available to callers. Before you can put 
an application into service, it must be complete. Test a complete application 
before publishing its telephone number.

To make an application available to callers, follow these steps:

1. Create the application.

2. Ensure all blocks are configured and connected. Pink borders around blocks 
indicate that they require configuration and connection.

3. Put a complete application into service by adding a telephone number, or 
service directory number (SDN), for that application to the SDN Table. Until 
you add an SDN, the application exists only in the system and is not available to 
callers.

4. After you add an application, test it to verify that it contains no errors.

5. Publish the application’s SDN for callers to dial.

See also

For information about blocks, see Chapter 4, “Understanding blocks,”  and 
Chapter 5, “Working with blocks.”

For information about voice recordings, see Chapter 6, “Working with voice 
recordings.”

For information about faxes, see Chapter 7, “Working with faxes.”

For information about the SDN Table and how to give callers access to 
applications, see Chapter 9, “Putting applications into service.”
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Application Builder’s graphical interface

Introduction

Application Builder’s graphical interface can help you to create an applicatio
You can see what the application looks like, and you can drag and drop par
the application.

Main window

Main window elements help you to create an application. For example, 
experiment with moving a Menu block to become familiar with the window.
. 
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Applic ation
The application window is the large white area that covers most of the main 
window.

When you create a new application, the application window displays the 
following default blocks: a Start block, an End block, a Rotary Dial block, a Call 
Transfer block, and three Announcement blocks. These blocks are always 
available.

Blo cks
Blocks are gray squares that represent functions in an application. For example, 
the Menu block lets you give callers different options, such as hearing an 
application in English or French. Add blocks, and then configure and connect 
them to build an application. Some blocks in the application are already 
connected.

Palette
The palette is a group of gray blocks in the left pane of the window. From the 
palette, select blocks and drag them into an application.

Page break
The light gray vertical line on the right side of the window beside the scroll bar 
indicates where a page break occurs if you print the application.

See also

To learn more about creating applications, see Chapter 2, “Creating 
applications.”

To learn more about the main window and its relation to an application, see 
Chapter 3, “Working with applications.”
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Application Builder’s tutorial

Introduction

After you finish reading this chapter, try the Application Builder tutorial.

Where the tutorial is located

You can find the tutorial under the Help menu on the CallPilot Administratio
Client window.

What the tutorial contains

The tutorial provides information, demonstrations, and a practice session to
you learn Application Builder quickly. The tutorial covers these main topics:

� beginning an application

� creating an application

� importing an application

� calling your application
28 CallPilot
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A comparison of Application Builder and 
Meridian Mail Voice Services

Introduction

Application Builder provides the same functions as Meridian Mail Voice 
Services, but in a different package. Application Builder also uses different 
terminology.

Meridian Mail Voice Services

Meridian Mail Voice Services creates services that callers dial. Application 
Builder creates the applications that callers dial.

Controllers

In Meridian Mail Voice Services, controllers are added to voice services and
functions. In Application Builder, blocks have the same role in applications t
controllers provide in Voice Services.

Voice recordings

Meridian Mail Voice Services use two types of voice recordings: prompts an
announcements. You can use a prompt only once. However, you can use a
announcement as many times as needed.

Application Builder uses two types of voice recordings: system prompts and
voice items. 

System prompt
A system prompt is any prerecorded voice that comes with the system. 
“Transferring to an attendant” is an example of a system prompt. 
Application Builder Guide 29
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Voice item
A voice item is a custom recording that you or someone else creates. You can 
use both system prompts and voice items as many times as you want. Therefore, 
you do not have to rerecord voice items.

VSDN Table

In Meridian Mail Voice Services, callers can dial voice services after you add the 
services to the Voice Service Directory Number (VSDN) Table. Similarly, 
callers can dial applications you created in Application Builder and add them to 
the SDN Table. An application becomes a service only when you add the 
application to the SDN Table.

See also

For information about blocks, see Chapter 4, “Understanding blocks.”

For information about voice recordings and how to migrate Meridian Mail Voice 
Services to Application Builder, see Chapter 6, “Working with voice 
recordings.”

For information about the SDN Table, see Chapter 9, “Putting applications into 
service.”
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Running Application Builder

Introduction

Run Application Builder to create custom applications that also link to syste
services for both voice and fax capabilities.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration

To run Application Builder

Double-click Service Administration, and then double-click Application Builder.

To exit from Application Builder

On the File menu, click Exit.
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Showing and hiding parts of the main window

Introduction

When the Application Builder main window appears, all the tools that you n
to build that application appear. By hiding some or all of the tools, the 
application window size increases, making it easier to see the application y
are building.

The basic blocks

Here is an example of the palette showing basic blocks.
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The system blocks

Here is an example of the palette showing system blocks.

Getting there  Exploring - CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder

To show the palette

On the View menu, click Palette to make a check mark appear beside your 
selection. The Palette window appears on the left side of the main window.
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To hide the palette

On the View menu, click Palette to make the check mark beside Palette 
disappear.

To move the palette from the main window

1 In Application Builder, move the cursor over the border of the palette to 
make the cursor change to four arrows.

2 Click and, pressing the mouse button, drag the palette away from its default 
position.

3 Once the palette is moved, release the mouse button.

To return the palette to the main window

Double-click the title bar of the Block Palette pane.

To show the toolbar

On the View menu, click Tool Bar to make a check mark appear beside your 
selection.

To hide the toolbar

On the View menu, click Tool Bar to make the check mark beside Tool Bar 
disappear.

To show page breaks in an application window

On the View menu, click Page Grid.

To hide page breaks in an application window

On the View menu, click Page Grid to make the check mark beside Page Grid 
disappear.
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Changing the size of an application window

Introduction

Change the size of an application window to zoom in and out on parts of an
application. This way, you can focus on the parts you need to see during cre
and maintenance.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder

To view an application window using the full screen

On the View menu, click Full screen.

To shrink the contents of an application window

On the View menu, click Zoom Out.

To enlarge the contents of an application window

On the View menu, click Zoom In.

To restore the contents of an application window to default size

On the View menu, click Zoom Normal.
Application Builder Guide 35



Getting started with Application Builder  Standard 1.0
To set the zoom magnification for an application window

1 On the View menu, click Set Zoom. 

Result: The Set Zoom dialog box appears.

2 In the New Zoom Setting box, type a value between 35 and 100 percent.

3 Click OK to resize the application window and return to the main window.
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Arranging application windows

Introduction

Arrange application windows to help you navigate among multiple applicatio

Stack or tile application windows to see the contents of more than one 
application at the same time.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder

To stack application windows in the workspace

On the Window menu, click Tile.

To overlap application windows in the workspace

On the Window menu, click Cascade.
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Creating applications

In this chapter 
Section A: What kinds of applications can you create? 41

Section B: How to create applications 49

Section C: Guidelines for creating applications 55
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Section A: What kinds of applications 
can you create?

In this section
 Comparing Meridian Mail Voice Services 42

 Application scenarios 45
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Comparing Meridian Mail Voice Services

Introduction

A menu is one of the most common types of applications. If you are familia
with using Meridian Mail Voice Services to create menus, note that Applicat
Builder looks different. Application Builder uses a graphical interface rather
than an interface based on command lines. Application Builder’s screens a
different, too.

Meridian Mail Voice Services interface

To create a menu in Meridian Mail Voice Services, use the three parts of the
a Voice Menu Definition screen.
. 
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Application Builder interface

To create a menu in Application Builder, work in an application window.
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Benefits of Application Builder

Application Builder enables you to do the following tasks:

� Plan online rather than on paper.

� Record voice from within an application.

� See and print the contents of an application.

� Reuse applications in other applications.
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Application scenarios

Introduction

The following scenarios show how you can add functions to an application o
time. The scenarios also show various possibilities for creating applications

In the scenarios, you might notice that some blocks do not appear to conne
Instead, labels appear at the ends of the lines that usually connect blocks. 
labels show where blocks connect and are alternatives to connecting lines.
them to ensure that an application does not look cluttered.

Example: Menu to two departments

You need to set up an application that greets callers and then enables them
transfer to one of two departments: marketing (ext. 7110) or sales (ext. 712
As well, callers must be able to get a detailed help announcement by press
and to transfer to an attendant (ext. 7100) by pressing 0.
. 
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Adding an automated attendant to the menu

After using the application for some time, you decide to make it an auto 
attendant. As a result, during business hours (Monday to Friday, 9:00 a.m. 
5:00 p.m.), callers can reach any department. During nonbusiness hours, c
can leave a message in a general mailbox (ext. 7500).

From the menu, you enable callers to dial employees. A caller can dial an 
employee by extension number or by spelling the person’s name on the pho
keypad.
. 

. 

Adding a fax service that is available during business hours

After your boss’s request, you add a Fax Select block called “directions” to 
application. The fax associated with the block gives directions to the office a
is available only during business hours.
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Adding a main menu

Finally, you build another application that is a menu for your company’s ma
phone number. From the menu, callers can choose between hearing option
English or French.

Into this new application you import the menu that you first created and call
“englishmenu.” You call the French version of this menu “frenchmenu.”
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Section B: How to create applications

In this section
 Before you create applications 50

 What creating applications means 52
Application Builder Guide 49



Creating applications  Standard 1.0

 
ight 
 of 

 
rs 

 do 
ther 

s 

?

Before you create applications

Introduction

Before you begin to create an application, consider both the application’s 
purpose and audience.

Questions to consider

Consider the following questions before you create an application:

� Who will call in to the application?

Design your application based on the callers to your application. Some
callers might access a fax application from a phoneset, while others m
call from a faxphone. So, you must configure the most appropriate type
fax delivery in the application’s session profile. For information about 
session profiles, see Chapter 9, “Putting applications into service.”

� Will some callers have rotary dial phonesets?

Callers who have rotary dial phonesets can get lost in applications that
require dual-tone multifrequency (DTMF) input. Ensure that these calle
can reach a live attendant.

� Will some callers speak a different language?

Give these callers the opportunity to interact with the application in a 
different language if multiple languages are installed on your system.

� Do you need a telephone number or SDN for the application?

For callers to dial an application, it must have an SDN. However, callers
not dial all applications. Callers access imported applications through o
applications. Callers never dial imported applications. Imported 
applications do not require SDNs, but they are part of main application
that do. To identify which applications require SDNs, identify which 
applications callers dial. For information about SDNs, see Chapter 9, 
“Putting applications into service.”

� Do you have sufficient channels for the applications you want to create
50 CallPilot
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Applications use channels for processing. You might need more chann
for a large number of applications to ensure that calls to the applications
not lost.

� What should you name the application?

If possible, give your application a meaningful name, especially if you a
not the only administrator. Do not give applications names that sound a
Also, try to include the same prefix in the names of related applications,
try to keep your prefix short so that the rest of the name is easily 
recognized. For example, you can prefix any accounting department 
applications with “ac.” Then, “acmenu” represents the menu for that 
department.
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What creating applications means

Introduction

You complete six main steps when you create an application. When you cre
an application, you link all its parts, such as blocks, voice recordings, and fa

How you create an application

Each step in application building corresponds to a chapter in this guide. Th
are the steps:

1. Create an application.

2. Assemble the blocks.

3. Record voice

4. Create faxes.

5. Determine whether you can reuse the application.

6. Put the application into service.

7. Maintain the application.

Create an application
When you create an application, you name it and then save it on the server
Chapter 3, “Working with applications,” describes how to name and save file

Assemble the blocks
Blocks are the content of an application. Before you can place a block in an
application, you must understand that block’s function. After placing blocks,
configure and connect them. Associate voice recordings and faxes with blo
when you configure the blocks.

For information about each block’s function, see Chapter 4, “Understanding
blocks.” To find out how to configure and connect blocks, see Chapter 5, 
“Working with blocks.”
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Record voice and create faxes
You can create voice recordings and faxes while the application is open in 
Application Builder. For information about recording voice, see Chapter 6, 
“Working with voice recordings.” For information about creating faxes, see 
Chapter 7, “Working with faxes.”

Determine whether you can reuse the application
Even before you begin to create an application, consider whether you will w
to reuse some of its parts in other applications. Try to allow flexibility for reu
in your application design. For example, you can create an application that e
only for other applications to import. 

At other times, consider reusing functions after you create an application. F
example, you might need to copy some blocks from one application and pa
them into another application.

For information about reusing parts of an application, see Chapter 8, “Reus
existing applications.”

Put the application into service
Before you can test an application, you must add it to the SDN Table. To ad
application to the table, assign a telephone number or SDN to the applicatio
Then, in the session profile, configure how the application behaves. For 
example, configure the type of fax delivery that the application uses. 

To test an application, dial its SDN and use it as a caller would. After you ar
satisfied that the application works properly, make it available to callers by 
publishing its SDN for them to dial.

For information about the SDN Table, the session profile, and testing, see 
Chapter 9, “Putting applications into service.”

Maintain the application
Maintain your applications to ensure they contain up-to-date information. Yo
update applications from either an on-site computer or a remote phoneset. 
maintain applications, you must also back up and restore them and print the
documents.

For more information, see Chapter 10, “Maintaining applications.”
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See also

As you assemble blocks and create voice recordings and faxes, consider th
guidelines for application building. For more information, see Section C: 
“Guidelines for creating applications,” on page 55.
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Section C: Guidelines for creating 
applications

In this section
 Guidelines for applications 56

 Guidelines for menus 58

 Guidelines for voice recordings 59

 Guidelines for faxes 62
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Guidelines for applications

Introduction

To create caller-friendly applications, first consider your audience. The 
following guidelines suggest ways to tailor applications to assist callers.

Identify the application

Include an initial voice recording to identify for callers the application they ha
called and to advise them of what to expect. Callers then know whether the
want to use the application.

For example, a recording can say, “Thank you for calling Goudy’s Departme
Store. Select one of the following options to contact either a department or 
employee.”

Consider rotary dial callers

Callers who use rotary dial phoneset can get lost in applications that allow o
phoneset keypad input. To avoid this problem, provide callers with a way ou
all applications. You can direct such callers to a live attendant or, after hour
a mailbox.

Describe character keys

The character keys on the keypad of a phoneset have various names. Desc
these keys accurately and consistently. Also, use the same descriptions as
services.

� Call the * key “the star key,” not “asterisk.”

� Call the 0 key “the zero key,” not “oh.”

� Call the # key “the pound key” or “number sign” or whatever term is mo
common in your country.
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Denote keys for responses

Applications often require users to give “yes” or “no” responses. In such 
applications, be both consistent and conventional. Use 1 to denote Yes and
denote No.

Provide help

Each application should provide callers with help. Give callers access to 
automated help (a voice recording) or to a live attendant.

Give examples

A description sometimes does not give callers enough information about th
information they must enter. When a description is unclear, follow it with a 
specific example.

For example, suppose that a Thru-Dial block expects callers to enter both 
an area code and a phone number. The voice recording associated with the
should provide an example of which digits to enter: “Please enter the phone
number you want to call, preceded by 1 and the area code. For example, e
1 4 1 6 5 5 5 1 0 0 0.”
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Guidelines for menus

Introduction

In applications, you use menus to provide options to callers. When you pre
options, consider the following guidelines.

Indicate the number of options

Orient callers to a menu to help them know what to listen for and what to exp
The voice recording that introduces a menu should tell callers how many op
they are about to hear.

For example, a recording may say, “Welcome to Landon Offices. Please ch
one of the following five options.”

Give limited options

Callers can recall only a limited amount of information. To prevent overloadi
give callers no more than five options at one time.

Present options sequentially

For callers to select one option easily from several choices, make sure men
present options in sequential order.

Callers can easily select a language from the following menu: “For English,
press 1; for French, press 2; for Italian, press 3; for Spanish, press 4.”

Callers would have difficulty selecting a language from the following menu, 
especially after hearing all the options: “For English, press 2; for French, pr
4; for Italian, press 3; for Spanish, press 1.”
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Guidelines for voice recordings

Introduction

A caller experiences an application only through its voice recordings. Most 
often, you lay out your application and associate recordings with blocks. Th
you write and record the voice. During all three stages, consider the followin
guidelines.

How you put voice in an application

To put voice in an application, you associate it with blocks. When associatin
voice recording with an Announcement block, make the recording interrupti
unless it gives critical information. Interruptible voice enables experienced 
callers to go through an application quickly.

How you write voice

When you write voice recordings, pay attention to how you organize their 
content.

Organize in goal-action sequence
In your voice recordings, identify the result of an action before stating the 
action. To organize the content of a recording in this way, use the goal-actio
sequence. For example, a recording says, “To do x, press y now.”

Use everyday language
In voice recordings, use the language that callers expect. For example, you
call a telephone a telset, but telset is jargon, and jargon confuses callers. U
everyday, familiar language when you write recordings.

Write in the active voice
When you write voice recordings, use the active voice. A voice recording in
active voice is clear: “To reach the Accounting department, press 1.” 

Passive voice confuses callers because it only implies what they should do
reach the Accounting department, the number one key should be pressed.”
Application Builder Guide 59



Creating applications  Standard 1.0

llers 
line” 

ble 

ar 
 the 

lly 

the 

 

d 
 

r to 
. Use 
Make affirmative statements
Write your voice recordings as affirmative statements. Rather than telling ca
to do nothing, tell them to do something. For example, “Please stay on the 
is a better voice recording than “Do not hang up.”

By telling callers what to do, you ensure that negative conditionals and dou
negatives do not appear in your voice recordings.

The following recording has a negative conditional: “If you do not want to he
any more information, press 2.” The “if” makes the sentence conditional, and
“do not” makes it negative.

Double negatives are grammatically incorrect. “Do not do nothing” is an 
example of a double negative. However, by “not” doing “nothing,” you actua
do something.

Give callers useful feedback
Voice recordings should indicate when a selection is incorrect and then list 
valid options from which callers can choose.

If callers press an incorrect key, they do not want to hear “error,” “invalid 
response,” or “unable to process.” None of those recordings indicates what
callers should do next.

How you record voice

Consider the following guidelines when you record voice:

Record in a quiet area
When recording a voice, ensure no noise interferes. Turn off any backgroun
music. Background noise can interfere with callers’ ability to understand the
recording.

Use one professional voice
The voice you record projects your organization’s identity. Consider whethe
use a male or female voice, and whether the voice sounds formal or casual
only one voice per application to project consistency.
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Record all voice during one session
If possible, record all the voice for an application in one session to sound 
consistent. 

Use the same recording device for the voice. For example, use only the pho
or the PC microphone.
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Guidelines for faxes

Introduction

Callers receive hard-copy information from an application through fax. 
Therefore, make sure that all faxes are correct and up to date, and that the
project your organization’s identity. Consider the following guidelines to ens
that faxes include appropriate information.

Include a logo

To help callers recognize and become familiar with your organization, includ
your logo on a cover page.

Include a cover page

Use a cover page to communicate essential information and company iden
You can send a custom cover page with all fax deliveries. The system send
own cover page only for callback fax deliveries.

The system defines what information appears on its cover page. However, 
can put your organization’s logo, address, and phone number on a custom 
page that is included with each fax delivery.

Use the header

The header, or trimtab, of a fax can contain useful information for recipients.
example, the number of the sending fax machine can appear in the header
Recipients can refer to that number if a transmission error occurs.

Leave large margins

Leave larger margins at the top and bottom of fax pages to ensure that 
information does not get cut off during transmission.
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Select an app ropriate typeface

Use a typeface that is easy to read. Avoid decorative typefaces. Do not use a font 
size smaller than nine points.

Check for spelling e rrors

Spelling errors make your organization appear unprofessional. Do a spell check 
on all faxes to ensure they do not contain any errors. 

See also

For information about fax delivery, see Chapter 7, “Working with faxes.”

For information about fax cover pages and session profiles, see Chapter 9, 
“Putting applications into service.”
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Working with applications

In this chapter 
Section A: Working with applications 67

Section B: Working with text notes 77
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Section A: Working with applications

In this section
 Using applications 68

 Creating, saving, and closing applications 69

 Opening applications 72

 Restoring applications 75

 Deleting applications 76
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Using applications

Introduction

When you begin an application, you complete three main steps: you create
you save it, and you close it.

In Application Builder, when you open an application, you also lock it so that
other client can access it. This is different from other parts of CallPilot, whic
allow access by more than one administrator at a time. In Application Builde
you must close an application before others can use it. 

You must know how to restore applications if your client PC or the server 
crashes. You should also know how to delete applications from the server.
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Creating, saving, and closing applications

Introduction

After you create and work with an application, you must save it. When you s
an application, the application transfers from your client PC to the server. A
saved application is different from a complete application. To complete an 
application, you must connect and configure all its blocks. Only complete 
applications are accessible to callers.

Note: After you save a complete application, install it in the SDN Table. The
callers can dial the application.

Identifying applications

When you create an application, you give its file both a name and an ID.

File name
The file name identifies an application by a unique word of up to 60 charact

Example: mainmenu

Application ID
The application ID identifies an application by a unique number ranging from
1000–49 999. This ID enables you to identify an application on your phones
keypad when using Voice Item Maintenance or Fax Item Maintenance.

Example: 1001
When you create an application, Application Builder assigns it the next avail
ID. If you want, you can assign another available ID.

Applications on the server

All applications are kept on the server. However, you use a client PC to wor
an application. When you save an application, it transfers from the client PC
the server.
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Definition: Complete application

An application is complete only when you have connected and configured a
its blocks (saving an application does not ensure it is complete), and no pin
border appears around any block. Only complete applications can be made
available to callers.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder

To create an application

1 On the File menu, click New.

Result: The New dialog box appears.

2 In the File name box, type a unique name that identifies the application.

3 In the Application ID box, type a unique number that identifies the 
application.

4 From the Volume ID list, select the area of the hard drive on which you want 
the application to reside.

5 Click New to create an empty application and return to the main window.
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To save an application

On the File menu, click Save.

To close an application

Close an application after you have finished changing it or looking at its 
configuration. 

On the File menu, click Close.

To unlo ck an application

When you close an application, it unlocks so that others can access and make 
changes to it. You can unlock an application only from the computer or client 
used to open that application.

On the File menu, click Close.

See also

For information about each block, see Chapter 4, “Understanding blocks.”

For information about how to use blocks, see Chapter 5, “Working with blocks.”

For information about how callers begin to access your applications, see 
Chapter 9, “Putting applications into service.”
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Opening applications

Introduction

Open an application to look at it, work with it, or change its configuration. Wh
you open an application, you lock it. This prevents other administrators from
accessing and making changes to it.

Where to open an application

All applications reside on the server. You can open them from a client PC.

What happens when you open an application

When you open or close an application, you cause it to become, respective
locked and unlocked. Only one client PC at a time can open or use a locke
application. When you close the application, the server unlocks it for others
access.

What an open application looks like

Two terms describe an open application:

� application window

� call flow
. 
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Application window
When an application opens, it appears in the application window. 

Call flow
The application window shows the contents of one application. When you lo
at an application, you see linked blocks. Like a flowchart, the linked blocks 
show the paths that a caller can take through the application. A caller’s path
known as the call flow.
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Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder

To open an application

1 On the File menu, click Open.

Result: The Open dialog box appears.

2 Select the file you want to open.

3 Click Open to open the file in the workspace and to return to the main 
window.
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Restoring applications

Introduction

Temporary applications are left on the client PC if either the PC or the serve
crashes. After you recover from the crash, you cannot use those temporary
applications. To use them again, you must restore them on the server.

Effect of a computer crash

All applications reside on the server. From client PCs, you can open and ed
applications. If a client or the server crashes while you are working on an 
application, you lose the connection to the server. A temporary version of th
application remains on the client PC. No one else can open that application
because it is considered locked by that client.

How to restore an application

After you recover from the crash, open Application Builder from the client o
which you were working before the crash. As Application Builder opens, it 
prompts you to restore the application. 

Immediately after the application opens, save it. This transfers the applicati
information to the server and deletes the temporary version that was placed
the client during the crash.
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Deleting applications

Introduction

Delete an application to permanently remove it and its data (for example, vo
items) from the server. You cannot delete a locked application or an exporte
application that is in use by other applications. Also, you cannot delete an 
application that is assigned to an SDN.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder

To delete an application

1 On the File menu, click Delete.

Result: The Delete dialog box appears.

2 Select the name of the application you want to delete.

3 Click Delete to delete the application and return to the main window.
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Section B: Working with text notes

In this section
 Working with text notes 78
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Working with text notes

Introduction

Text notes enable you to include information about parts of an application. 
These notes appear as annotations in an application window and communi
useful information about applications and their parts.

After you create text notes, you can edit, move, and resize them. You can a
change their appearance.

Benefits of text notes

Text notes enable you to do the following tasks:

� Communicate easily with others about an application.

� Recall readily the purpose of blocks and their arrangement.

� Understand quickly an application’s call flow.
. 
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Communicate about applications
You can leave a note to another administrator about changes or problems i
application. You can create a text note to ensure the correct person gets th
information.

Besides communicating specific details about an application, text notes pro
general information, allowing you to share tasks with other administrators. 

Recall block  functionality
Text notes clarify why blocks appear in an application and the reason for th
placement.

Understand call flow
As you create applications, application windows can become cluttered. 
Sometimes the clutter can prevent you from seeing an application’s call flow
Text notes explain both the callers’ path through an application and why the
take that path.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window

To create a text note in an application window

1 On the Edit menu, click Create Text Note.

2 Position the pointer (+) where you want the text note to appear.

3 Click and, keeping the mouse button pressed, drag the pointer to make a 
rectangle.

4 Release the mouse button.

5 Type the text of the note.

6 Click anywhere outside the note to finish creating it.

To edit a text note

1 Double-click inside the text note you want to change.

2 Edit the text.
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3 Click anywhere outside the note to finish editing it.

To change the appearance of a text note

1 Click inside the text note you want to change.

2 On the Edit menu, click Change Text Note Font.

3 From the Font list, select a new font for the text note.

4 From the Size list, select a new size for the text note.

5 When you are finished changing the text note, click OK to return to the main 
window.

Tip:  You can change the appearance of multiple text notes by holding down
Shift key, clicking each note, and then following steps 2 through 5.

To resize a text note

1 Double-click the text note you want to resize.

2 Place the pointer on one side of the box.

3 Drag the side to resize the box.

4 Click anywhere outside the note to finish resizing it.

To move a text note

1 Click a text note and keep the mouse button pressed.

2 Drag the text note to its new location.

3 Release the mouse button.

4 Click anywhere outside the note to finish moving it.

To delete a text note

1 Click a text note.

2 On the Edit menu, click Delete.
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To change the default appearance of t ext notes

1 On the Options menu, click Set Default Text Note Font.

2 From the Font list, select a font for the text note.

3 From the Size list, select a size for the text note.

4 Click OK to change the default text note font and size.

See also

By checking and printing application text notes, you can share information with 
other administrators. For information, see Chapter 10, “Maintaining 
applications.”
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Understanding blocks

In this chapter 
Section A: Introduction to blocks 85

Section B: Basic blocks 93

Section C: System blocks 149

Section D: Imported application blocks 161

Section E: Blocks that work together 165
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Section A: Introduction to blocks

In this section
 What are blocks? 86

 Types of blocks 88

 Parts of blocks 90
Application Builder Guide 85



Understanding blocks  Standard 1.0

ars 

an 
What are blocks?

Definition

A block provides a specific function in an application. For example, the 
Announcement block gives you the primary way to play voice. A block appe
as a gray square with an icon that suggests the block’s function.
. 

Block palette

In Application Builder, most blocks appear on the left side of the window in 
area called the palette. Other blocks appear in applications.
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The palette has one tab for each block type: basic, system, and imported 
application. The third tab appears only in an application that has imported 
another application. To see a type of block, click the corresponding tab.

Some blocks do not appear in the palette because they apply either to all 
applications or to only a few. Instead, these blocks appear in applications 
immediately after you create or export them. For example, the Start and En
blocks must be part of every application and, therefore, appear automatical
when you create an application. Another block, the Continue block, appear
an application only when you export it.
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Types of blocks

Introduction

By adding blocks to an application, you add to its functionality. Blocks help y
to create complex applications, link to existing applications on the system, a
reuse functionality.

Three types of blocks

Choose blocks that add the functions you need to your application. Applica
Builder gives you three different types of blocks: 

� basic

� system

� imported application

Basic blocks
Basic blocks provide general functionality, such as call transfer. For each 
application, you customize the basic blocks. In the case of a call transfer, y
specify the number to which the system redirects calls.

Another example is provided by the Menu block. This block enables you to 
callers options that correspond to the keys on a phoneset. For each key, con
the specific action. For example, the number 1 key might enable callers to d
the extension of their choice.
. . 
. 

System blocks
System blocks represent system applications that have already been create
These applications are known as services. Use these blocks to link your 
applications to services.
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For example, the Express Voice Messaging block transfers callers to the Ex
Voice Messaging service and enables them to leave a voice message in a 
mailbox.
. 

Imported application blocks
Imported application blocks enable you to place applications within other 
applications.

For example, suppose that you create a simple application that has an 
announcement and a menu. While creating another application, you realize
need to use the same announcement and menu. Instead of re-creating them
simply import that application into the current one.
. 
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Parts of blocks

Introduction

When you work with blocks to build an application, you are reminded visua
of the configuration status of each block and the connection options availab

Two parts of a block

A block looks different in an application from the way it looks in the palette.
Once added to an application, a block acquires two parts:

� a pink border

� one or more outputs
. 

Pink border
A pink border appears around each block and indicates that you must conn
configure it. As soon as you connect or configure the block, the border 
disappears. The border shows you that an application is incomplete.

Output
One or more outputs appear on the right side of each block. Some outputs 
text labels. Others are lines with a solid square at the end. Use an output to
connect one block to another one.
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About connecting and configuring blo cks

To work with blocks, connect and configure them. While you need to connect all 
blocks, you only need to configure certain blocks.

Connecting
To connect blocks, attach the output of one block to another block’s input.

A line appears between the blocks and joins them by connecting their output. In 
this way, a line from an output shows which block callers go to next in an 
application.
. 

Configuring
To configure a block, open it, define its parameters, and associate its voice 
recordings and faxes.

See also

For information about connecting and configuring blocks, see Chapter 5, 
“Working with blocks.”
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Section B: Basic blocks

In this section
 Announcement block 94

 Call Transfer block 100

 Date Control block 103

 Day Control block 106

 End block 108

 Fax Select block 110

 Fax Send block 118

 Language Select block 120

 Menu block 122

 Password Check block 127

 Rotary Dial block 132

 Start block 134

 Thru-Dial block 135

 Time Control block 142

 Unavailable block 145
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Announcement block

Purpose

The Announcement block provides the primary way to play a voice recordin
an application.
. 
. 

Example

A company uses the Announcement block in an application to give callers 
information. For example, an announcement tells callers who won prizes in
company lottery.

Setup

You must configure and connect the Announcement block.

Configuring
When you configure the Announcement block, do the following tasks:

� Choose the announcement.

� Determine how many times the announcement plays.

� Define which phoneset keys can interrupt the announcement and whet
those keys should be buffered. 

Connecting
When you connect the Announcement block, you direct callers to their optio
after they listen to or interrupt the announcement.
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Voice recordings

To create an announcement, choose between two types of voice recordings

� system prompt

� voice item

As their name suggests, system prompts exist on the system. They are alre
recorded and are ready to use. Voice items are custom recordings that you 
to meet the needs of your organization.

Available system prompts
If you choose to use a system prompt as the announcement, you can selec
one of the following prompts:
. 

How prompt appears in Application 
Builder

Actual content of prompt

For more information, press star For more information, press star.

Transferring to an attendant Transferring to an attendant. One 
moment please.

For help, press star For help, press star.

Please try again Please try again.

<beep> <<Beep>>

Please contact your administrator Please contact your administrator.

<beep> No operator is available <<Beep>> No operator is available

<beep> That number is busy, try later <<Beep>> That number is busy. Ple
try again later.

<beep> Number cannot be reached <<Beep>> That number cannot be
reached from this service. Please try 
again.
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<beep> Your call cannot be completed <<Beep>> Your call cannot be 
completed at this time. Please try again
later.

<beep> Selection not recognized <<Beep>> That selection is not 
recognized.

<beep> Please make another choice <<Beep>> That selection is not 
recognized. Please make another 
choice.

<beep> Invalid password <<Beep>> That password is incorre
Please contact your administrator for 
assistance.

<beep> Invalid password, try again <<Beep>> That password is incorre
Please try again.

<beep> Invalid password, transferring <<Beep>> That password is incorr
Transferring to an attendant; one 
moment please.

Maximum fax selections reached You have reached the maximum 
number of selections that may be mad
in one call. If you would like to make 
additional selections, please call again

Goodbye Goodbye.

Note: You can customize, or edit, the 
“Goodbye” system prompt by using 
System Prompt Customization.

How prompt appears in Application 
Builder

Actual content of prompt
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Which phoneset keys interrupt an announcement

By default, callers can interrupt an announcement by pressing certain keys
their phoneset. Determine these keys when you configure key handling opt
for an Announcement block. Make sure the appropriate boxes are checked
the keys that should interrupt the announcement.

Key buffering
Key buffering means phoneset menu keys can both

� interrupt an announcement

� act as input for both the Announcement block and the next block, unles
next block is another Announcement block

Menu keys and key buffering
Menu keys are the keys labeled 1–9 on your phoneset. If you configure tha
callers can interrupt an announcement by pressing menu keys, you can als
configure key buffering for them. Key buffering affects the block that comes
after an Announcement block, unless the next block is another Announcem
block.

Key buffering and Announcement blocks
An Announcement block always stops the key buffering initiated by a preced
Announcement block. For example, two Announcement blocks are joined 
together. Both of them can be interrupted by menu keys and have key buffe
configured. A caller can interrupt the first announcement and then be taken
the second announcement. The caller must start listening to the second 
announcement before being able to interrupt it.

Pause before exiting

You can configure that a silent pause follows the last play of the announcem
before taking callers to the next block. Set the duration of the pause, known
the command-entry time out, in the Messaging Administration program. Ma
sure you use the pause only to give callers time to give input or to write dow
information. Otherwise, the pause can frustrate callers.
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Relationship to other blocks

The Announcement block can affect all blocks that follow it and require men
key input. For information about the blocks and key buffering, see “How the
Announcement block works with blocks that require menu key input” on pag
166.

As well, combining the Announcement block with certain other blocks adds
the number of functions available through an application. See “How the 
Announcement, Menu, and Thru-Dial blocks work together” on page 169.

Caller interaction

An announcement may let callers interrupt it. As well, the key that does the
interrupting may be key buffered.
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See also

For information about system prompts, customized system prompts, and voice 
items, see Chapter 6, “Working with voice recordings.”

For information about key buffering and its effect on an application, see “How 
the Announcement block works with blocks that require menu key input” on 
page 166.

YES
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NO

NO

Caller
interrupts the
recording?
(optional)

Key
buffering?

Next block. Attendant, cancel,
or help key.

Menu key.

According to
the menu key,
caller exits the
Announcement

block and the key
is applied to the

next block.

Voice recording
plays for the

specified number
of times.

Which
key did the

caller
press?

YES

NO

Wait for pause.
Pause
before

exiting?
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Call Transfer block

Purpose

The Call Transfer block transfers callers to the default attendant or to an 
extension of your choice.
. 
. 

Example

An application for the help desk of a software company uses the Call Trans
block to transfer callers to a particular member of the support staff.

Setup

You must configure and connect the Call Transfer block.

Configuring
To configure the Call Transfer block, select an optional greeting and specify
number to which callers transfer.

Connecting
To connect the Call Transfer block, designate where callers go if the system
not transfer them successfully.

Default fax delivery

If any faxes have not been delivered by the system, default fax delivery occ
when an application encounters this block.
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Where to transfer callers

You can transfer callers to 

� the default attendant

� a specific extension

Default attendant
If you transfer callers to the default attendant, the system transfers them to
attendant defined in the Messaging Administration program.

Specific extension
If you transfer callers to a specific extension, you enter its number in the 
appropriate box. Ensure the extension exists on the system.

Caller interaction

Unless a call transfers unsuccessfully, callers pass through the Call Transfe
block quickly.
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See also

For information about default delivery, see “Fax Select block” on page 110.

For information about system prompts and voice items, see Chapter 6, “Working 
with voice recordings.”

To configure the Call Transfer block, see “Configuring the Call Transfer block” 
on page 207.

YES

NO

Transfer
successful?

System plays
prompt: "That

number cannot
be reached

from this
service."

System
transfers caller
to extension.

Caller exits the
application.

Line is busy. Transfer fails. Extension
is invalid.

Extension
is restricted.

Next block.

System plays
prompt: "That

number is
busy."

System plays
prompt: "Your
call cannot be
transferred at

this time."

System plays
prompt: "That
number is not

in service."

Voice recording
plays.

(optional)
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Date Control block

Purpose

The Date Control block routes callers to different blocks in an application 
depending on the date.
. 
. 

Example

A university uses the Date Control block in an application to activate certain
functions only during registration week.

Setup

You must configure and connect the Date Control block.

Configuring
To configure the Date Control block, define the date period.

Connecting
To connect the Date Control block, direct where callers go in the application
depending on the date.

Definition: Date period

A date period defines the calendar days during which the application routes
callers to a specific part of an application. Up to five subperiods make up on
date period.
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Date subperiods
A subperiod defines one of the five separate date ranges that make up one
period. Each subperiod consists of both a start date and an end date specif
months and days. For example, a university could define three date subper
one per session, for registration: 

� 01/03 to 01/06 for the winter session

� 05/02 to 05/05 for the spring session

� 09/06 to 09/09 for the autumn session

Inside and outside a date period

When callers access an application, the system compares the current date
the date in each subperiod. If the current date falls on any date within one o
subperiods, then callers access the application inside the date period. If ca
access an application on a date not included in any date subperiod, then th
access the application outside the date period. Calling inside or outside a d
period determines which part of an application callers access.

How to configure a date period

When configuring a date period, you can overlap subperiods, span two yea
and define one-day periods.

Overlapped subperiods
You can overlap the dates specified in subperiods. The block follows the sa
simple rule: if the current date falls into any one of the specified date subper
the date is considered within the date period. Callers exit from the block 
according to the block’s output.

Later begin date than end date
For any subperiod, if the begin date is later than the end date, the block ass
the date range wraps from one year into the next. For example, if a date ran
specifies 22/12 to 3/1, the block checks if the current date falls between 
December 22 and December 31 inclusive or between January 1 and Janua
inclusive. If the date falls within one of those ranges, callers exit the block 
according to the Inside output.
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If the begin date and end date are the same for any subperiod, that subperiod is 
considered one day.

Relationship to other blo cks

You can combine the Date Control with other blocks to define a more specific 
time. For more information, see “How the Time Control, Day Control, and Date 
Control blocks work together” on page 176.

Caller interaction

Callers do not interact with the Date Control block. However, the block affects 
callers because the application routes calls differently on different dates.

See also

To configure the Date Control block, see “Configuring the Date Control, Day 
Control, and Time Control blocks” on page 210.
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Day Control block

Purpose

The Day Control block routes callers to different blocks in an application ba
on the day of the week or whether the day is a holiday.
. 
. 

Example

A bank uses the Day Control block in an application to play a menu that dir
callers to different departments on Mondays through Fridays. On Saturdays
Sundays, and holidays, a greeting about the bank’s hours of operation play
instead.

Setup

You must configure and connect the Day Control block.

Configuring
To configure the Day Control block, indicate whether the day of the week sho
be checked against a holiday schedule.

Connecting
To connect the Day Control block, direct where callers go in the application
depending on whether it is a weekday or a holiday.

Holidays and weekdays

To configure the Day Control block properly, you must understand where 
holidays are defined and how those holidays affect regular weekdays.
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Where holid ays are defined
If you configure the Day Control block to look for holidays, then it checks the 
holiday schedule defined in the Messaging Administration program. In that 
program, an administrator defines which days of the year are considered 
holidays.

How holid ays af fect  weekd ays
A holiday takes precedence over any day of the week. For example, you 
configure an application’s Day Control block to check for holidays. Callers call 
that application on Tuesday, January 1. Because it is New Year’s Day and a 
holiday, callers experience a different application than they would if they called 
on a Tuesday that was not a holiday.

Why the Holid ay output disappea rs

If you configure the Day Control block to not look for holidays in the holiday 
schedule of Messaging Administration, then the block’s Holiday output 
disappears.

Relationship to other blo cks

You can combine the Day Control block with other blocks to define a more 
specific time. For more information, see “How the Time Control, Day Control, 
and Date Control blocks work together” on page 176.

Caller interaction

Callers do not interact with the Day Control block. However, the block affects 
callers because the application routes calls differently on different days.

See also

To configure the Day Control block, see “Configuring the Date Control, Day 
Control, and Time Control blocks” on page 210.
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End block

Purpose

The End block terminates an application. It either

� disconnects callers from an application

or

� transfers callers to a service

To transfer callers from an application to a service, the End block must term
the application.

All system blocks (such as Express Voice Messaging) and some basic bloc
(such as Call Transfer and Thru-Dial) connect to the End block. By default, 
these blocks can connect only to the End block. For these blocks, the End 
transfers callers to the services they represent. 

However, if a block’s connection to the End block is not by default or configu
by you or another administrator, then the End block disconnects callers.
. . 

Setup

You do not configure the End block. Because it is the last block in an 
application, you do not have to connect it to another block.

You cannot cut, copy, rename, or delete the End block. It appears only in ea
application’s window and not in the palette with the rest of the blocks. As w
the End block can appear only once in an application.
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Default f ax delivery

If  any faxes have not been delivered by the system, default fax delivery occurs 
when an application encounters the End block.

Relationship to other blo cks

You can place an Announcement block before the End block to warn callers that 
the application is about to terminate.

The End block works with all the system blocks. See “How the End block works 
with all system blocks” on page 179.

Caller interaction

Callers are unaware of the End block because they do not interact with it.

If no faxes are waiting to be delivered, the system disconnects the call or 
transfers callers when it reaches this block. If faxes are waiting to be delivered, 
the system invokes the default delivery process. For information about default 
delivery, see “Fax Select block” on page 110.
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Fax Select block

Purpose

The Fax Select block has an associated fax that a caller can select for sam
or callback delivery.
. 
. 

Example

A factory outlet store uses the Fax Select block in an application to provide
callers with a map that gives directions to the store.

Setup

You must configure and connect the Fax Select block.

Configuring
To configure the Fax Select block, associate a fax item with it. 

Connecting
To connect the Fax Select block, direct where callers go in the application a
they select the fax or if they reach the maximum number of fax selections.

Definition: Fax item

A fax item contains both a fax and a confirmation prompt.
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Fax
A fax must be in tagged image file format, class F (TIFF-F). You can save fi
in TIFF-F by using Nortel Fax, fax viewing software, and graphics software.
When saving files in TIFF, be aware of its subtypes (for example, class F). N
all subtypes of TIFF are fax-compatible. All TIFF files (regardless of subtype
have a TIF extension (for example, routes.tif).

Confirmation prompt
A confirmation prompt is a voice recording that gives information about a fa
(for example, “Recreational cycling routes for the Greater Metropolitan Area
This prompt can also be recorded via the phoneset. A confirmation prompt m
be in WAV format, even when it is imported. Prompts in the appropriate form
have a WAV extension (for example, cycle.wav). 

Associating fax items

You can associate only one fax item with a Fax Select block. However, you
include more than one fax item in an application. 

Multiple fax items
To put more than one fax item in an application, use multiple Fax Select blo

How the session profile affects fax items

To include fax items in an application, define the application’s fax options in
session profile of the SDN Table. In the session profile, establish settings fo
fax applications and other settings that are specific to fax applications that u
callback delivery.

For all fax applications
In the session profile, establish the following settings for all fax applications

� the maximum number of faxes a caller can select during one call

� the maximum number of fax pages that the system delivers to a caller 
during one call

� the phoneset number of the fax machine that the system uses to send 

� the fax delivery method (callback, same-call, caller’s choice)
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� whether a custom cover page, called a sponsor fax item, transmits with 
fax

� how page transmission errors are handled

For fax applications that use callback delivery
In the session profile, also establish the following settings for fax application
that use callback delivery:

� the DN to which fax callback transmissions are billed

� whether the system cover page transmits with each fax

� the extension number of the fax recipient

� the type (for example, national) of fax machine number for which the 
system must prompt callers so it knows where to deliver faxes

� the restriction/permission list (RPL) against which the fax machine num
must be validated before the system can make a fax callback transmis

Note: If a service includes Fax Select blocks and callback delivery is allowe
then the settings on the General tab for the service override the channel 
allocations set in the SDN Table for the service. 

How an application delivers faxes

To ensure that the system sends faxes to callers according to the type of fa
delivery specified in the session profile, you either

� include the Fax Send block

� use default delivery

Including the Fax Send block
Place and configure the Fax Send block after the Fax Select block. This is t
best method to ensure faxes get delivered.

Using default delivery
Default delivery occurs in an application if faxes are selected and one of the
following events occur:

� a caller hangs up

� an error occurs in the application
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� a caller reaches a Thru-Dial, system, Call Transfer, or End block before
Fax Send block

Example
Suppose that you have an announcement that says, “Thank you for calling.
Goodbye.” This announcement precedes the End block. If callers have sele
faxes and there is no Fax Send block, then the End block activates default 
delivery. As a result, after the “goodbye” message, the system asks callers 
whether they want their selected faxes delivered. 

After callers have heard “goodbye,” they should not be prompted about deliv
This sample application makes more sense to a caller if it does not depend
default delivery. To correct the problem, place a Fax Send block before the 
Announcement and End blocks.

What happens when callers press certain keys

To configure the Fax Select block appropriately, consider its relationship to 
Cancel (#) key and the system prompts that play as a result of callers’ selec
Different prompts play during fax selection or when the application must ve
fax delivery, which is configured in the session profile.

The Cancel key
The Fax Select block does not support the Cancel (#) key. Callers can exit 
block only by selecting the fax, pressing (0) for an attendant, timing out on s
entry, or exiting on some error condition (for example, the fax is already 
selected). 

If callers press the Cancel key for the Fax Select block, the previous promp
replays. However, if callers press the Cancel key while entering an extensio
number for callback delivery, this indicates that they do not want an extensi
number to print on the system cover page.

Delayed prompts
If callers fail to respond when requested to enter an extension number, the 
system does not play prompts. Instead, the system assumes callers do not
to enter an extension number and plays the next prompt.
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The Attendant key
When you configure the Fax Select block, you define whether callers can 
transfer to an attendant by pressing the attendant (0) key during the confirm
prompt for the fax item or one of the menu prompts for the block. When you
enable or disable an attendant, you affect the system prompts that callers h

If you enable an attendant, the “Press 0 for an attendant” system prompt pl
when callers do not give a response or press the Help (*) key. If callers pres
Attendant key, they leave the Fax Select block on the Attendant output.

If you disable an attendant, the “Press 0 for an attendant” system prompt d
not play at any time. Instead, when callers press 0, the following system pro
plays: “That selection is not recognized.”

Relationship to other blocks

Use the Fax Select block with the Fax Send block. For information, see “Ho
the Fax Select and Fax Send blocks work together” on page 173.

You can use the Fax Select block with the Menu block. For example, you ca
attach a Menu block to the Done output of Fax Select. Then, you can give ca
one of the following choices:

� Select another fax by pressing 1.

� Receive the current fax by pressing 2. When callers press 2, they reac
Fax Send block. 

Caller interaction

After callers select a fax, their fax limit and fax delivery setup is checked.
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If the selected fax is the caller’s first fax, then the application verifies fax 
delivery setup, which is configured in the session profile.
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See also

For information about fax items, see Chapter 7, “Working with faxes.”

To understand more about the session profile, see Chapter 9, “Putting 
applications into service.”

To configure the Fax Select block, see “Configuring the Fax Select block” on 
page 215.
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Fax Send block

Purp ose

The Fax Send block delivers selected faxes via same-call or callback delivery.
. . 

Setup

You only connect the Fax Send block. You do not need to configure it.

Connecting
To connect the Fax Send block, direct where callers go in the application if they 
do not select any faxes.

Fax delivery

The Fax Send block delivers faxes using the delivery type configured in the 
session profile.

Relationship to other blo cks

Use the Fax Send block with the Fax Select block. For more information, see 
“How the Fax Select and Fax Send blocks work together” on page 173.

Caller interaction

Callers do not interact with the Fax Send block. Instead, they interact with the 
Fax Select block, which is often used with the Fax Send block.
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See also

For information about the types of fax delivery and how the session profile 
affects the Fax Send block, see Chapter 9, “Putting applications into service.”
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Language Select block

Purpose

The Language Select block changes the current language for all system pro
. . 

Example

An international corporation uses the Language Select block in an applicatio
route callers to human resources information in the language of their choice

Setup

You must configure and connect the Language Select block.

Configuring
To configure the Language Select block, choose the language in which sys
prompts play. More than one language can be ordered and installed on the
system. You can select any installed language.

Connecting
To connect the Language Select block, connect its single output to another 
to direct an application’s flow.

How this block affects an application

The language specified by the Language Select block remains the current 
language until another Language Select block appears in the application. T
current language also affects any imported applications and system service
example, Voice Messaging) that appear after the Language Select block.
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If no Language Select block appears in an application, system prompts play in 
the default prompt language.

Caller interaction

Callers do not interact with the Language Select block. However, all system 
prompts after the block play in the specified language.

See also

To configure the Language Select block, see “Configuring the Language Select 
block” on page 218.
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Menu block

Purpose

The Menu block gives callers choices that correspond to the keys on their 
phoneset.
. 
. 

Example

A department store uses the Menu block to direct callers to departments. F
example, the application directs callers to press 3 to reach Sporting Goods

Setup

You must configure and connect the Menu block.

Configuring
To configure the block, select its voice recordings. The recordings describe
options associated with the phoneset’s keys. The recordings prompt callers
give no response, and notify callers if they press an incorrect key. Select th
maximum number of times that callers can give no response and press inco
keys while in the menu.

Connecting
To connect the block, identify where callers go in the application after they p
a key on the phoneset.

How to make menu keys valid

Menu keys are labeled 1–9 on your phoneset. For callers to use menu keys
keys must be valid. Make a menu key valid by connecting its output to a blo
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If you do not connect a menu key’s output to a block, the application treats 
key as invalid. If callers press an invalid key while in a menu, they hear the 
invalid response prompt.

How to make a menu complete

To make an entire menu complete, you must connect a menu key’s output, 
No Response output, and the Invalid Response output to other blocks.

Voice recordings

You must use three voice recordings with the Menu block:

� menu choices greeting

� no response prompt

� invalid response prompt

There are two types of voice recordings: a voice item and a system prompt
their name suggests, system prompts exist on the system. They are alread
recorded and are ready to use. Voice items are custom recordings that you 
to meet the needs of your organization.

Menu choices greeting
The menu choices greeting describes the menu’s options associated with th
phoneset’s menu keys. You must create a voice item for the menu choices 
greeting.

No response prompt
The no response prompt encourages callers to press a key on the phonese
must create a voice item for the no response prompt.

Invalid response prompt
The invalid response prompt notifies callers when they press an invalid phon
key. You can create a voice item or use the system prompt for the invalid 
response prompt.
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The system prompt is as follows:  

Relationship to other blo cks

The Announcement block can affect menu keys. For more information, see 
“How the Announcement block works with blocks that require menu key input” 
on page 166.

As well, you can combine the Menu block with other blocks. See “How the 
Announcement, Menu, and Thru-Dial blocks work together” on page 169.

Caller interaction

When callers reach the Menu block, they usually press a valid key. However, 
they might give no response or press an invalid key.

How prompt appea rs in  Application 
Builder

Actual content of p rompt

<default system prompt> <<Beep>> That selection is not 
recognized. Please make another 
choice.
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See also

See Chapter 6, “Working with voice recordings” for information about creating 
voice items and using system prompts.

To understand how the session profile affects the Menu block, see Chapter 9, 
“Putting applications into service.”

To configure the Menu block, see “Configuring the Menu block” on page 220.
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Password Check block

Purpose

The Password Check block verifies the passwords entered by callers and g
callers with correct passwords access to the protected areas of the applica
. 
. 

Example

In an application, you can connect a Thru-Dial block that allows internationa
calls to a Password Check block. Only callers who enter the correct passwo
can place international Thru-Dial calls.

Setup

You must configure and connect the Password Check block.

Configuring
To configure the Password Check block, define up to five passwords and se
an optional greeting.

Connecting
To connect the Password Check block, identify where callers go in the 
application if they

� enter a correct password

� enter an incorrect password

� cancel while in the block
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Voice recordings

You can define the greeting that plays when callers reach the Password Ch
block. To create a greeting, choose between two types of voice recordings:

� system prompt

� voice item

As their name suggests, system prompts exist on the system. They are alre
recorded and are ready to use. Voice items are custom recordings that you 
to meet the needs of your organization.

Available system prompt
The system prompt is as follows:
. 

How to define a password

When you define passwords for the Password Check block, consider the 
following guidelines.

Duplication
Use a password only once in the Password Check block. Each password is
associated with one output. As a result, duplicate passwords make the 
application process only the first password that it matches. 

For example, suppose that you enter the same password twice. You conne
first password’s output to the administrators’ area of the application. You 
connect the second password’s output to the managers’ area of the applica
When callers enter the password, the application takes them to the 
administrators’ area of the application since the first matched password pro
that area.

Length
This is governed in Security Administration.

How prompt appears in Application 
Builder Actual content of prompt

<default system prompt> Password?
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Retention
Remember the passwords that you enter in the Password Check block, sinc
appear only as lines of asterisks. You must also communicate the password
the appropriate people.

Invalid password entry limits

Two invalid password entry limits, one defined in the session profile and the
other defined by the Password Check block, protect the application from ha
activity.

Password Check block
The block specifies how many invalid password entries callers can make be
being directed to the Cancel output.

Session profile
The session profile defines the number of invalid password entries that calle
can make during one call session.

Without the session limit, callers can repeatedly try to break past the Passw
Check block. For example, suppose callers exit from the block before they r
the maximum number of invalid password entries. Callers can then reenter 
block, which now has its number of invalid password entries reset to 0. Call
can then try to enter more passwords.
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Caller interaction

The Password Check block behaves differently depending on whether calle
respond, press the cancel key, or enter correct or incorrect passwords.
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See also

For information about system prompts and voice items, see Chapter 6, “Working 
with voice recordings.”

For information about the session profile, see Chapter 9, “Putting applications 
into service.”

To configure the Password Check block, see “Configuring the Password Check 
block” on page 223.
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Rotary Dial block

Purpose

The Rotary Dial block ensures that callers who use a rotary dial phoneset re
live attendant and do not get trapped in the application. All blocks require in
from the keypad of a phoneset (DTMF input). If callers do not give that inpu
they transfer to the Rotary Dial block. 

Application Builder cannot determine whether callers actually have DTMF 
capability. Therefore, if callers do not enter a DTMF response before the fir
time-out period occurs for certain blocks, they transfer, by default, to the Ro
Dial block. The timeout period is set in the Messaging Administration progra
. 

Example

Every application uses the Rotary Dial block. A government application ofte
uses this block, since many callers need government-related information. 
Because of the Rotary Dial block, callers who use a rotary dial phoneset 
eventually reach a live attendant, who transfers their calls to the appropriate
department. 

Setup

You only connect the Rotary Dial block. You do not need to configure it.

Connecting
Connect the Rotary Dial block’s single output to direct application flow. By 
default, this block connects to the Call Transfer block to pass non-DTMF ca
to an attendant. Although you can connect this block to blocks other than th
Call Transfer block, this is not recommended.
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If you connect the Rotary Dial block to another block, make sure rotary dial
callers are eventually routed to a live attendant. You connect a Rotary Dial b
to an Announcement or a Time Control block that precedes a Call Transfer
block. 

You cannot cut, copy, rename, or delete the Rotary Dial block. It appears 
whenever you create an application.

Relationship to other blocks

The first timeout period in an application applies to the following blocks: Fax
Select, Menu, Password Check, and Thru-Dial. Callers exit these blocks on
Rotary output.

Caller interaction

Callers do not interact with the Rotary Dial block. However, this block affects
non-DTMF callers.
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Start block

Purpose

The Start block begins an application by directing its flow.
. . 

Setup

You only connect the Start block. You do not need to configure it.

Connecting
You must connect the Start block’s single output to another block.

You cannot cut, copy, rename, or delete the Start block. As the first block, it
appears only in an application’s window and not in the palette with the rest 
the blocks. The Start block appears only once in an application.

Caller interaction

Callers are unaware of the Start block because they do not interact with it.
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Thru-Dial block

Purpose

The Thru-Dial block provides an automated attendant service that transfers
callers to the extension they choose.
. 
. 

Example

A multimedia company uses the Thru-Dial block to let callers dial employees
name or extension number.

Setup

You must configure and connect the Thru-Dial block.

Configuring
To configure the Thru-Dial block, select a voice recording to play as the 
greeting. As well, define whether callers can specify the person they wish to
by name, extension number, or both. By selecting a restriction/permission l
you determine the type of extension numbers (for example, long distance) t
callers can access.

Connecting
To connect the Thru-Dial block, identify where callers go in the application i
the system cannot transfer them to the specified extension.

Default fax delivery

If any faxes have not been delivered by the system, default fax delivery occ
when an application encounters the Thru-Dial block.
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Types of extension numbers

There are two types of extension numbers: 

� fixed length

� variable length

The first few digits of a fixed-length number are called left-pad digits.

Fixed-length extension numbers
Fixed-length extension numbers have a definite number of digits. For examp
phone number in your dialing area may have seven digits.

Left-pad digits
Typically, fixed-length extension numbers begin with the same digits, called 
pad digits. For example, a company’s main phone number is 686-0000. All 
company phone numbers begin with 686, but have other different digits. The
digits are the left-pad digits.

Variable-length extension numbers
Variable-length extension numbers have an indefinite number of no more th
15 digits. If you define variable-length extension numbers, callers can enter
to 15 digits for an extension number.

Why to use fixed-length digits or left-pad digits

When you define fixed-length extension numbers and their left-pad digits, y
save callers from having to enter prefix digits when they phoneset frequentl
called locations.

For example, the ABC Company’s main phone number is 555-0000. All 
employees at the company have their own phone numbers: Jonah Smith’s 
number is 555-7624; Jessica Freedman’s number is 555-8845. To set up a 
Dial block in a company application, specify that the fixed length number is 
seven. Seven digits make up each phone number. Since each number begin
555, you define those three digits as left-pad. As a result, callers who use th
Thru-Dial block to contact Jonah only enter 7624. Likewise, they only enter 
8845 to reach Jessica.
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Callers can enter some or all of the left-pad digits. If they enter all of Jonah
number, they still reach him. They also reach him if they dial 57624.

How the number sign affects extension numbers

The number sign (#) affects how callers enter both variable-length numbers
fixed-length extension numbers.

Callers must use the number sign to terminate variable-length extension 
numbers. For fixed-length extension numbers, callers can enter fewer digits
if these digits are followed by the number sign.

Restriction/permission list

A restriction/permission list (RPL) limits the numbers that callers can dial fro
the Thru-Dial block. The list governs which thru-dials callers can make from
their local switch. For example, an RPL can prevent callers from placing a l
distance call, even if they enter the correct number.

If a caller enters a restricted number, the block plays a system default error
message and asks the caller to try another number. 

Types of dialing

Callers can dial people by name, extension number, or both.

Name dialing
Name dialing means calling a person by spelling his or her name with the 
alphabet keys on the phoneset keypad.

Number dialing
Number dialing means calling a person by pressing the digits of his or her 
extension number on the phoneset keypad.

Why to use both name and number dialing

You usually configure both name and number dialing. Name dialing ensures
callers can contact people without knowing their extension numbers.
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To dial people by name, callers first enter the telephone number of the Nam
Dialing service. By default, the prefix for this service is 11. The prefix is 
configured in the Messaging Administration program. Ensure that you 
communicate the name dialing prefix in the appropriate voice recording use
with the Thru-Dial block.

Name dialing disabled on the system

The Messaging Administration program determines whether callers can use
name dialing. Therefore, the program can override the dialing options that y
configure for the Thru-Dial block. You need to understand how the override
affects applications that contain the Thru-Dial block.

If callers cannot use name dialing, that configuration in Messaging 
Administration affects two dialing options for the Thru-Dial block:

� name dialing only

� name and number dialing

Name dialing only
If you configure name dialing only for the Thru-Dial block, and Messaging 
Administration does not let callers use name dialing, then callers cannot us
Thru-Dial block. Instead, they hear a prompt when they reach the Thru-Dia
block, and they exit on its Cancel output.

Name and number dialing
If you configure both name dialing and number dialing for the Thru-Dial bloc
and Messaging Administration does not let callers use name dialing, then ca
can use only number dialing with the Thru-Dial block. In turn, the system 
prompt associated with number dialing plays in place of any voice item that
have configured.

Voice recordings

To create a Thru-Dial greeting, you choose between two types of voice 
recordings:

� system prompt

� voice item
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As their name suggests, system prompts exist on the system. They are alre
recorded and are ready to use. Voice items are custom recordings that you 
to meet the needs of your organization.

Available system prompts
If you use a system prompt as the greeting, the prompt that plays depends o
configuration of the Thru-Dial block.
. 

Relationship to other blocks

You can combine the Thru-Dial block with the Announcement and Menu bloc
For more information, see “How the Announcement, Menu, and Thru-Dial 
blocks work together” on page 169.

Caller interaction

Most callers pass through the Thru-Dial block quickly and exit from the 
application. Some callers interrupt the Thru-Dial or give no response.

Configuration of the Thru-Dial 
block

Actual content of prompt

Only name dialing is allowed. Please enter the name of the person
you wish to reach, followed by number
sign. To enter a name, spell the last 
name and then spell the first name.

Only number dialing is allowed, and 
the numbers are variable length.

Please enter the number of the 
extension you wish to dial, followed by 
number sign.

Only number dialing is allowed, and 
the numbers are fixed-length.

Please enter the number of the 
extension you wish to dial.

Both name dialing and number dialing 
are allowed, and the name-dialing 
prefix is 11.

Please enter the number or the name 
the person you wish to reach, followed
by number sign. To enter a name, pres
1-1, spell the first name, and then spe
the last name.
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See also

For information about default delivery, see “Fax Select block” on page 110.

For information about system prompts and voice items, see Chapter 6, “Working 
with voice recordings.”
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NO YES
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NOYES
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interrupts
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Caller
responds?
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Caller enters
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Voice recording
plays.

(optional)

G100874

Caller exits the
thru-dial and goes
to the next block via
the Rotary output
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To configure the Thru-Dial block, see “Configuring the Thru-Dial block” on 
page 226.
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Time Control block

Purpose

The Time Control block routes callers to different blocks in an application ba
on the time of day.
. 
. 

Example

A company uses the Time Control block in an application so that during 
business hours, callers reach the receptionist. Outside business hours, call
reach the company’s automated attendant.

Setup

You must configure and connect the Time Control block.

Configuring
To configure the Time Control block, define the time period.

Connecting
To connect the Time Control block, identify where callers go in the applicati
depending on the time of day.

Definition: Time period

A time period defines the time of day during which the application routes cal
to a specific part of an application. One time period has up to five subperiod
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Time subperiods
A subperiod is one of the five separate times of day that make up one time 
period. Each subperiod consists of both a start time and an end time that ar
specified in hours and minutes in 24-hour format. 

For example, you can define a receptionist’s working hours as 8:30 to 10:00
10:15 to 12:00, 13:00 to 14:30, and 14:45 to 17:00.

Inside and outside a time period

When callers access an application, the system checks the current time ag
each time subperiod. If the current time falls within one of the subperiods, t
callers access the application inside the time period. If callers access an 
application at a time not included within any time subperiod, then they acce
the application outside the time period. Calling inside or outside a time peri
determines the portion of an application that callers access.

How to configure a time period

When you configure a time period, you can

� overlap subperiods

� span two days

� define one-minute periods

� make a continuous time period

Overlapped subperiods
You can overlap the times specified in subperiods. The block follows the sa
rule: if the current time falls within any one of the specified time subperiods,
time is considered within the time period and callers exit the block accordin
the Inside output.

Later start time than end time
For any subperiod, if the start time is later than the end time, the block assu
the date range wraps around midnight, from one day to the next. For examp
a time period specifies 23:00 to 1:00, the block checks whether the time fal
between 23:00 and 23:59 or between 00:00 and 1:00. If the time falls within
of those ranges, callers exit the block according to the Inside output.
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Same start tim e and end time
If the start time and end time are the same for any subperiod, that subperiod is 
considered one minute. For example, if a Time Control block specifies only one 
subperiod from 1:00 to 1:00, the block exits callers according to the Inside 
output only if the current time is between 1:00:00 to 1:00:59 inclusive.

Conti nuou s time p eriod
To make a continuous time period, specify it from 00:00 to 23:59.

Relationship to other blo cks

You can combine the Time Control block with other blocks to define a more 
specific time. For more information, see “How the Time Control, Day Control, 
and Date Control blocks work together” on page 176.

Caller interaction

Callers do not interact with the Time Control block. However, this block affects 
them because an application behaves differently depending on the time that they 
call.

See also

To configure the Time Control block, see “Configuring the Date Control, Day 
Control, and Time Control blocks” on page 210.
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Unavailable block

Purpose

The Unavailable block indicates that either an imported application or a fax
function is missing.
. 

Setup

The Unavailable block appears in an application’s window if that application
cannot communicate with an imported application. The Unavailable block 
replaces an Imported Application block. The Unavailable block also appear
an application’s window if that application contains a fax function but resides
a system without fax capability. The Unavailable block appears in place of e
fax-related block.

You do not configure the Unavailable block or connect any outputs. You can
copy or rename the block. If you understand why this block appears, you ca
eliminate it.

Why the Unavailable block appears

The Unavailable block appears when something goes wrong with the archiv
and restoring of an application.

� The imported applications were not archived or restored on the system
the application in which they reside was archived. As a result, an 
Unavailable block appears instead of the imported applications.

� An application that contains fax functions was archived and then restor
on a system without fax capability. Therefore, an Unavailable block app
in place of each application’s fax-related blocks.
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How to eliminate the Unavailable block

After you restore an application, you must open and save it before installing
the SDN Table. When you open the application, you can see whether it is 
incomplete. An Unavailable block makes an application incomplete.

How you eliminate the Unavailable block depends on why it appears. You 
follow one process if an application has lost a fax function. You follow anoth
process if an application has lost imported applications.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder

To fix an application with lost fax functionality

1 Open the application.

2 Search for Unavailable blocks.

3 Delete the blocks.

4 Reconnect and reconfigure other blocks to complete the application.

To fix an application with lost imported applications

1 Locate the imported applications.

2 Archive and restore the applications on the same system as the application 
that imports them.

Irretrievable imported applications

If you cannot locate imported applications, you must follow the same proce
that you follow for an application with a lost fax function. In an application w
missing links, you delete the Unavailable blocks, and reconfigure and recon
the application until it is complete. An application without imported applicatio
might not be useful, depending on how much functionality those imported 
applications supplied.
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Caller interaction

Callers cannot interact with the Unavailable block. If this block appears in an 
application, the application is not available to callers.

See also
For information about connecting and configuring blocks, see Chapter 5, 
“Working with blocks.”

For information about recognizing when an application is complete, see Chapter 
3, “Working with applications.”

For information about the SDN Table, see Chapter 9, “Putting applications into 
service.”
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Understanding blocks
Section C: System blocks

In this section
 Custom Commands block 150

 Express Voice Messaging block 151

 Express Fax Messaging block 153

 Fax Item Maintenance block 155

 Multimedia Messaging block 156

 Speech Activated Messaging block 157

 Voice Item Maintenance block 159
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Custom Commands block

Purpose

The Custom Commands block allows users to create custom commands fo
Speech Activated Messaging system (for example, recording a synonym fo
command, or recording a word or phrase in another language as a synonym
command).

Setup

You do not configure or connect the Custom Commands block.

Default fax delivery

If any faxes have not been delivered by the system, default fax delivery occ
when an application encounters the Custom Commands block.

Caller interaction

Callers cannot return to the application once they transfer to the Custom 
Commands service.
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Express Voice Messaging block

Purpose

The Express Voice Messaging block transfers callers to the Express Voice 
Messaging service and lets them leave a voice message in a mailbox.
. 
. 

Setup

You only configure the Express Voice Messaging block. You do not connect

Configuring
To configure the block, determine whether callers leave messages in mailbo
that they specify or in a mailbox that you specify.

Configuring for Network Message Service 
If you are configuring for Network Message Service, you must ensure that y
system recognizes the location of a mailbox. Treat the data in the mailbox f
as a prime dialable DN, and add the location prefix exactly as it is dialed fro
the switch. For example, suppose that the prime location has prefix 1 and a
satellite location has prefix 2. Say that each location has a user and mailbo
extension 7000. If Express Voice Messaging is set up to leave messages in
mailbox at location 2, the administrator must enter 27000 in the mailbox field
Express Voice Messaging is to leave a message in the mailbox at location 1
administrator must enter 17000 or 7000, since both are dialable from the pr
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Default f ax delivery

If  any faxes have not been delivered by the system, default fax delivery occurs 
when an application encounters the Express Voice Messaging block.

Caller interaction

Callers cannot return to the application once they transfer to the Express Voice 
Messaging service.

See also

For information about default delivery, see “Fax Select block” on page 110.

To configure the Express Voice Messaging block, see “Configuring the Express 
Voice Messaging block” on page 230.
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Express Fax Messaging block

Purpose

The Express Fax Messaging block transfers callers to the Express Fax 
Messaging service and enables them to leave a fax message in a mailbox.
. 
. 

Setup

You only configure the Express Fax Messaging block. You do not connect i

Configuring
To configure the Express Fax Messaging block, determine whether callers l
fax messages in mailboxes that they specify or in a mailbox that you specif

Configuring for Network Message Service 
If you are configuring for Network Message Service, ensure that your syste
recognizes the location of a mailbox. Treat the data in the mailbox field as a
prime dialable DN, and add the location prefix exactly as it is dialed from th
switch. For example, suppose that the prime location has prefix 1 and a sat
location has prefix 2. Say that each location has a user and mailbox at exte
7000. If Express Fax Messaging is set up to leave messages in the mailbox
location 2, the administrator must enter 27000 in the mailbox field. If Expres
Fax Messaging is to leave a message in the mailbox at location 1, the 
administrator must enter 17000 or 7000, since both are dialable from the pr

Faxphone required

To use the Express Fax Messaging service, callers must use a faxphone.
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Default f ax delivery

If  any faxes have not been delivered by the system, default fax delivery occurs 
when an application encounters the Express Fax Messaging block.

Caller interaction

Callers cannot return to the application once they transfer to the Express Fax 
Messaging service.

See also

For information about default delivery, see “Fax Select block” on page 110.

To configure the Express Fax Messaging block, see “Configuring the Express 
Fax Messaging block” on page 232.
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Fax Item Maintenance blo ck

Purp ose

The Fax Item Maintenance block transfers callers to the Fax Item Maintenance 
service, which lets a caller edit fax items.
. 
. 

Setup

You do not configure or connect the Fax Item Maintenance block.

Default f ax delivery

If  any faxes have not been delivered by the system, default fax delivery occurs 
when an application encounters the Fax Item Maintenance block.

Caller interaction

Callers cannot return to the application once they transfer to the Fax Item 
Maintenance service.

See also

For information about default delivery, see “Fax Select block” on page 110.

For information about Fax Item Maintenance, see Chapter 10, “Maintaining 
applications.”
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Multimedia Messaging blo ck

Purp ose

The Multimedia Messaging block transfers callers to the Multimedia Messaging 
service, which lets callers use a DTMF phoneset to access their mailboxes for 
maintenance and for message retrieval and composition.
. . 

Setup

You do not configure or connect the Multimedia Messaging block.

Default f ax delivery

If  any faxes have not been delivered by the system, default fax delivery occurs 
when an application encounters the Multimedia Messaging block.

Caller interaction

Callers cannot return to the application once they transfer to the Multimedia 
Messaging service.

See also

For information about default delivery, see “Fax Select block” on page 110.
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Speech Activated Messaging block

Purpose

The Speech Activated (SA) Messaging block transfers callers to the SA 
Messaging service. This service lets callers use paced speech recognition 
access their mailboxes for administration and for message retrieval and 
composition.
. . 

Setup

You do not connect the SA Messaging block. However, you must configure 
you want callers to use paced speech recognition.

Paced speech recognition
Paced speech recognition enables callers to speak one digit at a time. With 
speech recognition configured, callers can say a mailbox number as “7 (pa
6 (pause), 2 (pause), 4” instead of saying “7624.”

SDN entry

If an application includes the SA Messaging block, the entry for the applica
in the SDN Table must use the appropriate channels for speech recognition

Default fax delivery

If any faxes have not been delivered by the system, default fax delivery occ
when an application encounters the SA Messaging block.
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Caller interaction

Callers cannot return to the application once they transfer to the SA Messaging 
service.

See also

For information about default delivery, see “Fax Select block” on page 110.
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Voice Item Maintenance block

Purp ose

The Voice Item Maintenance block transfers callers to the Voice Item 
Maintenance service, which lets them edit voice items.
. 
. 

Setup

You do not configure or connect the Voice Item Maintenance block.

Default f ax delivery

If  any faxes have not been delivered by the system, default fax delivery occurs 
when an application encounters the Voice Item Maintenance block.

Caller interaction

Callers cannot return to the application once they transfer to the Voice Item 
Maintenance service. 

Comparison to Meridian Mail

In Meridian Mail, Voice Item Maintenance is called Voice Prompt Maintenance.

See also

For information about default delivery, see “Fax Select block” on page 110.

For information about Voice Item Maintenance, see Chapter 10, “Maintaining 
applications.”
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Section D: Imported application blocks

In this section
 Continue block 162

 Imported Application block 163
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Continue block

Purpose

The Continue block passes the caller from an imported application to the 
destination application.
. 

Setup

The Continue block does not appear in the palette. Instead, this block appe
when you export an application. You must export an application before you
import it into another application.

In the exported application, you must connect at least one other block to th
Continue block. Connect any blocks that should take callers from the impor
application to the importing application.

Relationship to other blocks

For information about how the Continue block affects the Imported Applicat
block, see “How the Continue and Imported Application blocks work togethe” 
on page 171.

Caller interaction

Callers are unaware of the Continue block because they do not interact with
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Imported Application block

Purpose

The Imported Application block places one application within another one. I
the functionality of the imported application changes, it updates in all the 
applications that imported it.

This is an example of an imported application block showing its unique nam
and number.
. 

Distinguishing between importing and exported applications

An importing application is a destination application. An exported applicatio
a source application. 

Destination application
A destination application is an application into which another application ha
been imported. Usually, many types of functions make up a destination 
application. Imported applications supply some of the functions.

Source application
A source application is an application that has been imported into a destina
application. Usually, a source application provides only one function. This 
function can be used in more than one application. 

Setup

If you import a source application into a destination application, a block app
on the Imported Applications tab of the palette. The block has the same nam
the source application that it represents.
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You do not configure the Imported Application block. However, you must 
connect it.

Connecting
The Imported Application block’s outputs represent the End and Continue 
blocks in its source application. By default, the End output connects to the End 
block of the destination application. Also in the destination application, you 
must connect the Continue output to another block.

Relationship to other blo cks

See “How the Continue and Imported Application blocks work together” on 
page 171.

Caller interaction

Callers are unaware of the Imported Application block because they do not 
interact with it. Callers interact with the imported application just as they 
interact with the source application. 

See also

For more information about importing applications, see Chapter 8, “Reusing 
existing applications.”
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Section E: Blocks that work together

In this section
 How the Announcement block works with blocks that require menu key input166

 How the Announcement, Menu, and Thru-Dial blocks work together 169

 How the Continue and Imported Application blocks work together 171

 How the Fax Select and Fax Send blocks work together 173

 How the Time Control, Day Control, and Date Control blocks work together 176

 How the Rotary Dial and Call Transfer blocks work together 178

 How the End block works with all system blocks 179
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How the Announcement block works with 
blocks that require menu key input

Introduction

If you configure a phoneset’s menu keys to interrupt an Announcement bloc
you can also enable the keys to act as input for the next block. Typically, the
block is a Menu block. However, an Announcement block can affect other 
blocks that require menu key input, such as the Thru-Dial block.

Definition: Key buffering

Key buffering means phoneset’s menu keys can both

� interrupt an announcement

� act as input for both the Announcement block and the next block, unles
next block is another Announcement block

Menu keys
Menu keys are the keys labeled 1–9 on your phoneset.

Two Announcement blocks
An Announcement block always stops the key buffering initiated by a preced
Announcement block. For example, suppose that two Announcement block
joined. Both of them can be interrupted by menu keys and have key bufferin
configured. When callers interrupt the first announcement, they move to the
second announcement. Only after hearing the beginning of the second 
announcement can callers interrupt it.

Enabled key buffering

Enable key buffering both by configuring an Announcement block as 
interruptible by menu keys, and by ensuring that the Key Buffering box is 
checked.
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Effect of key buffering
Consider how an announcement with key buffering affects callers. Experien
callers can speed through an application because they can bypass blocks. 
However, inexperienced callers can become confused.

If an Announcement block that can be interrupted by menu keys and enable
with key buffering comes before a Thru-Dial block, the arrangement of bloc
can confuse callers. The key that interrupts the announcement acts as the 
digit for the extension number required by the Thru-Dial.

Examples of key buffering
Suppose that an application for a travel agency contains an Announcement 
followed by a Menu block. The phoneset’s menu keys interrupt the 
announcement, and the application uses key buffering. A caller dials the 
application and reaches the announcement that greets callers. Because the
knows he wants to dial a particular travel agent, he presses 3. Pressing 3 
interrupts the announcement, prevents the menu’s initial greeting and optio
from playing, and moves the caller to the Thru-Dial block attached to the M
block’s output for key 3. Because of key buffering, the Menu block treats ke
exactly as if the caller pressed it at the start of the block. At the Thru-Dial blo
the caller dials the agent by number.

A human resources application contains two Announcement blocks followe
a Menu block. The first announcement greets callers, the second announce
provides any important employee information, and the menu presents optio
callers. The phoneset’s menu keys interrupt both announcements, and the 
application buffers the keys for both of them. A caller phones the applicatio
about her employee benefits for the second day in a row. While listening to 
first announcement, she presses 2. Key 2 interrupts the first announcement
second announcement starts to play, but because the caller has already he
employee information, she interrupts the announcement by pressing 4. Key
prevents the menu’s options from playing and moves the caller to the Fax S
block attached to the Menu block’s output for key 4. The Fax Select block g
the caller information about benefits.

Disabled key buffering

To disable key buffering, ensure that the Key Buffering box is not checked. 
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Effect of no key buffering
Without key buffering, callers cannot speed through an application and must 
listen to all its information. No key buffering assists inexperienced callers, but 
the same application can frustrate experienced or impatient callers.

Exampl e of  no k ey buffering
In the application for a bookstore, a menu follows an announcement. Although 
key buffering is disabled, callers can interrupt the announcement with menu 
keys. The announcement greets callers and tells them about any in-store events. 
While listening, a caller presses 2. That key interrupts the announcement and 
moves her to the Menu block, so that the menu’s initial greeting plays. The caller 
listens to the greeting to hear the many options and to find out which key to press 
for special orders.

See also

For more information about how to let callers interrupt an announcement, see 
“Menu block” on page 122.
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How the Announcement, Menu, and Thru-Dial 
blocks work together

Introduction

When you combine the Announcement, Menu, and Thru-Dial blocks, you c
customize your applications in several ways.

The Announcement and Menu blocks
Use the Announcement block to customize a menu.

Greeting
Combine two Announcement blocks with two Time Control blocks and a Me
block to create a greeting appropriate for the time of day that welcomes cal
before they hear menu options.

For example, if callers access the menu in the morning, the greeting begins
“Good morning” and then presents the menu’s options. In the afternoon, ca
hear “Good afternoon” before the menu’s options.

The following diagram illustrates this application.
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Help
Use the Announcement block to provide extra help information for a menu.

The Menu and Thru-Dial blocks

Use Thru-Dial blocks with a Menu block to set up multiple instances of Thru
Dial.

For example, after accessing a menu, callers press the appropriate menu k
the department they want to access. Once they reach the department, they
an appropriate Thru-Dial greeting. Then, they dial the extension of their cho

The Thru-Dial and Announcement blocks

Use the Announcement block with a Thru-Dial block to ensure that callers 
cannot interrupt the greeting that plays for the Thru-Dial.

By default, callers can interrupt the greeting associated with the Thru-Dial 
block. To stop them from interrupting the greeting, you can choose No Gree
for the block. Place an Announcement block in front of the Thru-Dial block. 
Associate your Thru-Dial greeting with the Announcement block, and config
the Announcement block so that the greeting cannot be interrupted.

See also

Key buffering affects the Announcement, Menu, and Thru-Dial blocks becau
these blocks require menu key input. For information about key buffering, s
“How the Announcement block works with blocks that require menu key inp” 
on page 166.
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How the Continue and Imported Application 
blocks work together

Introduction

The Continue and Imported Application blocks work together to allow you to
export and import applications.

Distinguishing between exported and importing applications

An exported application is a source application. An importing application is 
destination application.  

Destination application
A destination application is an application into which another application ha
been imported. Usually, many types of functions make up a destination 
application. Imported applications supply some of the functions.

Source application
A source application is an application that has been imported into a destina
application. Usually, a source application provides only one function. This 
function can be used in more than one application. 

How to export and import an application

You must export a source application before you can import it into a destina
application. To export an application, use the Continue block. To import an 
application, use the Imported Application Block. The process of exporting a
importing involves four steps.

1. Export the source application.

2. In the source application, connect a block to the Continue block.

3. In the destination application, import the source application.

4. In the destination application, connect the Imported Application block t
another block.
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Expo rt the sou rce application
When you export a source application, a Continue block appears in it.

Connect the Conti nue blo ck
In the source application, you can connect blocks to the Continue block. The 
Continue block allows callers to move from the source application to the 
destination application. For example, callers call the destination application, go 
to the source application, and then go back to the destination application. 
Therefore, connect any blocks to the Continue block that take callers from the 
source application to the destination application. If you do not connect any block 
to the Continue block, the source application is the terminating application.

Impo rt the so urce application
In the destination application, import the source application. On the Imported 
Applications tab of the palette, a block appears with the name of the source 
application. If you change the functions offered by the source application, it 
automatically updates in the destination application.

Connect the Impo rted Application block
Before you can connect the Imported Application block, you must move it from 
the palette to the window of the destination application. The block has two 
outputs: End and Continue.

Both outputs correspond to parts of the source application. Like every 
application, the source application has an End block. This End block 
corresponds to the Imported Application block’s End output. Similarly, the 
source application’s Continue block corresponds to the Imported Application 
block’s Continue output. Therefore, after callers reach the Continue block in the 
source application, they go to the block connected to the Continue output of the 
Imported Application block. The Continue block directs where they go next in 
the destination application.

See also

For information about importing applications, see Chapter 8, “Reusing existing 
applications.”
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How the Fax Select and Fax Send blocks work 
together

Introduction

When you combine the Fax Select and Fax Send blocks, you create a fax-o
demand application. However, depending on how you set up your applicatio
you sometimes need to use only the Fax Select block.

Definition: Fax-on-demand application

A fax-on-demand application enables callers to select and receive faxes.

How the session profile affects fax items

To include fax items in an application, define the application’s fax options in
session profile of the SDN Table. In the session profile, establish settings fo
fax applications and other settings that are specific to fax applications that u
callback delivery.

For all fax applications
In the session profile, establish the following settings for all fax applications

� the maximum number of faxes a caller can select during one call

� the maximum number of fax pages that the system delivers to a caller 
during one call

� the telephone number of the fax machine that the system uses to send

� the fax delivery method (callback, same-call, caller’s choice)

� whether a custom cover page, called a sponsor fax item, transmits with 
fax

� how page transmission errors are handled

For fax applications that use callback delivery
In the session profile, you also establish the following settings for fax 
applications that use callback delivery:
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� the DN to which fax callback transmissions are billed

� whether the system cover page transmits with each fax

� the extension number of the fax recipient

� the type (for example, national) of fax machine number for which the 
system must prompt callers so it knows where to deliver faxes

� the restriction/permission list against which the fax machine number m
be validated before the system can make a fax callback transmission

What each block does

Each Fax Select block in an application represents one fax that callers can s
You can also include a Fax Send block to deliver the selected fax to callers
However, an application can deliver faxes using another method.

How an application delivers faxes

To ensure that the system sends faxes to callers according to the type of fa
delivery specified in the session profile, you either

� include the Fax Send block

or

� use default delivery

Including the Fax Send block
Place and configure the Fax Send block after the Fax Select block. This me
is the best way to ensure faxes are delivered.

Using default delivery
Default delivery occurs in an application if faxes are selected and one of the
following events occur:

� a caller hangs up

� an error occurs in the application

� a caller reaches a Thru-Dial, system, Call Transfer, or End block before
Fax Send block
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Example
Suppose that you have an announcement that says “Thank you for calling. 
Goodbye.” This announcement precedes the End block. If callers have selected 
faxes and there is no Fax Send block, then the End block activates default 
delivery. As a result, after the “goodbye” message, the system asks callers 
whether they want their selected faxes delivered. 

After callers have heard “goodbye,” they should not be prompted about delivery. 
This sample application makes more sense to a caller if it does not depend on 
default delivery. To correct the problem, place a Fax Send block before the 
Announcement and End blocks.

See also

For information about these two blocks, see “Fax Select block” on page 110 and 
“Fax Send block” on page 118.

For information about the session profile, see Chapter 9, “Putting applications 
into service.”
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How the Time Control, Day Control, and Date 
Control blocks work together

Introduction

When you combine the Time Control, Day Control, and Date Control blocks
you gain several ways to specify periods of time in your applications.

The Time Control and Day Control blocks

Use the Time Control block with the Day Control block to transfer callers to
appropriate service at the correct time on the correct day.

For example, callers who access a company’s application on a weekday du
business hours reach a receptionist. Callers reach the auto attendant on a 
weekday during nonbusiness hours. Callers also reach the auto attendant o
weekends.

The Time Control and Date Control blocks

Use the Time Control block with the Date Control block to transfer callers to
appropriate service at the correct time on the correct date.

For example, callers access an application for the registrar’s office at a 
university. If callers access the application on a registration date and during
business hours, they reach a service that allows them to register by phones
callers access the application on a non-registration date and during busines
hours, they reach a receptionist. On any date and during nonbusiness hour
callers reach an announcement that tells them the hours of operation for th
registrar’s office.

More than one Time Control block

Use more than one Time Control block to accurately route calls during vario
time periods.
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For example, the support staff on the help desk of a software company take
on the desk because they also teach classes. Between 9 a.m. and 3 p.m., t
application routes callers to staff. After 3 p.m., the application sends callers
mailbox in which they can leave messages for staff.
. 

During 9 a.m. and 11 a.m., the application transfers callers to Fred. At that t
Susan is teaching a class. During Fred’s class, between 11 a.m. and 1 p.m
application transfers callers to Susan. Between 1 p.m. and 3 p.m., callers re
Jim.
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How the Rotary Dial and Call Transfer blocks 
work together

Introduction

Combine the Rotary Dial and the Call Transfer blocks to ensure that callers
without DTMF phonesets do not get trapped in applications.

DTMF capability

All applications require DTMF input, but applications cannot tell whether 
callers actually have DTMF. Callers are routed by default to the Rotary Dial
block if they do not give input before the first time-out period occurs for the 
following blocks: Fax Select, Menu, Password Check, and Thru-Dial.

What each block does

If callers do not give DTMF input in an application before the first time-out 
period occurs, they transfer to the Rotary Dial block by default. The Rotary D
block directs these callers to another block. By default, the Rotary Dial bloc
connects to the Call Transfer block. After reaching that block, callers transfe
the default attendant or to the extension of your choice.

Why you connect these blocks

By connecting the Rotary Dial block to the Call Transfer block, you ensure t
non-DTMF callers can exit from an application and speak to a live attendan

If you connect the Rotary Dial block to another block, make sure that caller
using a rotary dial phoneset are eventually routed to a live attendant. You c
connect a Rotary Dial block to an Announcement or a Time Control block th
precedes a Call Transfer block. 
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How the End block works with all system 
blocks

Introduction

In your applications, all system blocks remain connected to the End block s
callers can go from applications to system services.

Difference between a service and an application

A service is an existing application that comes with the system, like Expres
Voice Messaging. An application is any application you create using Applica
Builder.

What each block does

Each system block represents a service, such as Express Voice Messaging
the system. A system block transfers callers to an appropriate service. How
the application from which callers come must finish. The End block finishes
applications.
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Working with blocks

In this chapter 
Section A: About working with blocks 183

Section B: Connecting blocks 193

Section C: Configuring blocks 201
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Section A: About working with blocks

In this section
 About connecting and configuring blocks 184

 How voice recordings and faxes work with blocks 187

 Why you customize outputs and lines 189
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About connecting and configuring blocks

Introduction

When you build an application, you configure and connect blocks. You conn
all blocks, but you configure only some of them.

Where you put blocks

To be part of an application, a block must appear in that application’s windo
Whenever you create an application, some blocks automatically appear in i
window. For example, the Start and End blocks always appear. However, m
blocks reside in the palette. Therefore, you must move them from the palet
the application window. After you move the blocks, you can configure and 
connect them.

Knowing when to configure and connect a block

If you see a pink border around a block when you move it into the applicatio
window, you must connect or configure it, or both.

Why blocks have pink borders
The border indicates that the block is incomplete. You must configure or con
all incomplete blocks. The border acts as a visual reminder of which blocks
must complete.

Connecting

To connect a block, link the block’s output to another block. You must conne
every block, except the End block, to another block. When you connect blo
you create the paths that callers take through the application. A path is also
known as the call flow.
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Configuring

To configure a block, open it, define its parameters, and associate voice 
recordings and faxes with it. Only certain blocks require configuration.

Knowing which blocks to configure
Open a block to find out whether you need to configure a block. If you see “T
block has no input parameters,” you do not have to configure the block.
. 

If you open a block and see boxes that require input, you must fill them in. B
doing so, you configure the block.
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See also

For information about each block, see Chapter 4, “Understanding blocks.”

For information about how to create applications, see Chapter 2, “Creating 
applications.”
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How voice recordings and faxes work with 
blocks

Introduction

In an application, you add voice recordings and faxes by associating them w
blocks. You associate voice and fax when you configure a block. In the con
of Application Builder, voice recordings are called voice items and faxes are
called fax items.

How you associate voice items with blocks

To associate a voice item, specify a file that contains a voice recording for t
appropriate block.

Blocks with which you associate voice items
You can associate voice items with various blocks, such as the Announcem
Call Transfer, and Thru-Dial blocks. You can even associate more than one 
item with some blocks. For example, the Menu block needs a voice item to 
describe the phoneset keys and another voice item to remind callers to pre
those keys.

How you associate a voice item
To associate a voice item with a block, select its file name.
. 

An imported voice item must be in WAV format. You can use the Sound 
Recorder that comes with Microsoft Windows to save voice in this format.
Application Builder Guide 187



Working with blocks  Standard 1.0

tion 
tent 

o 
How you associate fax items with blocks

To associate a fax item, specify a file that contains both a fax and a confirma
prompt. The confirmation prompt is a voice recording that describes the con
of the fax.

Block with which you associate fax items
You can associate fax items only with the Fax Select block. Also, you can 
associate only one fax item with the Fax Select block. For every fax in an 
application, you need a Fax Select block.

How you associate a fax item
You associate a fax item in the same way that you associate a voice item. T
associate a fax item, you select its file name or type the file’s ID in the 
appropriate box.
. 

See also

For information about voice items, see Chapter 6, “Working with voice 
recordings.”

For information about fax items, see Chapter 7, “Working with faxes.”
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Why you customize outputs and lines

Introduction

When you customize the outputs and lines of blocks, you determine whethe
outputs and lines should appear in the application window. When you custo
lines and outputs, you change how the content of an application looks.

How you customize outputs and lines

You customize outputs by hiding them. You customize lines by stubbing the

Hiding outputs
For example, a Menu block has outputs for nine menu keys. If an applicatio
uses only two menu keys, then you can ensure that the outputs for only tho
keys show in the application window. You hide the outputs for the remaining
seven menu keys.

This example of a Menu block shows all nine of its outputs.
. 

. 

The following example of a Menu block shows only two of its nine outputs.
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Stubbing lines
A line is full length when it connects one block to another block. If the block
are far apart, then the line that joins them is usually long and hard to follow. 
can shrink, or stub, the line. When you stub a line, a label appears beside a
block’s output and indicates the block to which the first block connects.
. 

Benefits of customizing outputs and lines

When you hide outputs and stub lines, you create a clear, uncluttered 
application.

More room
If you hide a block’s outputs, then that block takes up less space in the 
application window. Therefore, you have more room to place and arrange o
blocks.

More tidy
When lines intersect, the application window looks cluttered.
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Stubbed lines tidy a window and let you easily see the blocks that connect.
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Section B: Connecting blocks

In this section
 Basics of connecting blocks 194

 Editing blocks 196

 Working with lines and outputs 199
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Basics of connecting blocks

Introduction

The basics teach you how to add content to applications by moving and 
connecting blocks.

Pink border

A pink border appears around a block after you move it into an application. 
border indicates that you need to configure the block, connect it, or both. To
right of a block, you see one or more outputs. Connect outputs to other bloc
set the path that callers take through the application. When two blocks are 
connected, a line joins them. The pink border disappears after you finish 
connecting and configuring a block.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window

To move a block from the palette to an application

1 In the palette, click the appropriate tab:

� Basic tab

� System tab

� Imported Applications tab

2 Click a block and, while you press the mouse button, drag the block into the 
application window.

Result: The Add Block dialog box appears. 

3 In the Enter block name box, type a name to identify the block.

4 Click OK to see the block in the application window and to return to the 
main window.
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To connect a block to another block

1 In the application window, click a block’s output.

2 Click the block to which you want to connect.

To connect a block to another block with a collapsed line

1 In the application window, click a block’s output.

2 Right-click the block to which you want to attach the first block.

To connect multiple blocks to another block

1 In the application window, hold down the Shift key and then click the output 
of each block that you want to connect to another block.

2 Click the block to which the others should connect.

To see the outputs of a block

1 In the application window, click the block that you want to open.

2 On the Edit menu, click Block Properties.

3 Click the Outputs/Notes tab to see the block’s output.

4 Click OK to return to the application window.

To drag a block

1 Click the block that you want to move, keeping the mouse button pressed.

2 Drag the block to the area of the application that you want to see.

See also

For information about connecting blocks, see “About connecting and 
configuring blocks” on page 184.

For information about outputs, see “Parts of blocks” on page 90.
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Editing blocks

Introduction

When you edit blocks, you copy, cut, paste, delete, and rename them. Whe
paste a block, you must know how to resolve a name conflict with another bl
Keep track of your edits by adding notes to individual blocks.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window

To copy a block

1 In the application window, click the block that you want to copy.

2 On the Edit menu, click Copy.

Note: The copied block goes to the clipboard so you can paste it.

See also

For information about how to reuse blocks, see “How to reuse applications” on 
page 302.

To cut a block

1 In the application window, click the block that you want to cut.

2 On the Edit menu, click Cut.

Note: The cut block goes to the clipboard so you can paste it.
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To paste a block

1 On the Edit menu, click Paste.

2 Move the pointer (+) to where you want to paste the block, and click.

To resolve a name conflict for a block

1 In the Block Name Conflict dialog box, ensure that Default name is selected 
to use the name assigned by Application Builder, then go to step 4.

2 To define a new name for the block, ensure that New name is selected.

3 In the New name box, type a name to identify the block. Go to step 5.

4 Click Change All to enable Application Builder to assign names to all the 
blocks that are to be pasted and to return to the main window.

5 Click OK to rename the block. 

Result: If you paste only one block, you return to the main window. If you 
paste more than one block, go to step 6.

6 Repeat steps 2, 3, and 5.

Note: You see the Block Name Conflict dialog box when you copy a block in
your application’s window and then try to paste it in the same window. Reso
the block’s name conflict so that you can paste the block in the application.

To delete a block

1 In the application window, click the block that you want to delete.

2 On the Edit menu, click Delete.

ATTENTION! Sometimes when you attempt to paste a block, the Blo
Name Conflict dialog box appears because a block 
already exists with the same name. You must change t
name of the block that you want to paste.

If you paste a block in another application, then the block
associated voice items or fax items are also pasted.
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To rename a block

1 In the application window, click the block that you want to rename.

2 On the Edit menu, click Rename.

Result: The Rename Block dialog box appears.

3 In the Enter block name box, type a new name for the block.

4 Click OK to change the block’s name and to return to the main window.

To add notes to a block

1 In the application window, click the block to which you want to add notes.

2 On the Edit menu, click Block Properties.

3 Click the Outputs/Notes tab.

4 In the Notes box, type any additional information about the block.

5 Click OK to return to the main window.

Note: These notes print out when you print a block’s details.
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Working with lines and outputs

Introduction

You can reroute lines and connect multiple blocks. When you hide the outpu
a block, you decrease the amount of space it takes in an application. When
collapse the lines between blocks, you reduce the clutter in an application.

To select more than one block, line, or output at the same time

Hold down the Shift key and then click each block, line, or output that you want to 
select in the application window.

Tip: You can also use the cursor to draw a box around the blocks, lines, or 
outputs that are close together.

To show the output of a block

1 In the application window, click the block with the output that you want to 
show.

2 On the Edit menu, click Hide/Show Outputs and keep your mouse button 
pressed.

3 From the submenu, select the output’s name or Goto (for an output that is a 
line with a square at its end) so that a check mark appears beside it.

To hide the output of a block

1 In the application window, click the block with the output that you want to 
hide.

2 On the Edit menu, click Hide/Show Outputs and keep your mouse button 
pressed.

Tip: You can also access the Hide/Show Outputs submenu by right-clicking 
on a block.

3 From the submenu, select the output’s name or Goto (for an output that is a 
line with a square at its end) so that the check mark beside it disappears.
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To adjust the line that connects two blocks

1 Double-click the line.

2 Click a handle and, while pressing the mouse button, drag the handle in the 
direction that you want the line to move.

To readjust the line that connects two blocks

1 Click the line that you want to readjust.

2 On the Edit menu, click Reroute Line.

To collapse the line that connects two blocks

1 Click the line that you want to collapse.

2 On the Edit menu, click Stub/Restore Line.

To restore the line that connects two blocks

1 Click the collapsed line that you want to restore.

2 On the Edit menu, click Stub/Restore Line.
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Section C: Configuring blocks

In this section
 About basic blocks 202

 Opening a block 203

 Configuring the Announcement block 204

 Configuring the Call Transfer block 207

 Configuring the Date Control, Day Control, and Time Control blocks 210

 Configuring the Fax Select block 215

 Configuring the Language Select block 218

 Configuring the Menu block 220

 Configuring the Password Check block 223

 Configuring the Thru-Dial block 226

 About system blocks 229

 Configuring the Express Voice Messaging block 230

 Configuring the Express Fax Messaging block 232

 Configuring the Speech Activated Messaging block 234
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About basic blocks

Basic blocks provide general functionality in applications, such as playing vo
recordings and transferring calls. Customize these blocks for each applicat
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Opening a block

Introduction

Open a block to configure it or to see its properties and outputs.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window

To open a block

1 Click the block that you want to open.

2 On the Edit menu, click Block Properties.

3 Click OK to return to the main window.

Tip: You can also double-click a block to open it.
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Configuring the Announcement block

Introduction

Use the Announcement block to play voice—either a system prompt or a vo
item—in an application. You can also specify how many times the 
announcement plays and which keys on the phoneset can interrupt the 
announcement.

Menu keys are labeled 1–9 on your phoneset. If the Announcement block is
configured to let callers interrupt an announcement by pressing menu keys
can also configure key buffering. Key buffering affects the block that comes
after an Announcement block, unless the next block is another Announcem
block.

An Announcement block always stops the key buffering initiated by a preced
Announcement block. For example, suppose that two Announcement block
joined. Both blocks are interruptible by menu keys and have key buffering 
configured. Therefore, a caller can interrupt the first announcement and the
taken to the second announcement. Then, the caller has to start listening to
second announcement before being able to interrupt it.

A pink border appears around a block after you move it into an application. 
border indicates that you need to configure the block, connect it, or do both
the right of a block, you see one or more outputs. You connect outputs to o
blocks to set the path that callers take through the application. When two bl
are connected, a line joins them. The pink border disappears after you finis
connecting and configuring the block.

How you configure the Announcement block

Follow these procedures to configure the Announcement block:

1. To define a voice item as the announcement.

2. To define a system prompt as the announcemt.

3. To define how many times the announcement plays.
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4. To define key handling for the announcement.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window > Announcement block

To define a voice item as the announcement

1 Select Play custom voice item.

2 From the Custom Voice Item list, select the voice item that you want to play 
as the announcement.

Tip: You can change a selected voice item by clicking Edit. You can also 
create a voice item if you select <new voice item> from the Custom Voice 
item list, and then click New.
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To define a system prompt as the announcement

1 Select Play system prompt.

2 From the System prompt list, select the prompt that you want to play as the 
announcement.

To define how many times the announcement plays

1 In the Number of times to play box, type a number between 1–10.

2 To let callers hear a pause after the last play of the announcement, ensure 
that the Pause before exiting box is checked.

To define key handling for the announcement

1 Double-click the Announcement block.

2 To let callers stop the announcement with a menu key and go to the 
following block, ensure that the Accept menu keys (1–9) box is checked.

3 To let callers skip ahead in the application by applying the pressed menu 
key to both the Announcement block and the next block, ensure that the 
Store key in buffer box is checked.

4 To let callers stop the announcement with the attendant key (0) and go to 
the following block, ensure that the Accept attendant key (0) box is 
checked.

5 To let callers stop the announcement with the help key (*) and go to the 
following block, ensure that the Accept help key (*) box is checked.

6 To let callers stop the announcement with the cancel key (#) and go to the 
following block, ensure that the Accept cancel key (#) box is checked.

7 Click OK to return to the main window.
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Configuring the Call Transfer block

Introduction

Use the Call Transfer block to route callers to the default attendant or to a 
specific extension either on- or off-switch. If callers transfer to an extension 
is busy or unanswered, you can still route them to the default attendant. Yo
define that attendant in the Messaging Administration program.

How you configure the Call Transfer block determines what callers experien
after a call transfer. If the extension is valid, callers hear ringing before the 
application terminates. If no one answers, ensure that callers reach either 
CallPilot or the default attendant. If the extension is busy, callers hear a pro
before exiting the Call Transfer block on the Busy output. Callers reach 
CallPilot if the extension is forwarded. If the extension is not forwarded, ens
that callers reach the attendant. If the transfer fails, if the extension is not in
service and has no mailbox, or if the extension is restricted, then callers he
prompt before exiting on the Failed output. For a failed transfer, direct caller
CallPilot or the default attendant. 

How to configure the Call Transfer block

Follow these procedures to configure the Call Transfer block:

1. To define the call transfer greeting

2. To define call transfer options
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Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window > Call Transfer block

To define the call transfer greeting

1 Double-click the Call Transfer block.

2 To define the system prompt as the call transfer greeting, from the Prompt 
to play before transferring list, select <default system prompt>, which plays 
“Transferring to an attendant, one moment please.”

3 To define no greeting for call transfer, from the Prompt to play before 
transferring list, select <none>.

4 To define a voice item as the call transfer greeting, from the Prompt to play 
before transferring list, select the item’s name.

Tip: You can change a selected voice item by clicking Edit. You can also 
create a voice item if you select <new voice item> from the Prompt to play 
before transferring list, and then click New.
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To define call transfer options

1 Double-click the Call Transfer block.

2 To transfer callers to a default attendant, ensure that Transfer to default 
attendant is selected. Then go to step 6.

3 To transfer callers to a specific extension, ensure that Transfer to specific 
extension is selected.

4 Click the Extension to transfer to box.

5 Type the extension number to which callers should transfer.

6 Click OK to return to the main window.

Note: A successful call transfer ends the application.
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Configuring the Date Control, Day Control, 
and Time Control blocks

Introduction

Configure the Date Control and Time Control blocks to define periods of time
calendar dates and by a 24-hour clock. You configure the Day Control block
check every day of the week against a holiday schedule. Holidays take prio
over weekdays.

How to configure the Date Control, Day Control, and Time Control 
blocks

Folllow these procedures to configure the Date, Day and Time Control bloc

1. To define a date period for the Date Control block

2. To configure the Day Control block

3. To define a time period for the Time Control block

Defining a date period for the Date Control block

Use the Date Control block to route calls to different blocks according to a d
period, which can consist of up to five separate subperiods. You also use th
Date Control block with the Time Control block to route calls during specific
time periods. For example, a university might want to activate services durin
certain hours only on the dates that registration takes place.

If the current date falls within any one of the specified subperiods, the 
application considers the current date to belong to the date period. If you re
additional date periods, you can connect Date Control blocks.
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Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window > Date Control block

To define a date period for the Date Control block

1 Double-click the Date Control block.

2 In a box under From (mm/dd), type the month and the day on which the 
date subperiod begins.

3 In the corresponding box under To (mm/dd), type the month and the day on 
which the date subperiod ends.

4 Repeat steps 1 and 2 to define another date subperiod.

5 Click OK to return to the main window.

Tip: You can include a date in more than one subperiod and, therefore, 
overlap subperiods. Use a Date Control block to define departmental 
holidays that differ from organizational holidays.
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Configuring the Day Control block

Use the Day Control block to route calls to different blocks according to the 
You can route calls for each day of the week as, well as for holidays. You ca
also use the Day Control block with the Time Control block to route calls dur
specific time periods.

The holiday schedule set in the Messaging Administration program determi
which days are holidays. A holiday has priority over any day of the week un
you configure the Day Control block to skip holidays.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window > Day Control block 
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To configure the Day Control block

1 Double-click the Day Control block.

2 To ensure that the day of the week is checked against the holiday schedule, 
make sure that the Check for holidays box is checked.

Note: If the Check for holidays box is not checked, the Day Control block 
has no Holiday output.

3 Click OK to return to the main window.

Defining a time period for the Time Control block

Use the Time Control block to route calls to different blocks according to a 
24-hour time period consisting of up to five separate subperiods. Most often,
use the Time Control block with the Day Control block to send callers to the
most appropriate area of the application. For example, during a company’s 
business hours, callers reach a live attendant; during a company’s nonbusin
hours, callers reach an auto attendant.

A subperiod can begin at 19:00 at night and go until 05:00 the following 
morning. The system interprets the earlier time (05:00) as a reference to the
day. If you require additional time periods, you can connect Time Control 
blocks.
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Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window > Time Control block

To define a time period for the Time Control block

1 Double-click the Time Control block.

Note: The Time Control block uses a 24-hour clock.

2 In a box under From (hh:mm), type the hour and minute that subperiod 
starts.

3 In the corresponding box under To (hh:mm), type the hour and minute that 
the time subperiod ends.

4 Repeat steps 1 and 2 to define another time subperiod.

5 Click OK to return to the main window.

Note: You can include a time in more than one subperiod and, therefore, 
overlap subperiods.
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Configuring the Fax Select block 

Introduction

Use the Fax Select block to set up a fax-on-demand application. To set up a
on-demand application, you need to understand how the system delivers fa
the fax options that you must configure in the session profile, and how you 
the Fax Select block.

The system sends faxes using either callback or same-call delivery. In the 
session profile, configure the type of fax delivery that the system uses and d
the session profile in the SDN Table. As its name suggests, caller’s choice 
delivery enables callers to choose between callback and same-call delivery

Callback and same call-delivery

With same-call delivery, the caller—who must be at a faxphone—selects fa
and then receives the selected faxes. Same-call delivery avoids billing prob
because the caller pays any long distance charges. With callback delivery, 
caller provides a fax machine number to which the system delivers faxes. S
system knows how to prompt callers for the number, configure its type (for 
example, national). This callback number must validate against the restricti
permission list (RPL), which you also configure in the session profile. For 
example, a restriction could prevent the system from calling back an 
international faxphone number. With caller’s choice delivery, the system ask
callers to indicate whether they want either same-call or callback delivery.

Configuring other options

Besides the type of fax delivery and the RPL, you must configure some othe
options in the session profile. Select whether an optional system cover pag
sends with callback faxes. As well, you can add information, such as a logo
the page. Specify both the maximum number of faxes and the maximum nu
of fax pages that a caller can receive during one call. When a caller reache
first maximum number in a fax-on-demand application, a warning message
plays and the application takes the caller to the block that you configure. Of
that block is a Fax Send block.
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The Fax select block

Each Fax Select block contains only one fax item. Therefore, you must inclu
Fax Select block for each fax that you want in your application. In turn, calle
can assemble multiple faxes to transmit in a single call.

Various factors affect how the Fax Select block behaves. When callers reac
block, they might hear an optional confirmation prompt that describes the fa
After selecting faxes, callers enter information depending on the type of fax
delivery configured. For example, with callback delivery, the application ask
callers to enter, at least, a faxphone number.

Fax-on-demand application 

This fax application can send faxes using one of two methods. With one me
your application can include the Fax Send block. For example, you can atta
Menu block to the Done output of Fax Select. Then, you can give callers th
choice to select another fax by pressing 1 or to receive the current fax by 
pressing 2. If callers press 2, they reach the Fax Send block. 

With the other method, your application can activate default delivery by send
callers out of the application. For example, passing callers to a block (such
Thru-Dial or Call Transfer) that does not let them return to the application 
triggers fax delivery. Default delivery also occurs if the caller hangs up or if 
error occurs in the application. Most often, you should use the Fax Send blo

Callers are done after any of the following conditions: they select the fax ite
the fax item is already selected, or the fax item is empty. To let callers hear
prompt before selecting another fax, you can connect the Done output to a M
block or to an Announcement block. You can also see where callers go if th
reach either the maximum number of faxes or the maximum number of fax 
pages set in the session profile.
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Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window > Fax Select block

To configure the Fax Select block

1 Double-click the Fax Select block.

2 From the Fax item list, select the fax item that you want to associate with 
the Fax Select block.

3 To enable callers to transfer to an attendant from the Fax Select block, 
ensure that the Allow caller to transfer to an attendant (when 0 key is 
pressed) box is checked.

4 Click OK to return to the main window.

Tip: To change a selected fax item, click Edit. To create a fax item, select 
<new fax item> from the Fax item list, and then click New.
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Configuring the Language Select block

Introduction

Use the Language Select block to change the current language for system 
prompts without affecting voice items, such as those used in an announcem

The selected language affects all the blocks that follow it in the application 
all system programs (for example, Express Voice Messaging). The selected
language remains active until another Language Select block appears.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window > Language Select block
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To configure the Language Select block

1 Double-click the Language Select block.

2 From the System prompting language list, select the language in which you 
want system prompts to play.

3 Click OK to return to the main window.

Note: The Language Select block affects only system prompts. It does not 
affect voice items.

See also

To learn more about configuring the Language Select block, see “Language 
Select block” on page 120.
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Configuring the Menu block

Introduction

Use the Menu block to give callers options in an application. You specify the
voice items used by the menu. The menu uses voice items to 

� describe options associated with the phoneset keys

� prompt callers who give no response

� notify callers if they press an invalid key

� set the maximum number of times that callers can give no response an
press invalid keys

To use the Menu block, combine it with blocks such as the Announcement 
block, Thru-Dial block, Call Transfer block, and Language Select block. The
Announcement block enables you to provide extra help information for a me
You can also configure the Announcement block, Menu block, and Time Con
block so that callers hear the appropriate greeting for the time of day that th
access the menu. Use a Call Transfer block or Thru-Dial block with a Menu
block to set up multiple instances of call routing. If you use the Language Se
block with the Menu block, you ensure that callers can hear the rest of the m
in the language of their choice.

To make a menu valid, you must connect at least one key to a block. By 
connecting a key to a block, you also make that key valid. If you do not con
a key to a block, the application treats that key as invalid.

How to configure the Menu block

Follow these procedures to configure the Menu block:

1. To define the voice item that describes menu choices.

2. To define how a menu deals with no response.

3. To define how a menu deals with invalid responses.
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Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window > Menu block

To define the voice item that describes menu choices

1 Double-click the Menu block.

2 From the Menu choices greeting list, select the voice item that describes 
the menu keys and their services.

Tip: You can change a selected voice item by clicking Edit. You can also 
create a voice item if you select <new voice item> from the Menu choices 
greeting list, and then click New.
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To define how a menu deals with no response

1 Double-click the Menu block.

2 To give callers another opportunity to respond, ensure that the Allow retries 
after no response box is checked.

3 In the Number of no response retries box, type the number of times that the 
system asks callers for a response before the system terminates them from 
the menu.

4 From the No response prompt list, select the voice item that asks callers to 
give a response.

Tip: You can change a selected voice item by clicking Edit. You can also 
create a voice item if you select <new voice item> from the No response 
prompt list, and then click New.

To define how a menu deals with invalid responses

1 Double-click the Menu block.

2 To let callers give a valid response after giving an incorrect response, 
ensure that the Allow retries after invalid response box is checked.

3 In the Number of invalid response retries box, type the number of times that 
callers can press undefined menu keys before the system terminates them 
from the menu.

4 To define the system prompt as the invalid response prompt, from the 
invalid response list, select <default system prompt>, which plays 
“<<beep>> That selection is not recognized. Please make another choice.”

5 To define a voice item as the invalid response prompt, from the invalid 
response list, select the item’s name.

6 Click OK to return to the main window.

Tip: You can change a selected voice item by clicking Edit. You can also 
create a voice item if you select <new voice item> from the Invalid response 
prompt list, and then click New.
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Configuring the Password Check block

Introduction

Use the Password Check block to control access to specific areas of an 
application by prompting callers to enter a password before they can contin

You can place Password Check blocks anywhere in the application. For 
example, you can connect a Thru-Dial block that allows international calls t
Password Check block. When you do so, only callers who enter the correct
password can place international Thru-Dials. 

The system does not display a password after you define it. Therefore, you 
remember passwords and distribute them to appropriate callers.

In the session profile, configure the maximum number of invalid password 
entries and the maximum number of entry attempts allowed. Without these 
limits, hackers can repeatedly try to break through the Password Check blo

To configure the Password Check block

Follow these procedures to configure the Passwork Check block:

1. To define the password check greeting.

2. To define passwords. 
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Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window > Password Check block

To define the password check greeting

1 Double-click the Password Check block.

2 To define the system prompt as the password check greeting, from the 
Password prompt list, select <default system prompt>, which plays 
“Password?”

3 To define no greeting for password check, from the Password prompt list, 
select <none>.

4 To define a voice item as the password check greeting, from the Password 
prompt list, select the item’s name.

Tip: You can change a selected voice item by clicking Edit. You can also 
create a voice item if you select <new voice item> from the Password 
Prompt list, and then click New.
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To define passwords

1 Double-click the Password Check block.

2 To define the number of times callers can enter an undefined password 
without exiting from the Password Check, type the number in the Number of 
invalid response retries box.

3 Ensure that one of the Password check boxes is checked.

4 In the corresponding Password text box, type the password.

5 In the corresponding Confirmation text box, type the password again.

6 To define another password, repeat steps 2 through 4.

Note: You must define at least one password.

7 Click OK to return to the main window.

Note: The minimum password length is governed in Security 
Administration.

See also

For information about the Start block, see “Start block” on page 134.
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Configuring the Thru-Dial block

Introduction

Use the Thru-Dial block to create an automated attendant that transfers call
the DN that they enter. 

You can also use restriction/permission lists to define the numbers that call
can enter. For example, an RPL can prevent callers from placing a long dist
call, even if the callers enter the correct number. 

The Messaging Administration program determines whether callers can use
name dialing. The program can override the dialing options that you configu
for the Thru-Dial block. If you configure name dialing for only the Thru-Dial 
block and Messaging Administration does not let callers use name dialing, 
callers hear a prompt when they reach the block, and they exit on its Cance
output. If you configure both name dialing and number dialing for the Thru-D
block and Messaging Administration does not let callers use name dialing, 
callers can use only number dialing with the block. The system prompt 
associated with number dialing plays in place of any custom voice item that
have configured.

You can define multiple Thru-Dial blocks to satisfy callers with different dialin
restrictions. For instance, you can have two Thru-Dial blocks attached to tw
menu keys. One Thru-Dial lets a company’s customers dial employees by n
The other Thru-Dial lets staff dial each other and place local calls.

How to configure the Thru-Dial block

Follow these procedures to configure the Thru-Dial block:

1. To define the Thru-Dial greeting.

2. To define dialing options for Thru-Dial.

3. To define a restriction/permission list for Thru-Dial.
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Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window >Thru-Dial block

To define the Thru-Dial greeting

1 Double-click the Thru-Dial block.

2 To define a system prompt as the Thru-Dial greeting, from the Thru-Dial 
greeting list, select <default system prompt>, which plays a prompt 
appropriate for the block’s configuration.

3 To define no greeting for Thru-Dial, from the Thru-Dial greeting list, select 
<none>.

4 To define a voice item as the Thru-Dial greeting, from the Thru-Dial greeting 
list, select the item’s name.
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5 Click OK to return to the main window.

Tip: You can change a selected voice item by clicking Edit. You can also 
create a voice item if you select <new voice item> from the Thru-Dial 
greeting list and then click New.

To define dialing options for Thru-Dial

1 Double-click the Thru-Dial block.

2 To let callers dial people by only their extension numbers, ensure that Allow 
dial by number is selected. Then go to step 4.

3 To let callers dial people by only their names, ensure that Allow dial by 
name is selected. Then go to step 7.

4 To let callers dial people by both their extension numbers and their names, 
ensure that Allow dial by number or name is selected. Then go to step 7.

5 To ensure callers enter numbers of a particular length, ensure that the Use 
fixed length numbers box is checked.

6 In the Length box, type the number of digits (0–13) callers must enter.

7 To specify a string of digits that prefix the value specified in the Length box, 
in the Left pad box, type the digits.

8 Click OK to return to the main window.

To define a restriction/permission list for Thru-Dial

1 Double-click the Thru-Dial block.

2 From the RPL, select the list that monitors calls made through the Thru-Dial 
block.

3 Click OK to return to the main window.
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About system blocks

System blocks represent existing system applications known as services. U
these blocks to link your applications to services.
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Configuring the Express Voice Messaging 
block

Introduction

Use the Express Voice Messaging block to transfer callers to the Express V
Messaging service. This service enables callers to leave a voice message i
specific mailbox or a mailbox of their choice.

If callers have selected faxes in the current call, the Express Voice Messag
block asks them to accept faxes already selected for same-call delivery, or 
continue with the Express Voice Messaging block and lose the faxes.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window > Express Voice Messaging block 
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To configure the Express Voice Messaging block

1 Double-click the Express Voice Messaging block.

2 To let callers specify the mailbox in which they want to leave a voice 
message, ensure that Allow caller to specify mailbox number is selected. 
Then go to step 5.

3 To specify the mailbox in which callers leave all voice messages, ensure 
that Use specific mailbox is selected.

4 In the Mailbox box, type the number of the mailbox to which all voice 
messages deliver.

5 Click OK to return to the main window.

See also

To learn more about configuring the Express Voice Messaging block, see 
“Custom Commands block” on page 150.
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Configuring the Express Fax Messaging block

Introduction

Use the Express Fax Messaging block to transfer callers to a service that a
them to leave a fax message in a specific mailbox or a mailbox of their choi
To use the service, callers must call from a faxphone.

If callers enter the Express Fax Messaging block after they select faxes for s
call delivery, the system asks callers if they want to continue and lose the fa
or to receive the faxes instead.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window > Express Fax Messaging block
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To configure the Express Fax Messaging block

1 Double-click the Express Fax Messaging block.

2 To let callers specify the mailbox in which they want to leave a fax message, 
ensure that Allow caller to specify mailbox number is selected. Then go to 
step 5.

3 To specify the mailbox in which callers leave all fax messages, ensure that 
Use specific mailbox is selected.

4 In the Mailbox box, type the number of the mailbox to which all fax 
messages deliver.

5 Click OK to return to the main window.
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Configuring the Speech Activated Messaging 
block

Introduction

Use the Speech Activated (SA) Messaging block to transfer callers to the S
Messaging service. This service enables callers to use speech recognition 
retrieve and manipulate mailbox messages. The service requires speech 
recognition channels dedicated in the SDN Table.

You do not connect the SA Messaging block. However, you must configure 
you want callers to use paced speech recognition. Paced speech recognitio
callers speak one digit at a time. Callers can say a mailbox number as “7, 
(pause), 6, (pause), 2, (pause), 4”, instead of saying it as “7624.”

Since this messaging block offers a service, it causes the application to end
callers have selected faxes in the current call, this block asks them to accep
faxes already selected for same-call delivery, or to continue with this block 
lose them.
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Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window > Speech Activated Messaging block

To configure the Speech Activated Messaging block

1 Double-click the SA Messaging block.

2 Ensure that the Use paced speech recognition box is checked.

3 Click OK to return to the main window.
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Working with voice recordings

In this chapter 
Section A: About working with voice recordings 239

Section B: Working with voice recordings 245
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Section A: About working with voice 
recordings

In this section
 Types of voice recordings 240

 How to use voice created for Meridian Mail Voice Services 242
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Types of voice recordings

Introduction

Voice recordings let you construct applications from the callers’ perspective
Callers interact with applications by listening and responding to voice.

Three types of voice recordings

CallPilot supports three types of voice recordings: system prompts, voice ite
and customized prompts. You use all three types of voice recordings in 
Application Builder.

System prompts
System prompts are voice recordings that come with the system. A well-kn
system prompt is “Login incorrect. Please try again.”

You cannot delete any system prompts. However, you can use System Pro
Customization to edit some system prompts.

Voice items
Voice items are custom-made voice recordings. You can use a phoneset to r
your own voice items, or you can import a sound file in WAV format. An 
example of a voice item is “Welcome to ABC Company. For information in 
English, press 1. For information in French, press 2.”

Customized prompts
Customized prompts are system prompts that you have replaced, or custom
with a phoneset recording or a sound file in WAV format. You can customize
system prompts in System Prompt Customization. You then replace a syste
prompt with a voice item.

You can customize only one system prompt in Application Builder. For the 
Announcement block, you can select the “Goodbye” system prompt or 
customize it to say “Goodbye. Thank you for calling ABC Company.” If a 
customized prompt exists for “Goodbye,” you cannot select the system prom
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How to add voice to an application

To include a system prompt, voice item, or customized prompt in an applica
associate it with a block.

You can associate voice with various blocks, such as the Announcement bl
Call Transfer block, or Thru-Dial block. You can even associate more than o
voice item or system prompt with some blocks. For example, the Menu bloc
needs voice to describe the phoneset keys. This block needs more voice to
prompt callers to press those keys.

Default names and IDs

Whenever a conflict occurs, Application Builder proposes default names an
IDs for the voice items you want to paste. Use the default names and IDs to
time. You can always change the names later.

See also

For information about associating voice with a block, see Chapter 5, “Working 
with blocks.”
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How to use voice created for Meridian Mail 
Voice Services

Introduction

You can reuse voice created for Meridian Mail Voice Services so that you do
waste time re-creating existing announcements and voice prompts.

You can migrate the following item from Voice Services to Application Build

� announcements

� fax items

� menus

This section describes how to use migrated announcements and menus.

Contents of a menu

Each menu from Voice Services contains voice prompts for

� the greeting

� caller choices

� the 1–9 menu keys

How to identify migrated voice

In general, “Migrated_” prefixes identify both announcements and menus fo
migrated voice. The prefix indicates a service that was created in Meridian 
Voice Services. Other prefixes indicate the type of migrated service. Names
IDs indicate the announcements and prompts themselves.

Menus
A migrated menu is identified in Application Builder by a prefix of 
“Migrated_Menu” and its ID from Voice Services. For example, a Voice 
Services menu with an ID of 64 appears as “Migrated_Menu64” in Applicat
Builder. The description of the application is “Migrated from Menu Service 6
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Announcements
A migrated announcement is identified in Application Builder by a prefix of 
“Migrated_Ann” and its ID from Voice Services. For example, a Voice Servic
announcement with an ID of 65 appears as “Migrated_ANN65” in Applicatio
Builder. The description of the application is “Migrated from Announcement
Service 65”.

Within that file, you see the announcement with both a name (Announceme
and an ID (1010).

Format of migrated voice

In Voice Services, you can use only announcements in multiple services. A v
prompt can appear in only one service. However, in Application Builder, 
announcements and voice prompts are in the same format as voice items.

Access
On the server, you access migrated announcements and the voice prompts
menus in the same way that you access voice items.

Use
Voice items are compatible with all applications. For example, you can use 
same voice item in multiple applications just as you used an announcemen
multiple services. As a result, you now can use all your existing voice promp
multiple applications.

Applications that contain migrated voice

You can use migrated voice in new applications and in rebuilt applications t
existed in Meridian Mail Voice Services. Consider when to build both types 
applications.

New applications
You can build new applications that use migrated voice either before or afte
voice is migrated from Voice Services.

If you build new applications before migration, you save time. However, you 
complete the applications and use them only after migration.
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Rebuilt applications
You can rebuild applications that use migrated voice either before or after th
voice is migrated from Voice Services.

You save time if you rebuild applications before migration. However, you ca
complete the applications and use them only after migration. 

You can do everything at once if you rebuild applications after migration. Yo
can paste the voice into the applications during creation. Also, the migrated
voice can help you remember what to rebuild.

See also

For information about migrated fax items, please see Chapter 7, “Working with 
faxes.”
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Section B: Working with voice 
recordings

In this section
 Voice items 246

 Defining a voice item 249

 Recording a voice item 250

 Importing a voice item 252

 Editing and deleting a voice item 254

 Copying and pasting a voice item 260

 Resolving name or ID conflicts for a voice item 262
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Voice items

Creating a voice item

Create a voice item so you can associate a custom recording with a block.

Use the Voice Recorder toolbar to play and record voice with a phoneset.

The Voice Recorder toolbar
The Play button is enabled only when a recording already exists. Play alwa
rewinds the recording to its beginning before playing it. When you record, y
overwrite the last recorded voice.

Voice item name and ID 

When you create a voice item, you define its name and ID.

Name
The name identifies the voice item by a unique word. The name can contain
to 30 characters.

Example: greeting

ID
The ID identifies the voice item by a unique number. The number can contai
to four digits and must be in the range from 1000–3000.

Example: 1038

When you use Voice Item Maintenance, you specify voice items by their IDs
indicate the voice item that you want to listen to or edit, input its ID on the 
phoneset keypad.
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Description of a voice item

You can use the description area to generate a script for a voice item. Type
exact wording of the item. Whatever information you enter as a description 
prints with the voice item’s name and ID when you print details for the fax a
voice items in an application. 

Where voice items are saved

As soon as you save a voice item, it appears on the server. You can access
item from any client. You can also access the item remotely by phoneset us
Voice Item Maintenance.

After you save a voice item

You can save a voice item with only a name and an ID. However, the item is
empty because it contains no voice recording. You add voice by recording it 
the phoneset or by importing a WAV file.

Record voice with a phoneset

If you click the Record button in Application Builder while you create a voice
item, you connect to a phoneset. When you use a phoneset for recording, y

1 connect

2 record

3 disconnect

Connect
In the Specify Phoneset dialog box, you indicate which phoneset you want to
to record voice items. You must enter the telephone number in the same fo
as you dial it. If the phoneset sits on a desk beside you and you call people
surrounding desks by dialing extension numbers, then you dial the appropr
extension number. When the phoneset rings, you must answer it.
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Record
After you click the Record button in the Voice Recorder dialog box, the syst
records what you speak into the phoneset. If you have a voice item already
selected, recording overwrites that voice item.

Disconnect
After you record a voice item, you do not have to disconnect by hanging up
Instead, you can stay connected and record other voice items. Disconnect 
when you are finished recording all the voice items you need.

Import sound files

To import prerecorded sound files into Application Builder, they must be in t
correct format. You can import only 8-bit, 11-bit, 22-bit, or 44-bit sound files
WAV format, recorded at 22 050 kilohertz (kHz) and mono. Import files from
anywhere on your client PC network.

How you create a voice item

Follow these procedures to create a voice item.

1. Defining a voice item.

2. Recording a voice item.

3. Importing a voice item.

Note: You can also create a voice item when you add a block to the applica

See also

For information about the content of a voice item, see Chapter 2, “Creating 
applications.”

For information about Voice Item Maintenance and printing voice item detai
see Chapter 10, “Maintaining applications.”
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Defining a voice item

Introduction

Define a voice item so that you can identify it on the server.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window

To define a voice item

1 On the Define menu, click Voice items... .

2 Click Add... .

Result: The Add voice item dialog box appears.

3 In the Name box, type a name to identify the voice item.

4 In the ID box, if you do not want to accept the default, type a number to 
identify the voice item.

5 To include a description of the voice item, in the Description box, type 
information about the item.

6 Click Done.
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Recording a voice item

Introduction

Record a voice item by using a phoneset.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window

To record a voice item

1 On the Define menu, click Voice items... .

Result: The Define voice items dialog box appears.

2 In the Define voice items dialog box, select the voice item you want to 
record.

3 Click Edit... .

4 Click Record... .

5 In the Specify Phoneset box, type the number of the phoneset you want to 
use for recording, and then click Dial.
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6 Answer the phoneset when it rings.

7 Click Record.

8 Speak the content of the voice item.

9 Click Stop.

10 If you are satisfied with the recording, click Done, and go to step 12.

11 If you are not satisfied with the recording, repeat steps 7 to 10.

12 Hang up the phoneset.

13 Click Done.

14 Click OK.

15 Click Done until you return to the application window.
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Impo rting a voice item

Introduction

Import a voice item to use the contents of a WAV file as the item.

Getting there   CallPilot System > System Administration > Service Administration > 
Application Builder > application window

To impo rt a voice item

1 On the Define menu, click Voice items... .

Result: The Define voice items dialog box appears.

2 In the Define voice items dialog box, select the voice item into which you 
want to import voice.

3 Click Edit... .

4 Click Import... .

5 Select the voice item that you want to import.

6 Click Open.
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7 Click OK.

8 Click Done until you return to the application window.
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Editing and deleting a voice item

Introduction

Because the information contained in voice items often changes, you must k
how to edit and delete voice items. By changing the content of some voice i
and removing other ones, you ensure callers always get the most up-to-dat
information. 

What you can edit and delete

You can edit or delete voice items. You cannot delete any system prompts, 
you can edit some of them.

How to edit and delete a voice item

Both Application Builder and Voice Item Maintenance (VIM) let you edit and
delete voice items. Use Application Builder to do any maintenance on voice
items when you are at the office. When you are away from the office, use VIM
edit voice items on a phoneset. 

IDs and VIM

You can print the details of all voice items in an application. These details 
include the IDs of all voice items. When you know their IDs, you can use VI

Definition: Online updating

Online updating means that callers do not encounter edited items until after
finish changing and saving them, and then finish saving and closing the 
application in which they reside. Both you and callers must exit from the 
application before it can update.
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Example: Online updating

Suppose that you have to change the voice items that play for an announce
Instead of three announcements (one for the morning, one for the afternoon
one for after business hours), you want only two. You must have one 
announcement for business hours and another announcement for after hou

A caller calls the application before you change the announcements. Since
caller accesses the application in the afternoon, she hears, “Good afternoo
Thanks for calling Book Bonanza. If you know the number of the departmen
you want to reach, press 1. If you don’t know the department’s number, pres

While the caller interacts with the application, you use Application Builder to
replace the morning and afternoon announcements with one announcemen
plays during business hours: “Hello. Thanks for calling Book Bonanza. If yo
know the number of the department you want to reach, press 1. If you don’t
know the department’s number, press 2.”

While in the application, the caller is never aware of the changed 
announcements. After she hangs up, she realizes she must call Book Bona
again because she forgot to ask about a book’s availability. During the time
takes her to use the application and redial it, you change the announcemen
Besides saving the announcements, you also save and exit from the applic
in which they reside. Only when the caller redials the application does she 
the new announcement for business hours.
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Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window

To edit a voice item

1 On the Define menu, click Voice items... .

2 In the Define voice items dialog box, select the voice item you want to edit.

3 Click Edit... .
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Result: The Edit voice item dialog box appears.

4 In the Name box, select the existing name and then type a new one.

5 In the Description box, select the existing text and then type new 
information about the item.

6 Re-create the content of the voice item. See “To rerecord a voice item” and 
“To reimport a voice item” on the next pages.

To delete a voice item

1 On the Define menu, click Voice items... .

2 In the Define voice items dialog box, select the voice item you want to 
delete.

Note: Be sure to select the correct item. The system does not prompt you 
again before deleting the selected file.

3 Click Delete.

4 Click Done to return to the application window.
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To rerecord a voice item

1 On the Define menu, click Voice items... .

2 In the Define voice items dialog box, select the voice item you want to 
rerecord.

3 Click Edit... .

4 Click Record... .

Result: The Specify Phoneset dialog box appears.

5 In the Specify Phoneset box, type the number of the phoneset you want to 
use for recording, and then click Dial.

6 Answer the phoneset when it rings.

7 Click Record.

8 Speak the new content of the voice item.

9 Click Stop.

10 If you are satisfied with the recording, click Done and go to step 12.

11 If you are not satisfied with the recording, repeat steps 4 to 7.

12 Hang up the phoneset.

13 Click Done until you return to the application window.
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To reimport a voice item

1 On the Define menu, click Voice items... .

2 In the Define voice items dialog box, select the voice item into which you 
want to reimport voice.

3 Click Edit... .

4 Click Import... .

5 Select the file that contains the new voice item.

6 Click Open.

7 Click OK.

8 Click Done until you return to the application window.

See also

See Chapter 10, “Maintaining applications”  for more information on VIM and 
on printing voice item details.
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Copying and pasting a voice item

Introduction

Copy and paste voice items into applications so that you do not have to re-c
voice between applications. Voice items belong to applications. To use a vo
item from an application, copy that voice item and then paste it into another
application. You need to know how to avoid replacing existing voice items b
accident.

How to copy a voice item

You can copy a voice item in one of two ways:

� Copy the block with which the voice item is already associated.

� Copy the voice item in the Define voice items dialog box.

Copy a block
When you copy a block in an application, do not copy the block’s associate
voice items. However, when you copy a block between applications, copy it
configuration plus one or more voice items.

Copy in the Define voice items dialog box
When you use the Define voice items dialog box, copy only voice items. Yo
can copy one or more voice items.

Note: Identify voice items in an application using a unique name and a uniq
ID. Voice items cannot have the same names or IDs. 

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window
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To copy a voice item

1 Open the application in which you want to copy the voice item.

2 On the Define menu, click Voice items... .

Result: The Define voice items dialog box appears.

3 In the Define voice items dialog box, select the voice item you want to copy.

4 Click Copy.

Note: The voice item is copied to the clipboard so that you can paste it. To 
do a multiple copy, select more than one voice item. 

5 Click Done to return to the application window.

To paste a voice item

1 On the File menu, click Open... .

2 Open the application into which you want to paste the voice item.

3 On the Define menu, click voice items... .

4 Click Paste.

Note: You can paste a voice item into another application, but you cannot 
paste it within the same application. Sometimes when you attempt to paste 
a voice item, the Voice Item Conflict dialog box appears because an item 
already exists with the same name, ID, or both. To paste the voice item, you 
must change the duplicate name or ID, or accept the proposed defaults.

5 Click Done to return to the application window.
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Resolving name or ID conflicts for a voice item

Introduction

Resolve a name or an ID conflict for a voice item so that you can paste the v
item in an application.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window

To resolve a name conflict, an ID conflict, or both 

1 In the Voice Item Conflict dialog box, select Default name to use the name 
or ID assigned by Application Builder. Then go to step 5. To assign your 
own name or ID, go to step 2.

2 To define a new name or ID for the voice item, select New name.

3 In the New name box, type a name for the voice item.
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4 In the New name ID box, type an ID for the voice item. 

5 Click Change All to let Application Builder assign names or IDs to all the 
voice items to be pasted or click OK to resolve each conflict individually.

Note: If you are pasting only one voice item, you return to the application 
window. If you are pasting more than one voice item, go to step 6.

6 Repeat steps 2 to 4.
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Working with faxes

In this chapter 
Section A: About working with faxes 267

Section B: Working with faxes 273
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Section A: About working with faxes

In this section
 What are fax items? 268

 Using faxes created for Meridian Mail Voice Services 270
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What are fax items?

Introduction

A fax item is made up of both a fax and a confirmation prompt. Create a fax 
to place a fax into an application.

Definition: Confirmation prompt
A confirmation prompt is a voice recording that gives callers information ab
a fax.

Example: “Recreational cycling routes for the Greater Metropolitan Area.”

How to put a fax item into an application

To include a fax item in an application, associate the item with a Fax Select
block. Use multiple Fax Select blocks to put more than one fax item into an
application. For example, to put six fax items into an application, use six Fa
Select blocks.

How the session profile affects fax items

To include fax items in any application, define fax options in the session pro
You configure how many faxes callers can receive during one call and how 
system delivers those faxes.

Maximum number of faxes per call

In the session profile, specify both the maximum number of faxes and the 
maximum number of fax pages that a caller can receive during one call. Wh
caller reaches the first maximum number in an application, a warning mess
plays and the application takes the caller to the next block.
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Types of fax delivery

In the session profile, you also configure the type of fax delivery the system
uses: 

� same-call

� callback

� caller’s choice

Same-call delivery
With same-call delivery, the caller—who must be at a faxphone—receives fa
after selecting them. Same-call delivery avoids billing problems because th
caller pays any long distance charges.

Callback delivery
With callback delivery, the caller provides a fax number to which the system
delivers faxes. This callback number must be validated against the restrictio
permission list, which you also configure in the session profile. For example
restriction could prevent the system from calling back an international faxph
number.

Caller’s choice delivery
With caller’s choice delivery, the system prompts callers to indicate whether
they want either same-call or callback delivery.

See also

For information about the session profile, see Chapter 9, “Putting applications 
into service.”

For information about the Fax Select block, see Chapter 4, “Understanding 
blocks.”

To associate a fax item with the Fax Select block, see Chapter 5, “Working with 
blocks.”
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Using faxes created for Meridian Mail Voice 
Services

Introduction

You can migrate the following items to Application Builder from faxes create
for Meridian Mail Voice Services:

� announcements

� fax items

� menus

Contents of a fax item

Each fax item from Voice Services contains

� a fax

� a confirmation prompt

How to identify migrated fax

In general, migrated faxes have the prefix “Migrated_FAX.” The prefix indica
the fax was created in Meridian Mail Voice Services. 

A fax is identified in Application Builder by a prefix of “Migrated _FAX” and 
its ID from Voice Services. For example, a Voice Services fax with an ID of 
appears as “Migrated_FAX66” in Application Builder. The description of the
application is “Migrated from Fax Service 1627.”

Within that file, you see the fax item with both a name and an ID (for examp
FaxItem 1000). 
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Format of migrated fax

In Application Builder, migrated fax is in the same format as fax items.

Access
On the server, you access migrated fax in the same way that you access fa
items.

Use
You can use migrated fax in any application that has fax functionality.

Applications that contain migrated fax

You can use migrated fax in new applications and in rebuilt applications tha
existed in Meridian Mail Voice Services. Consider when to build both types 
applications.

New applications
You can build new applications that use migrated fax either before or after t
fax is migrated from Voice Services.

If you build new applications before migration, you save time. However, you 
complete the applications and use them only after migration.

Rebuilt applications
You can rebuild applications that use migrated fax either before or after the f
migrated from Voice Services.

You save time if you rebuild applications before migration. However, you ca
complete the applications and use them only after migration. 

You can do everything at once if you rebuild applications after migration. Yo
can paste the fax into the applications during creation. Also, the migrated fa
can help you remember what to rebuild.

See also

For information about migrated announcements and voice prompts, please
Chapter 6, “Working with voice recordings.”
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Section B: Working with faxes

In this section
 Creating a fax item 274

 Editing a fax item 284

 Copying and pasting a fax item 292

 Resolving name or ID conflicts for a fax item 296

 Saving a file as a fax 298
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Creating a fax item

Introduction

When you put faxes into your applications, you can give callers more detail
information than what voice recordings provide. Faxes can give callers acce
directories, forms, lists, and maps. To put faxes into applications, you create
items.

Name and ID of a fax item

When you create a fax item, you define its name and ID.

Name
The name identifies the fax item by a unique word. The name can contain u
30 characters.

Example: map

ID
The ID distinguishes the fax item by a unique number. The number can con
up to four digits and must be in the range between 1000–3000.

Example: 1143

When you use Fax Item Maintenance, you specify fax items by their IDs. To
indicate the fax item that you want to edit, input its ID on the faxphone keyp

Where fax items are saved

As soon as you save a fax item, it appears on the server. You can access th
from any client and also remotely by phoneset using Fax Item Maintenance
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After you save a fax item

You can save a fax item if it has only a name and an ID. However, the item 
empty because it contains no fax or confirmation prompt. You can add a fax
importing or scanning it.

Import a fax

You can import faxes from anywhere on your client PC network. To import a
into a fax item, save the fax in a special format known as tagged image file 
format, class F (TIFF-F).

What is TIFF-F?
Tagged image file format (TIFF) lets you exchange image files between 
computers. Various classes of TIFF increase the portability of TIFF files. TIF
format lets you exchange fax images between computers. Even if a fax con
only text, that fax is considered an image. In CallPilot, a fax must be in TIFF
format.

Saving in TIFF-F
When Application Builder installs on your computer, a fax printer driver also
installs. The printer driver’s name is Nortel Fax. You can save files in TIFF-F
using the Nortel Fax print driver. When saving files in TIFF, be aware of its 
classes or subtypes, such as Class F. Not all subtypes of TIFF are fax-
compatible. All TIFF files, no matter what their subtype, have a TIF extensio

Printing TIFF-F files 
Printing a file as TIFF-F is similar to printing a file as PostScript (PS). You c
save any file in TIFF-F simply by printing it after selecting the Nortel Fax prin
driver.

Scan a fax

To scan a fax into a fax item, make sure the fax item exists on the server. Th
item appears on the server as soon it is created. Once the fax item is on the
server, you call Fax Item Maintenance from a faxphone. Then, you

� identify the item by inputting its ID on the faxphone keypad

� scan the fax
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Note: You can only edit a fax item using Fax Item Maintenance. You cannot
create or delete a fax item using FIM.

Confirmation prompts

A confirmation prompt is a voice item that gives information about the fax. 

How to create a confirmation prompt
To create a confirmation prompt that gives callers information about a selec
fax, create a voice item.

Blank confirmation prompts
If a confirmation prompt is blank, then the system does not play it. However,
confirmation prompt contains no voice but some background noise, then th
system plays the full prompt. Make sure there are no confirmation prompts 
background noise that callers will hear.

See also

For information about what to include in a fax item, see Chapter 2, “Creating 
applications.”

For information about Fax Item Maintenance, see Chapter 10, “Maintaining 
applications.”

For information about how to create voice items, see Chapter 6, “Working with 
voice recordings.”

How to create a fax item

Follow these procedures to create a fax item:

1. To define a fax item.

2. To import a file that contains a fax.

Follow these procedures to create a confirmation prompt that describes a fa

1. To record voice for a fax item. 
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2. To import a file that contains voice for a fax item.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window

To define a fax item

1 On the Define menu in the application window, select Fax Items... .

Result: The Define fax items dialog box appears.
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2 Click Add... .

Result: The Add fax item dialog box appears.

3 In the Name box, type a name to identify the fax item.

4 In the ID box, accept the proposed default or type a number to identify the 
fax item.

5 To include a description of the fax, in the Fax description box, type 
information about the fax.

6 To include a description of the confirmation prompt, in the Fax confirmation 
description box, type information about the prompt.

7 Click Done.

Result: The Edit fax item dialog box appears.

8 Click OK.

9 Click Done.

To import a file that contains a fax

Before you import a file that contains a fax you must save that file as a fax. 
“Saving a file as a fax” on page 298 for more information.
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1 On the Define menu, click Fax items... .

Result: The Define fax items dialog box appears.

2 In the Define fax items dialog box, select the fax item into which you want to 
import the fax.

3 Click Edit... .

Result: The Edit fax item dialog box appears.

4 Under Fax item content box, click Import... .

Result: The Import fax item dialog box appears.

5 Select the file that contains the fax.

6 Click Open.

Result: The Edit fax item dialog box reappears.

7 Click Done until you return to the application window.
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To record voice for a fax item

1 On the Define menu, click Fax items... .

Result: The Define fax items dialog box appears.

2 In the Define fax items dialog box, select the fax item for which you want to 
record voice.

3 Click Edit... .
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Result: The Edit fax item dialog box appears.

4 Under Fax item confirmation content, click Record... .

5 In the Specify Phoneset box, type the phone number of the phoneset you 
want to use for recording.

6 Click Dial.

7 Answer the phoneset when it rings.

8 Click Record.

9 Speak the content of the confirmation prompt.

10 Click Stop.

11 If you are satisfied with the recording, click Done, and go to step 13.

12 If you are not satisfied with the recording, repeat steps 8 through 10.

13 Hang up the phoneset.

14 Click Done until you return to the application window.
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To import a file that contains voice for a fax item

1 On the Define menu, click Fax items... .

Result: The Define fax items dialog box appears.

2 In the Define fax items dialog box, select the fax item into which you want to 
import the voice file.

3 Click Edit... .
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Result: The Edit fax item dialog box appears.

4 Under Fax item confirmation content, click Import... .

5 Select the file that contains a recording that describes the fax.

6 Click Open.

7 Click Done until you return to the application window.
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Editing a fax item

Introduction

Both Application Builder and Fax Item Maintenance (FIM) enable you to ed
fax items. Use Application Builder to do maintenance when you are at the of
Use FIM to edit fax items using a faxphone when you are away from the off

IDs and FIM

You can print out the details for all fax items in an application. These details
include the IDs of all the fax items. When you know the IDs, you can use FI

How to edit a confirmation prompt

If you edit the content of a fax item, often you also have to edit the confirma
prompt. You edit the voice item used for a confirmation prompt just as you e
any other voice item.

Definition: Online updating

Online updating means that callers do not encounter edited items until after
finish changing and saving them, and saving and closing the application in 
which they reside. An application does not update until you save it and you
callers exit from the application.
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Example: Online updating

The fax that shows directions to your company contains an incorrectly labe
street, so you must replace it with a new map.

You do not prevent callers from accessing the application, because the mis
on the map does not affect the application. To take the application out of se
would cause more problems. A caller accesses the application before you o
and change the fax. Immediately after the caller accesses the application, y
replace the old map with the new one. You import the new map in a TIFF-F 
Then, you save the fax item, and save and exit from the application. You ex
from the application before the caller exits.

When the caller selects the fax, she gets the old map. She accessed the las
application, which contains the old map. After she exits from the application 
receives the fax, the caller contacts the receptionist to point out the error in
map. The receptionist tells the caller to redial the application and reselect th
fax. The caller accesses the updated and saved application, and now receiv
correct fax.
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How to edit and delete fax items

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window

To edit a fax item

1 In the application window, click Fax items.... from the Define menu.

2 In the Define fax items dialog box, select the file you want to edit.

3 Click Edit.... .
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Result: The Edit fax item dialog box appears.

4 In the Name box, select the existing name and then type a new one.

5 In the Description box, select the existing text and then type new 
information.

6 In the Description box, select the existing text and then type new 
information about the prompt.

7 To re-create the confirmation prompt that describes the fax see, “To record 
voice for a fax item” on page 280 or “To import a file that contains voice for 
a fax item” on page 282.

8 To reimport a file that contains a fax, see page 288.
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x. 
To reimport a file that contains a fax

Before you reimport a file that contains a fax, you must save that file as a fa
See“Saving a file as a fax” on page 298 for more information.

1 On the Define menu, click Fax items... .

2 In the Define Fax Items dialog box, select the fax item into which you want 
to reimport the fax file.

3 Click Edit.... .

Result: The Edit fax item dialog box appears.

4 Under Fax item content, click Import... .

5 Select the file that contains the fax.

6 Click Open.

7 Click Done until you return to the application window.

To rerecord voice for a fax item

1 On the Define menu, click Fax items... .

2 In the Define fax items dialog box, click the name of the fax item into which 
you want to reimport the file.
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3 Click Edit... .

Result: The Edit fax item dialog box appears.

4 Under Fax item confirmation content, click Record... .

5 In the Specify Phoneset box, type the phone number of the phoneset you 
want to use for recording.

6 Answer the phoneset when it rings.

7 Click Record.

8 Speak the confirmation prompt.

9 Click Stop.

10 If you are satisfied with the recording, click Done, and go to step 12.

11 If you are not satisfied with the recording, repeat steps 7 to 10.

12 Hang up the phoneset.

13 Click Done to return to the application window.

To reimport a file that contains voice for a fax item

1 On the Define menu, click Fax items... .

2 In the Define fax items dialog box, select the fax item into which you want to 
reimport the voice file.
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3 Click Edit... .

Result: The Edit fax item dialog box appears.

4 Under Fax item confirmation content, click Import... .

5 Select the file that contains the voice you want to import.

6 Click Open.

7 Click Done until you return to the application window.

To delete a fax item

1 On the Define menu, click Fax items... .

2 In the Define fax items dialog box, click the name of the fax item you want to 
delete.

Note: Be sure to select the correct item. The system does not prompt you 
again before deleting the selected file.

3 Click Delete.

4 Click Done to return to the application window.
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To configure how Fax Item Maintenance users can edit fax items

1 On the File menu, click Properties... .

Result: The File properties dialog box appears.

2 Click the Security tab.

3 In the Number box, type the phone number of the fax machine that receives 
faxes modified in Fax Item Maintenance.

4 To have your extension number appear on the cover sheets of modified 
faxes, in the Contact box, type your extension number.

5 To let Fax Item Maintenance users change the phone number of the 
verification fax machine, make sure the Allow modification of fax verification 
number from telset box is checked.

6 To let Fax Item Maintenance users change the confirmation prompts of fax 
items, make sure the Allow modification of fax confirmation prompt from 
telset box is checked.

7 Click OK to return to the application window.
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Copying and pasting a fax item

Introduction

Copy and paste fax items  to save having to re-create faxes between applica
Fax items belong to applications. To use a fax item from one application, co
that fax item and then paste it into another application. You also need to kn
how to avoid replace existing fax items by accident.

How to copy a fax item

Copy a fax item in one of two ways:

� Copy the Fax Select block with which the fax item is already associate

� Copy the fax item in the Define Fax Items dialog box.

Copy a Fax Select block
When you copy a Fax Select block within an application, you do not copy it
associated fax item. However, when you copy a Fax Select block between 
applications, you copy its associated fax item. Copy a Fax Select block betw
applications to copy its configuration plus its fax item.

Copy in the Define Fax Items dialog box
Use the Define Fax Items dialog box to copy fax items. You can copy one o
more fax items.

How to paste a fax item

Based on how you copy a fax item, paste it in one of two ways:

� Paste the copied Fax Select block with which the fax item is already 
associated into another application.

� Paste the copied fax item in the Define Fax Items dialog box of anothe
application.
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Unique names and IDs

You identify fax items in an application by

� name

� ID

Each fax must have a unique name and ID. 

When you paste a fax item

When you try to paste a fax item, Application Builder checks its name and I
against all the other names and IDs of fax items already in the application. 
Because each name and ID must be unique, Application Builder notifies yo
an existing fax item already has that name, ID, or both. By notifying you, 
Application Builder ensures you replace an existing fax item with the item to
pasted only if you want to do so. If you do not want to replace the existing it
you can change the name, ID, or both, of the item you want to paste.

Name or ID conflicts
In a partial conflict, an existing fax item has the name or ID of the fax item y
want to paste. In a full conflict, the existing fax item has both the name and
ID of the fax item you want to paste.

Default names and IDs

Whenever a conflict occurs, Application Builder proposes default names an
IDs for the fax items you want to paste. Use the default names and IDs to s
time. You can always change the names later.
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How to copy and paste fax items

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window

To copy a fax item

1 Open the application from which you want to copy the fax item.

2 On the Define menu, click Fax Items... .

3 Under Fax Items, select the fax item you want to copy.

4 Click Copy.

Note: Copy the fax item to the clipboard so that you can paste it. To make 
multiple copies, select more than one fax item. Click Done to return to the 
application window.

To paste a fax item

1 On the File menu, click Open... .

2 Open the application into which you want to paste the copied fax item.
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3 On the Define menu, click Fax items... .

4 Click Paste.

Note: Sometimes when you attempt to paste a fax item, the Block Name 
Conflict dialog box appears because an item already exists with the same 
name, ID, or both. You must change the name or ID to paste the new item.

5 Click Done to return to the application window.
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Resolving name or ID conflicts for a fax item

Introduction

Resolve a name or ID conflict for a fax item so that you can paste the fax ite
into an application. If the fax item you are trying to paste conflicts with an 
existing fax, the Fax Item conflict dialog box appears.

To resolve a name or ID conflict for a fax item

1 In the Fax item conflict dialog box, select Default name to use the name or 
ID assigned by Application Builder. Then go to step 5. To assign your own 
name or ID go to step 2.

2 To define a new name or ID for the fax item, make sure New name is 
selected.

3 In the New name box, type a name for the fax item.

4 In the New name ID box, type an ID for the fax item. 
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5 Click Change All to let Application Builder assign names or IDs to all the fax 
items to be pasted, or click OK to resolve each conflict individually.

Note: If you paste only one fax item, return to the application window. If you 
paste more than one fax item, go to step 6.

6 Repeat steps 2, 3, and 4.
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Saving a file as a fax

Introduction

Save a file as a fax to ensure it is in TIFF-F, the only format that fax items 
support. Then, you can import the saved fax into a fax item.

To save a file as a fax

1 In the file you want to save as a fax, on the File menu, click Print.

2 From the list of printers, select Nortel Fax.

3 Click Print or OK.

4 Click No.

5 To add another file to the fax, repeat steps 1 to 4.

6 To view a file with fax viewing software, select the file and click View/Edit 
Image. When you are finished, on the File menu, click Exit.

7 To delete a file, select it and click Delete Item.

8 To scroll up and down the list of files, click Move Forward and Move 
Backward.

9 Click Save As… .

10 From the Save as type list, select TIFF-F Files (*.tif).

11 In the File name box, before .tif, type a name for the fax.

12 From the Save list, select the directory in which you want to save the fax.

13 Click Save.
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Reusing existing applications

In this chapter 
Section A: About reusing applications 301

Section B: Reusing applications 309
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Section A: About reusing applications

In this section
 How to reuse applications 302

 Precautions for reusing applications 305
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How to reuse applications

Introduction

You can reuse functions that already exist in applications in various ways. A
result, you do not have to re-create parts of applications or entire applicatio
they already exist.

Three ways to reuse applications

You reuse applications in three ways:

� by copying and pasting blocks

� by saving applications under other names

� by exporting and importing applications

Copy and paste blocks

Copy blocks within an application if you want to use their configuration. Cop
blocks between applications if you want to use their configuration and their 
associated voice and fax items.

Example
Copy both an Announcement block and a Thru-Dial block from an applicati
to paste into another application. Copy the Announcement block because y
want to use the voice item associated with the Announcement block. Copy 
Thru-Dial block because you need its configuration in the new application. 
Callers can define which number they want to reach. They must enter a num
of at least four digits.

Save applications under other names

If an application has a reusable structure and various blocks configured as 
want, you can save that application under another name. Then, you custom
the renamed application.
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Example
An application called “Depts” contains these blocks: Menu, Announcement,
multiple Thru-Dials. In a new application, you need the same blocks in the s
arrangement. However, the new menu must give callers options for how to 
information from a particular department rather than which departments the
can reach. The Thru-Dial blocks, associated with the menu keys, pass calle
specified extension numbers.

Save “Depts” as “Sdept.” In “Sdept,” which stands for sporting goods 
department, you modify the Menu block so that it tells callers whom they ca
reach in the department. You also change the specified extension numbers
each of the Thru-Dial blocks so callers can transfer to people in the sporting
goods department. Because the Announcement block plays a voice item th
gives general help for any menu, you do not change this block.

Export and import applications

Sometimes you need to reuse a large part of an application regularly. You c
create that part only once. Then you export the application so that you can 
import it into other applications that need the same functions.

Example
You need to use an automated attendant in various applications. Instead of
re-creating that functionality every time you need it, you create one automa
attendant application. You create an application that has the following block
Day Control, Time Control, Announcement, Menu, Thru-Dial, and Call 
Transfer.

You then configure the blocks. You configure the Day Control block so that 
routes callers to the Time Control block on business days. On nonbusiness 
callers hear an announcement that lists business days and hours. Callers h
same announcement if they reach the Time Control block after business ho
On a business day and during business hours, callers go to the Menu block

You configure the Menu block so callers hear a greeting that gives them two
options: “Hello. Thanks for calling Oswald Law Offices. If you know the 
extension of the person you wish to reach, press 1. If you don’t know the 
extension, press 2.” You connect the Thru-Dial block to the number 1 menu
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This allows callers to dial people only by number. You connect the Call Transfer 
block to the number 2 menu key. You also configure that block to pass callers to 
a live attendant. As a result, callers reach someone who can direct their calls to 
the appropriate people.

After you complete the application, you save it as “Attendant” and export it. 
Whenever you need to add an automated attendant to another application, you 
import “Attendant.”

See also

For information about each block and about exporting and importing 
applications, see Chapter 4, “Understanding blocks.”

To copy and paste blocks, see Chapter 5, “Connecting blocks,” on page 193.
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Precautions for reusing applications

Introduction

Take precautions to ensure that errors do not occur when you import and e
applications and save them under other names.

When to save an application

When you save an application under another name, ensure that its name a
are unique on the hard drive partition on which the application resides. 
Otherwise, you can overwrite another application.

When to import and export applications

Take the following precautions before and after you export, and when you 
import.

Before you export
You can export an application only when it is complete. A complete applica
has all its blocks configured and connected, and it is saved. Any blocks that 
a pink border are not configured or connected.

After you export
After you export an application, a Continue block appears in its window. Th
Continue block enables callers to move from the exported application to the
importing application. For example, callers call the importing application, go
the exported application, and then go back to the importing application. 
Therefore, connect any blocks to the Continue block that should take caller
from the exported application to the importing application. If you do not conn
a block to the Continue block, the exported application is the terminating 
application.
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When to import
The exported, or source, application is represented by an Imported Applica
block in the importing application. The Imported Application block has the sa
name as the source application. The importing application is known as the 
destination application. 

Both outputs of the Imported Application block correspond to parts of the so
application. Like every application, the source application has an End block
End block corresponds to the Imported Application block’s End output. 
Similarly, the source application’s Continue block corresponds to the Impor
Application block’s Continue output. Therefore, you pass callers to the Cont
block in the source application. Then, the Continue output of the Imported 
Application block directs where callers go next in the destination application

Unsuccessful importing and exporting

If you do not take precautions while exporting and importing applications, 
callers can follow the wrong application flow. For example, if you do not 
connect the appropriate blocks in the source application to the Continue blo
then callers cannot move from that application to the destination application

Restrictions on the number of levels

You cannot have more than 20 levels of imported applications. However, th
system does not limit how many imported applications you use.

Restrictions on deleting applications

To ensure that all exporting and importing works smoothly, the system does
let you delete an application if it is imported or if it appears in the SDN Tabl
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See also

For information about the Continue block, see “Continue block” on page 162.

For information about using the Continue and Imported Application blocks, see 
“How the Continue and Imported Application blocks work together” on page 
171.

For information about the SDN Table, see Chapter 9, “Putting applications into 
service.”
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Section B: Reusing applications

In this section
 Saving an application under another name 310

 Exporting an application 312

 Importing an application 314
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Saving an application under another name

Introduction

Save an application under another name to base a new application on the c
application.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window

To save an application under another name

1 On the File menu, click Save As.

Result: The Save As dialog box appears.

2 In the File name box, type a name for the new application to which you want 
to save data.
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3 In the Application ID box, type a unique number for the new application.

4 To move the new application to another hard drive partition, from the 
Volume ID list, select another number.

5 Click Save As to save the data as a new application and return to the 
application window.

See also

To save an application under another name, see “How to reuse applications” on 
page 302.

For information about reusing applications, see “Precautions for reusing 
applications” on page 305.
Application Builder Guide 311



Reusing existing applications  Standard 1.0

nd 
Exporting an application

Introduction

Export an application so other applications can import it and use its 
functionality.

Note: Before you export an application, you must complete all of its blocks a
save it.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window

To export an application

1 On the File menu, click Export. 

Result: A Continue block appears in the application window.

2 To the Continue block, connect any blocks from which callers should go to 
the destination application.

Example: You connect the output of a main menu to the Continue block. 
Therefore, after callers press the appropriate menu key, they pass to the 
destination application, which lets them select faxes.

To cancel an export

In the application you no longer want to export, on the File menu, click Undo 
Export.

Note: You cannot cancel an export if the application has been imported by 
another application.
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See also

For information about exporting an application, see “How to reuse applications” 
on page 302.

For information about the Continue block, see “Continue block” on page 162.

For information about using the Continue and Imported Application blocks, see 
“How the Continue and Imported Application blocks work together” on page 
171.
Application Builder Guide 313



Reusing existing applications  Standard 1.0
Importing an application

Introduction

Import an application to use its functionality without having to re-create it.

Note: You must export an application before you can import it into another 
application.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder > 
application window
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To import an application

1 On the File menu, click Import.

Result: The Import dialog box appears

2 Select the application you want to place in the current application.

3 Click Import.

4 In the palette, click the Imported Applications tab.

5 Move the appropriate Imported Application block to the application window.

6 Connect the Continue output of the Imported Application block to another 
block.
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To cancel an import

1 In the appropriate application, on the File menu, click Remove Import.

Result: The Undo Import dialog box appears.

2 Select the application you want to remove from the current application.

3 Click Undo Import to remove the imported application and return to the 
application window.

Note: Imports cannot be cancelled if that application is referenced in the 
current application.
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See also

For information about importing an application, see “How to reuse applications” 
on page 302.

For information about using the Continue and Imported Application blocks, 
“How the Continue and Imported Application blocks work together” on page
171.
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Putting applications into service

In this chapter
 How applications become services 320

 How callers are routed to services 321

 Why you set up the session profile for services 322

 Using a cover page for fax services 326

 How to test applications 328
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How applications become services

Introduction

Before you can call and test an application that you have created, you must 
it available. You need to know which applications you should make availabl
and how to do so by configuring the SDN Table.

Complete applications

Before you can make applications available, make sure they are complete. 
blocks in an application must be connected and configured. You must save
complete application.

How to make an application become a service

To make a complete application available so that you can dial and test it, yo
must add its telephone number, or DN, to the SDN Table. Until you do this,
application exists only in the system and is not accessible to callers.

What happens when you make an application available

An application becomes a service when you add an SDN to the SDN Table
that application. 

Example
You are creating a voice menu application in Application Builder. While you
work on the voice menu, it is considered an application. While you design a
create the application, it is not available to callers. 

Once you finish designing and creating the application, you are ready to pu
into service so that you can test it. To do this, you add an SDN for the voice
menu to the SDN Table. This puts the application into service and you can 
dial the voice menu.
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How callers are routed to services

Introduction

When you route callers through your application, keep in mind how calls ar
routed from the switch to services. Also consider how you configure the SD
Table and SDNs. 

SDNs

Each CallPilot service that callers access by dialing a number needs an SD
the SDN Table. You need to know what SDNs are and how to configure the
control the channels that are allocated to services.
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Why you set up the session profile for 
services

Introduction

Some SDNs require additional configuration. You configure a session profile
all SDNs associated with Application Builder services.

Definition: Session profile

A session profile is a set of operational characteristics that is associated wit
SDN of certain CallPilot services, including the services created in Applicat
Builder. The session profile determines how a service behaves when it is ca
and the length of time that callers can use the service.

Multiple session profiles for one service

The session profile determines the behavior of a service on a per-SDN basis
can enter the same service into the SDN Table more than once, with a diffe
SDN for each entry. As well, you can configure the session profile of each S
differently. Consequently, the same service can behave differently based on
SDN that callers dial.

Example 1
You have a service that contains fax items. In the SDN Table, add two SDN
the service. Because you know that some callers can call the service from 
faxphones, configure the first SDN’s session profile to use same-call deliver
Configure the second SDN’s session profile to use callback delivery becaus
other callers can access the service only from a phoneset.

Example 2
Your company’s corporate directory appears in two services. The first servic
a main menu from which external callers access the directory. The second 
service is the directory that employees access. Each service has its own SD
and, therefore, its own session profile. For the first service, configure a lowe
number of maximum invalid selections. You do so for security reasons. For 
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second service, configure a higher number of maximum invalid selections. 
Security is less of an issue where internal callers are concerned. Also to en
security, give the external callers’ service a shorter session limit than the 
employees’ service.

What the session profile controls

The session profile affects all Application Builder services. In particular, it 
affects the following blocks: Fax Select, Fax Send, and Menu. You must 
configure more session profile options for services with fax capability.

All Application Builder services
For all Application Builder services, the session profile determines the follow
aspects:

� the maximum length of a call session

� the maximum number of password failures allowed for services that con
the Password Check block and, therefore, have password-protected co

Application Builder services with fax capability
To include fax items in an application, define the application’s fax options in
session profile of the SDN Table. In the session profile, establish settings fo
fax applications and other settings that are specific to fax applications that u
callback delivery.

For all fax applications
In the session profile, establish the following settings for all fax applications

� the maximum number of faxes a caller can select during one call

� the maximum number of fax pages that the system delivers to a caller 
during one call

� the telephone number of the fax machine that the system uses to send

� the fax delivery method (callback, same-call, caller’s choice)

� whether a custom cover page, called a sponsor fax item, transmits with 
fax

� how page transmission errors are handled
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For fax applications that use callback delivery
In the session profile, you also establish the following settings for fax 
applications that use callback delivery:

� the DN to which fax callback transmissions are billed

� whether the system cover page transmits with each fax

� the extension number of the recipient of the fax

� the type (for example, national) of faxphone number for which the syste
must prompt callers so it knows where to deliver faxes

� the restriction/permission list against which the faxphone number must
validated before the system can make a fax callback transmission

Types of fax delivery

For services with fax capability, in the session profile, configure which type 
fax delivery the system uses: 

� same-call

� callback

� caller’s choice

Same-call delivery
With same-call delivery, the caller—who must be at a faxphone—receives fa
after selecting them. Same-call delivery avoids billing problems, because th
caller pays any long distance charges.

Callback delivery
Configure callback delivery if callers will access fax applications from a 
phoneset. With callback delivery, the caller provides the number of a faxpho
to which the system delivers faxes. 

If you configure callback delivery for services with fax capability, then you m
configure callback handling. This ensures that callers are prompted to ente
callback numbers in the appropriate format based on where they are calling
from. Each callback number must be validated against the RPL, which you 
configure in the session profile. For example, a restriction can prevent the 
system from calling back an international faxphone number.
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Caller ’s choic e delivery
With caller’s choice delivery, the system prompts callers to indicate if they want 
either same-call or callback delivery.

See also

Read more about “Fax Select block” on page 110 and “Fax Send block” on page 
118.
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Using a cover page for fax services

Introduction

From the SDN Table, configure both the session profile and callback handli
In the session profile, you can set up a custom cover page (called a sponso
to send with all your faxes. In callback handling, you configure how faxes se
using callback delivery. You also configure whether a system cover page se
with those faxes. The two cover pages are different, and they work together

What information appears on the two cover pages

A system cover page contains information defined by the system. However,
can define the information that appears on a custom cover page. When you
define that information, remember that a custom cover page is sent with all 
transmissions, including callback faxes. Include all important information on
that page. Also remember that a system cover page sends only with callbac
transmissions.

System cover page
On a system cover page, the system automatically generates the following 
information:

� the caller’s extension number (The system puts this number on the pag
only if you configure, in callback handling, that the system prompts the
caller for the extension.)

� the number of the fax machine entered by the caller

� the sender’s name and address (This information is entered in the sess
profile.)

� the total number of pages sent (including the cover page)

� the date and time the fax was submitted by the system for delivery

� instructions that the recipient should rerequest the information from the
service if the fax does not transmit properly
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Custom c over  page
Define all the information that appears on a custom cover page. This cover page 
transmits with all faxes. Therefore, include important information, such as your 
company logo, and the name and number of a contact person.

A custom cover page is a soft-copy file in tagged image file format, class F 
(TIFF-F). You can save a file in TIFF-F by using the Nortel Fax printer driver 
that installs with Application Builder or by using fax-viewing and graphics 
software.

Transmission o rder for c over pages

Both the system and custom cover pages send only if you configure them to do 
so. The system cover page always transmits before the custom cover page. 
Therefore, if you configure both cover pages and the system sends a callback fax 
transmission, the fax transmits in the following order:

1. system cover page

2. custom cover page

3. fax pages

See also

For information about TIFF-F, see Chapter 7, “Working with faxes.”
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How to test applications

Introduction

Callers interact with applications by listening and responding to voice. After 
build an application and before you publish its SDN to callers, you must tes
You test an application by interacting with it from a caller’s perspective.

Why you test
Testing an application enables you to access and interact with it from a call
perspective and, therefore, gain valuable design input. Testing also gives yo
chance to ensure that the application works as you intended.

When to test
You should test an application only after you believe it is complete and befo
you publish its SDN to callers.

What to test
To test an application, put it in the SDN Table, call it, and interact with all of
flow. For example, if a menu has five options, follow each of those options 
through to its end to ensure it works properly. Do the following when you te

� Give no DTMF response at the beginning of the application to verify how
handles rotary-dial callers.

� Make no response at various times throughout the application to confir
that it correctly prompts callers to give input.

� Give incorrect responses at various times throughout the application to
ensure that it correctly directs callers to give input.

� Make enough no responses in the application to check how it handles 
out periods.

After you test an application

After you are sure an application has no errors, publish its SDN so that call
can phoneset into and use the application.
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Maintaining applications

In this chapter 
Section A: About maintaining applications 331

Section B: Checking and printing application details 337

Section C: Using telset maintenance 349

Section D: Archiving and restoring applications 361
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Section A: About maintaining 
applications

In this section
 What maintaining applications means 332

 How online updating affects application maintenance 334
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What maintaining applications means

Introduction

Application development never really ends. However, you usually reach a p
at which you finish creating applications and begin to maintain them.

To maintain applications, you need to perform tasks such as 

� checking and printing application details

� updating voice and fax items

� archiving and restoring applications

� testing updated applications before you make them available to callers

Who maintains applications

Application Builder allows for two administration roles: application and telse
Usually, one person fills both roles.

Application administration
In application administration, you create and maintain applications using 
Application Builder. You often also create and maintain voice and fax items

Telset maintenance
In telset maintenance, you maintain the voice and fax items in applications u
a phoneset from a remote location when you cannot use a client. To perform
telset administration, you require a telset maintenance password.

How to maintain applications

The following list presents general information about each type of maintena
For more information about a particular type, see the corresponding section
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Check and print application details
Check and print application details to collect both general and specific 
information about an application. Then use the information to maintain 
applications and share tasks with other administrators.

Use telset maintenance
Telset maintenance enables you to keep voice and fax items up to date with
phoneset. Therefore, you can always change applications, even when you 
a remote location. When you update items with your phoneset, you use two
services: Voice Item Maintenance and Fax Item Maintenance.

Archive and restore applications
When you archive applications, you preserve their information. If you need 
recover applications or move them to another server, simply restore them.
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How online updating affects application 
maintenance

Introduction

Whenever you change an application, using either Application Builder or te
maintenance, callers do not experience the changes until you save the 
application. Before you update applications, you must understand both whe
and how those updates affect callers.

Definition: Online updating

Online updating means that you can edit applications even while callers use
them. Because editing and using can take place simultaneously, callers bec
aware of the changes only when they call the application again.

When callers become aware of updates
Callers encounter changes in applications only after you save them. Theref
callers always use the last saved version of an application for an entire call
never experience updates in the middle of a call. They experience the updat
next time they call the application.

How online updating affects telset maintenance
Online updating is not different for applications updated by telset maintenan
However, you can change only voice and fax items using telset maintenanc
Only after you update and save voice and fax items and then save the applic
in which they reside can callers access that application and experience the
updated items.

Examples of online updating

The following examples of online updating show how it affects applications 
modified both by Application Builder and telset maintenance.
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Example 1
An application contains an Announcement block and a Thru-Dial block. The
Announcement block plays a non-interruptible greeting. Callers then move 
the Thru-Dial block.

The greeting contains some important information plus instructions for using
Thru-Dial block. You decide to associate the important information with anot
Announcement block that appears earlier in the application. As well, you de
that the instructions should be interruptible for experienced callers. Therefo
you want to associate the instructions with the Thru-Dial block which, by 
default, can be interrupted.

A caller accesses the application a few seconds before you begin editing it.
While she is listening to the non-interruptible greeting, you delete its 
Announcement block. You add the information to the voice item associated 
the earlier Announcement block. You also associate a voice item made up 
of instructions with the Thru-Dial block. The caller is never aware of these 
changes. She experiences only the last saved application.

You save and exit from the application. As you do so, the caller reaches the 
mailbox of the person she dialed. Instead of leaving a message, she decide
call the application again and dial another person. This time, she accesses
updated application. When she reaches the Thru-Dial block, the caller interr
its instructions and dials the other person’s phone number.

Example 2
You maintain applications for a company that sells swimming pools and 
supplies. One night, your supervisor calls you at home and informs you that
must change the fax that lists available chemicals immediately because the
representatives are at a conference and need the information. Your supervi
faxes you the updated list.

You call Fax Item Maintenance. You specify both the appropriate applicatio
and the fax item by ID. Then, you scan the updated list into the item.

While you are scanning the fax, a sales representative calls the application 
the list. You save the fax item and the application before he selects the list. 
However, he receives the out-of-date list because he accessed the applicat
while you were editing it, but before it was saved. 
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The sales representative calls to complain that the list has not been updated
explain that he did not get an updated list because he called while you were
making the changes. After the new list is available, you can advise all sales
representatives to pick up the new list.
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Section B: Checking and printing 
application details

In this section
 Checking and printing application details 338

 Checking application details 340

 Printing application details 344
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Checking and printing application details

Introduction

Check and print application details to get both general and specific informa
about an application. The information helps you to maintain applications on
or from a remote site. Also, the information lets you communicate changes 
other administrators.

Why you check an application’s details

You check an application’s details to find out general information, such as th
application’s ID, customer number, description, and level of completeness w
in the application. In particular, updating the description and knowing the le
of completeness help you with administrative tasks.

Description
When you maintain or edit an application, update its description. You can w
information about the application’s use and configuration. As well, you can 
identify what changes you make to an application to prevent others from ma
the same changes.

Completeness
When you check an application’s details, you can quickly see whether the 
application is complete. Otherwise, you must look at the application’s flow a
ensure that none of its blocks have a pink border. After you know that an 
application is complete, you can export it or add it to the SDN Table.

Types of print documents

You can print three types of documents for an application:

� application flow

� block details

� voice and fax item
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Application flow document
Print an application flow document to see an application’s graphical layout. 
looking at the layout, you can see which blocks make up the application and
they connect to one another.

Block details document
Print the block details document to find out the configuration of each block in
application. In the header of each page, you see the page number and the 
application’s name and ID. Used with the application flow document, the blo
details document gives you detailed information about a particular block in 
application.

For example, if you want to find out about an application’s Thru-Dial block, u
the block details document. In the document, you find which voice item (and
name and ID) plays when callers reach the block, which type of dialing is 
allowed, and if left-pad digits and variable-length numbers are set up. If they
set up, you also learn the numerals specified for them.

Voice and fax item document
Print an application’s voice and fax item document to find out information ab
each voice and fax item in the application. The document lists each item’s n
ID, and description. The description of a voice item is its script. The descrip
of a fax item is the script of its confirmation prompt plus the file name of its 

Why you print an application

Because of the levels of detail provided in the three documents, you can sh
tasks with other administrators. As well, you can easily perform telset 
maintenance by always having information about voice and fax items on ha

For details on how to print, see the online Help for Application Builder.
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Checking application details

Introduction

When you check the details of an application, you learn its status. When yo
include a description of the application, you can advise others of the 
application’s status. A voice recording of the application’s title lets telset 
maintenance users easily identify the application. You can also configure 
whether pasting and deleting in an application requires confirmation.

Getting there  CallPilot Administration Client > CallPilot system > System 
Administration > Service Administration > Application Builder > 
application window

To set confirmation for a paste and delete

On the Options menu, click Confirm Paste/Delete so that a check mark appears 
beside the selection.

To cancel confirmation for a paste and delete

On the Options menu, click Confirm Paste/Delete so that the check mark beside 
the selection disappears.

To see an application’s name, ID, and description

1 On the File menu, click Properties.

2 Click the General tab.

3 Click OK to return to the application window.
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To edit the description of an application

1 On the File menu, click Properties.

2 Click the General tab.

3 In the Description box, select the existing text, and then type new 
information about the application.

4 Click OK to return to the application window.

To check whether an application is complete

1 On the File menu, click Properties.

2 Click the General tab.

3 If the Complete box says Yes, you can export or install the application.

4 Click OK to return to the application window.

To check whether an application is exported

1 On the File menu, click Properties.

2 Click the General tab.

3 If the Exported box says Yes, the application has already been exported.

4 Click OK to return to the application window.

To check locked applications

1 On the File menu, click Locks.

2 Look at the list of applications.

3 Click Done to return to the application window.
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To record a title for an application

1 On the File menu, click Properties.

2 Click the General tab.

3 Click Record through phoneset.

4 In the Specify Phoneset box, type the number of the phoneset you want to 
use for recording.

5 Click Dial.

6 Answer the phoneset when it rings.

7 Click Record.

8 Speak the title of the application.

9 Click Stop.

10 If you are happy with the recording, click Done and go to step 12.

11 If you are unhappy with the recording, repeat steps 6 through 9.

12 Hang up the phoneset.

13 Click OK to return to the application window.

To import a file that contains the title of an application

1 On the File menu, click Properties.

2 Click the General tab.

3 Click Import from .WAV file.

4 Select the file that contains a recording of the application’s title.

5 Click Open.

6 Click OK to return to the application window.
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See also

For information about application IDs, see “Creating, saving, and closing 
applications” on page 69.

For information about telset maintenance, see “Understanding telset 
maintenance” on page 350.

To lock and unlock applications, see “Opening applications” on page 72.

To make recordings, see Chapter 6, “Working with voice recordings.”
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Printing application details

Introduction

You can print the complete layout of an application, or you can print details 
its blocks, fax items, and voice items. The application’s layout prints as a ha
copy flowchart. When you use borders, you can easily join a flowchart that 
spans more than one page. When you print details, you always have inform
on hand for telset maintenance.

Getting there  CallPilot Administration Client > CallPilot system > System 
Administration > Service Administration > Application Builder > 
application window

To edit the printer settings

1 On the File menu, click Print Setup.

2 Adjust any printer settings.

3 Click OK to return to the application window.

To turn a border on or off for application printouts

On the Options menu, click Print Frame so that a check mark appears beside 
the selection.

To print the layout of an application

1 On the File menu, click Print Flow.

2 Adjust any printer settings.

3 Click OK to print the contents of the application window and return to the 
application window.
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To print details for all the blocks in an application

1 On the File menu, click Print Block Details.

2 Adjust the appropriate printer settings.

3 Click OK to print the details and return to the application window.

To print details for all the voice and fax items in an application

1 On the File menu, click Print Voice/Fax Items.

2 Adjust the appropriate printer settings.

3 Click OK to print the details and to return to the application window.

To print an application from another location

You can print an application on another PC if the client you are working from
not connected to a printer. 

1 Save the application in a TIFF format.

2 Copy it to a disk or send it via email to the desired location.

3 Print the application using a fax viewing software.
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Saving an application to a TIFF format

1 Within the application, select one of the Print options from the File menu.

Result: The print dialog box appears

2 Select the Nortel Fax print driver.

3 Click ok.

Result: The Compose Fax dialog box appears

4 Select Save As from the SAVE this fax a file box. 
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Result: The Save As dialog box appears.

5 Type in the name for the file.

6 Select the location where you want to save the file.

7 Click Save.

Result: The Come Fax dialog box reappears.

8 Click Cancel from the CANCEL this fax box. The dialog box disappears and 
the applications appear.

Printing the application from a TIFF format

1 Locate the TIFF file.

2 Double-click on the file.

Result: The file open using the fax viewing software.

3 Under the File menu, select Print.

Result: The file prints.

See also

For information about blocks, see Chapter 4, “Understanding blocks.”
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For information about different types of printouts, see “Checking and printing 
application details” on page 338.

For information about voice items, see Chapter 6, “Working with voice 
recordings.”

For information about fax items, see Chapter 7, “Working with faxes.”
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Section C: Using telset maintenance

In this section
 Understanding telset maintenance 350

 Defining the telset maintenance password for an application 352

 Using Voice Item Maintenance 353

 Using Fax Item Maintenance 356
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Understanding telset maintenance

Introduction

Telset maintenance lets you keep voice and fax items up to date in applicat
by using your phoneset. You can always change applications, even when yo
at a remote location. When you maintain items with your phoneset, you use
services. To access these services, you require a password.

Telset maintenance password

The telset maintenance password gives you access to the two maintenance
services. Define this password in Application Builder.

The two maintenance services

To keep an application’s voice and fax items up to date, use two services:

� Voice Item Maintenance

� Fax Item Maintenance

Voice Item Maintenance
Voice Item Maintenance enables you to edit the voice items in applications 
using your phoneset. To use Voice Item Maintenance, you must know the te
maintenance password, the ID of the application in which a voice item resid
and the ID of the voice item that you want to edit.

Difference between Voice Item Maintenance and Voice Prompt 
Maintenance
Voice Item Maintenance in CallPilot replaces Voice Prompt Maintenance in 
Meridian Mail Voice Services.

In Meridian Mail Voice Services, you used Voice Prompt Maintenance to ed
your voice prompts but not your announcements. Application Builder makes
distinction between voice prompts and announcements. They are both know
voice items. You can use Voice Item Maintenance to edit any voice item wit
phoneset.
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Fax Item Maintenance
Fax Item Maintenance allows you to edit the fax items in applications by usi
your phoneset. To use Fax Item Maintenance, you must know the telset 
maintenance password, the ID of the application in which a fax item resides,
the ID of the fax item that you want to edit.

Why use the Voice Item Maintenance and Fax Item Maintenance 
services

When you use these services, you do not have to wait until you return to th
office in order to update an application.

For example, use Voice Item Maintenance if you cannot make it in to the off
because of a snowstorm. Update the greeting of your company’s main 
application to inform callers that the office is closed because of inclement 
weather.

Use Fax Item Maintenance if you find faxes at home that you want to use fo
items. If you do not have a soft copy of a fax, it is easier to receive its hard c
with Fax Item Maintenance. Use your faxphone to call Fax Item Maintenanc
and then you scan the faxes into the correct fax items.

See also

To create voice items, see Chapter 6, “Working with voice recordings.”

For information about creating fax items, see Chapter 7, “Working with faxes.”
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Defining the telset maintenance password for 
an application

Introduction

Define the telset maintenance password for an application to ensure people
know that password can use Fax Item Maintenance and Voice Item Mainten
to edit the application.

The minimum length for a password is defined in the Security Administratio
program.

For each application, you must configure a telset maintenance password on
Security tab of the File Properties sheet. 

Getting there  CallPilot Administration Client > CallPilot system > System 
Administration > Service Administration > Application Builder > 
application window

To define the telset maintenance password for an application

1 On the File menu, click Properties.

2 Click the Security tab.

3 Make sure the Telset maintenance password check box is selected.

4 In the Telset maintenance text box, type a new password.

5 In the Password confirmation box, type the password again to verify it.

6 Click OK to return to the application window.
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Using Voice Item Maintenance

Introduction

Before you use Voice Item Maintenance, configure a telset maintenance 
password on the Security tab of the File Properties sheet for each applicati
that you want to edit. 

To use Voice Item Maintenance, you need to know

� the number to dial to reach the service

� the ID and telset maintenance password of the application you want to

� the IDs of the voice items

In Application Builder, you can print application details, such as IDs, so that 
always have them available. 

Note: You cannot use Voice Item Maintenance to edit an application that is o
in Application Builder. 

To log on to Voice Item Maintenance

1 Dial Voice Item Maintenance.

2 Enter the ID of the application that you want to edit, and then press number 
sign (#).

3 Enter the telset maintenance password for the application, and then press 
number sign (#).

After you log on

After you log on to Voice Item Maintenance, what you hear depends on how
many voice items the application contains. If the application contains only a
single voice item, you hear its ID. If the application contains multiple voice 
items, you are asked for the ID of a voice item.
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To identify a voice item

Enter the ID of the voice item, and then press number sign (#).

To record a voice item

1 Press 5.

2 Speak what you want to record.

3 Press number sign (#).

4 To listen to the recording, press 2.

5 To rerecord, follow steps 1 to 3.

6 To delete the recording, press 76.

To select another voice item

1 Press 6.

2 Enter the ID of the voice item, and then press number sign (#).

To select another application

1 Press 81.

2 Enter the ID of the application, and then press number sign (#).

To change the telset maintenance password
Note: The minimum length for a password is defined in the Security 
Administration program.

1 Press 84.

2 Enter the old password, and then press number sign (#).

3 Enter the new password, and then press number sign (#).

4 Enter the new password again, and then press number sign (#).

To exit Voice Item Maintenance

Press 83.
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See also

For information about the telset maintenance password, see “Defining the telset 
maintenance password for an application” on page 352.

For information about printing application details, see “Checking and printing 
application details” on page 338.
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Using Fax Item Maintenance

Introduction

Before you use Fax Item Maintenance, configure on the Security tab

� a telset maintenance password for each application

� whether Fax Item Maintenance users can change the fax verification 
number and the confirmation prompts of fax items

Telset maintenance password

You must configure a telset maintenance password on the Security tab for e
application that you want to edit. Both Fax Item Maintenance and Voice Item
Maintenance users use the same password to access an application.

Fax verification number

The fax verification number is the phone number of the fax machine to whic
Fax Item Maintenance sends a copy of the document just scanned for a fax
This copy is a verification fax.

Make sure Fax Item Maintenance users can change the fax verification num
if they are using fax machines other than the one indicated on the Security 

Confirmation prompts

Confirmation prompts are voice recordings that give callers information abo
fax.

Consider whether you want Fax Item Maintenance users to modify confirma
prompts. Instead, you might want one voice for all confirmation prompts use
the application.

Other things to consider
To use Fax Item Maintenance, consider the following points:
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� Know which number to dial to reach Fax Item Maintenance. If you do n
know the number, ask your system administrator.

� Call Fax Item Maintenance from a faxphone.

� You cannot use Fax Item Maintenance to edit an application that is ope
Application Builder.

� Know the ID and telset maintenance password of the application you w
to edit plus the IDs of its fax items. In Application Builder, you can print
application details like IDs so you can always have them available.

To log on to Fax Item Maintenance

1 Dial Fax Item Maintenance.

2 Enter the ID of the application that you want to edit, and then press number 
sign (#).

3 Enter the telset maintenance password for the application, and then press 
number sign (#).

After you log on

After you log on to Fax Item Maintenance, what you hear depends on how m
fax items the application contains and whether you can modify their 
confirmation prompts. If the application contains only a single fax item, you
hear its ID. If the application contains multiple fax items, you are asked for 
ID of a fax item.

To identify a fax item

Enter the ID of the fax item, and then press number sign (#).

To scan a document for a fax item
Note: Fax Item Maintenance ends when you scan a document to be used 
as the fax for a fax item. If a fax item’s confirmation prompt can be modified, 
record or edit it before you scan so that you do not have to call Fax Item 
Maintenance again after you scan.
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 error 
1 Press 9.

Result: If the fax verification number can be modified, you can change the 
number to which the fax sends. If the number cannot be modified, go to 
step 5.

2 To send the fax to the default fax verification number, press 1.

3 To send the fax to another fax verification number, press 2.

4 Enter the new number, and then press number sign (#).

5 Put the document in the fax machine.

6 Press the Send key on the fax machine.

Result: The fax transmits and Fax Item Maintenance ends.

Document transmission

If a document does not scan properly, then Fax Item Maintenance sends an
message rather than a verification fax to the fax verification number.

To record a confirmation prompt for a fax item

1 Press 5.

2 Speak what you want to record.

3 Press number sign (#).

4 To listen to the prompt, press 2.

5 To delete the prompt, press 76.

To select another fax item

1 Press 6.

2 Enter the ID of the fax item, and then press number sign (#).

To select another application

1 Press 81.

2 Enter the ID of the application, and then press number sign (#).
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To change the telset maintenance password
Note: The minimum length for a password is defined in the Security 
Administration program.

1 Press 84.

2 Enter the old password, and then press number sign (#).

3 Enter the new password, and then press number sign (#).

4 Enter the new password again, and then press number sign (#).

To exit from Fax Item Maintenance

Press 83.

See also

For information about the telset maintenance password, see “Defining the telset 
maintenance password for an application” on page 352.

For information about printing application details, see “Checking and printing 
application details” on page 338.
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Section D: Archiving and restoring 
applications

In this section
 How to archive and restore applications 362
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How to archive and restore applications

Introduction

Archive applications to preserve their information. You also archive and res
to move applications from one volume ID or server to another. To move 
applications, archive one volume ID’s or server’s applications and then rest
them on another volume ID or server.

Archiving applications

When you archive, you choose the type of archive to use and select the 
applications to include.

Which type of archive to use
You can archive all your applications or only individual ones. However, you 
not need to restore all applications in an archive. Instead, you can restore o
the archived applications that you want.

Choose which applications to archive by name or by ID
While you can choose which applications to archive by name or by ID, you 
should archive all of your applications. Always consider imported applicatio
interdependence on the applications that import them. Accordingly, archive 
application and all of its imported applications.

When you restore applications

After you archive applications, you restore them on a system. Then you ope
each application in Application Builder and save it before you install it in the
SDN Table. When you open an application, you see whether it is incomplete
Unavailable block makes an application incomplete.

Why the Unavailable block appears
The Unavailable block appears in an application when something is wrong 
the way in which it was archived and restored:
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� The imported applications were not archived or restored on the system
the application in which they reside was archived and restored. As a re
an Unavailable block appears instead of the imported applications.

� An application that contains fax functionality was archived and restored
a system without fax capability. Therefore, an Unavailable block appear
place of each of the application’s fax-related blocks.

How to eliminate the Unavailable block
To eliminate the Unavailable block, determine why it appears. Follow one 
process if an application has lost fax capability, and follow a different proces
an application has lost imported applications.

Getting there  CallPilot Administration Client > CallPilot system > System 
Administration > Service Administration > Application Builder > 
application window

To fix an application with lost fax capability

1 Open the application.

2 Search for any Unavailable blocks.

3 Delete the Unavailable blocks.

4 Reconnect and reconfigure other blocks to make the application complete.

To fix an application with lost imported applications

1 Locate the imported applications.

2 Archive and restore the applications on the same system as the application 
that imports them.
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Irretrievable imported applications

If you cannot locate the imported applications, you must follow the process 
you follow for an application with lost fax capability. In an application with 
missing links, delete the Unavailable blocks and reconfigure and reconnect
application until it is complete. An application without imported applications
might not be of use, depending on the functions those imported application
supplied.
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Troubleshooting

In this chapter 
 Application Builder cannot run 366

 Client or server crashes 368

 Unavailable block appears in a restored application 370
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Application Builder cannot run

Introduction

To run on a client, Application Builder depends on services that run on the 
server. If those services are not running or if the server has crashed, then 
Application Builder cannot run.

Required services

To run, Application Builder requires the following server services:

� Administration Server

� Security Server

� Notification Server

� Volume Servers

� SQL Anywhere database

How to run Application Builder

How you get Application Builder to run depends on whether the server has 
crashed, a required service has crashed, or a required service is not runnin

To run Application Builder after the server has crashed

1 Restart the server.

2 Run Application Builder.

To run Application Builder after a required service has crashed

1 Restart the service.

2 Run Application Builder.
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To run Application Builder after a required service is not running

1 On the server, start the service.

2 Run Application Builder.

See also

For more information about running services on the server and restarting th
server, see the installation guide for your server.
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Client or server crashes

Introduction

Temporary applications are left on the client PC if either the client or the se
crashes. After you recover from the crash, you cannot use those temporary
applications. To use the applications again, you must restore them on the s

Effect of a computer crash

All applications reside on the server. From clients, you open and edit 
applications. If a client or the server crashes while you are working on an 
application, you lose the connection with the server. A temporary version of
application remains on the client. No one else can open that application, bec
it is considered locked by that client.

How to restore an application

After you recover from a crash, you open Application Builder from the client
which you were working before the crash. As Application Builder opens, it 
prompts you to restore the application. Before the application can open, yo
must restore it.

Save the application immediately after it opens. When you save, the applica
transfers its information to the server and deletes the temporary version tha
placed on the client because of the crash.

To restore an application

1 Run Application Builder.

2 When the system asks whether you want to restore the application, click 
Yes.

3 Save the application.
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See also

For information about locked applications, see “Opening applications” on page 
72.
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Unavailable block appears in a restored 
application

Introduction

The Unavailable block indicates that a function is missing in a restored 
application.

Why the Unavailable block appears
The Unavailable block appears in an application when something is wrong 
the way in which it was archived and restored:

� The imported applications were not archived or restored on the system
the application in which they reside was archived and restored. As a re
an Unavailable block appears instead of the imported applications.

� An application that contains fax functionality was archived and restored
a system without fax capability. Therefore, an Unavailable block appear
place of each of the application’s fax-related blocks.

How to eliminate the Unavailable block
To eliminate the Unavailable block, determine why it appears. Follow one 
process if an application has lost fax capability, and follow a different proces
an application has lost imported applications.

Getting there  CallPilot Administration Client > CallPilot System > System 
Administration > Service Administration > Application Builder

To fix an application with lost fax capability

1 Open the application.

2 Search for any Unavailable blocks.

3 Delete the Unavailable blocks.

4 Reconnect and reconfigure other blocks to make the application complete.
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To fix an application with lost imported applications

1 Locate the imported applications.

2 Archive and restore the applications on the same system as the application 
that imports them.

Irretrievable imported applications

If you cannot locate the imported applications, you must follow the process 
you follow for an application with lost fax capability. In an application with 
missing links, delete the Unavailable blocks and reconfigure and reconnect
application until it is complete. An application without imported applications
might not be of use, depending on the functions those imported application
supplied.

See also

For information about archiving and restoring, see the System Administration 
Guide.
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Sample applications

In this appendix
Section A: Applications for educational institutions 375

Section B: Applications for a hospital 385

Section C: Application for a sales company 391
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Section A: Applications for educational 
institutions

In this section
 The University of City main menu 376

 The University of City English menu 378

 The Faculty of Arts application 380

 The Religious Studies department menu 382
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The University of City main menu

Introduction

The main menu of the University of City directs calls to the university’s main
telephone number at different times and on different days. Because of the 
university’s location, the main menu also supports bilingual callers.
. 

. 
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Description of the university’s main menu

The main menu directs callers according to the day of the week and the tim
day. After business hours (8:30 a.m. to 5:00 p.m.) and on weekends and 
holidays, callers hear an appropriate announcement. During business hours
choose to hear the rest of the application in either English or French.

Two imported applications—an English menu and a French menu—appear
the main menu. While in either imported application, callers can press the 
Cancel (#) key and return to the main menu to choose a language. Both imp
applications contain the same functions. Their only difference is language.
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The University of City English menu

Introduction

If callers press 1 or 2 while in the main menu of the University of City, they 
to the English or French menu, respectively. The English menu, like the Fre
menu, directs callers through the various faculties and services of the unive
. 

. 

Description of the university’s English menu

The English menu enables callers to 

� dial staff by name or number

� transfer to such services as the bookstore
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� select another menu that directs them to one of the six faculties

Callers transfer to the faculty of their choice. If any transfer fails, callers hea
explanation before the application ends.

The English menu anticipates which keys, other than the menu keys, callers
press. If callers press the Cancel (#) key, they return to the main menu and
Menu block named “language.” If they press the Help (*) key, they hear deta
instructions about what they should do. If they press the Attendant (0) key, 
transfer to an attendant. Callers also transfer to an attendant if they do not 
respond or if they make too many invalid choices.
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The Faculty of Arts application

Introduction

If callers press 2 while in the Menu block named “faculties” of the English 
menu, they transfer to the Faculty of Arts. The faculty’s application directs 
callers to one of nine departments.
. 

. 
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Description of the Faculty of Arts application

From the Menu block called “departments,” callers can transfer to one of th
following departments: Anthropology, English, Fine Arts, History, Philosoph
Psychology, Language, Religious Studies, and Women’s Studies. Each 
department has its own phone number. If any transfer fails, callers hear an 
explanation before the application ends.

Like the English menu, the Arts application anticipates which keys other tha
the menu keys callers can press. If callers press the Cancel (#) key, they ret
the main menu and its Menu block named “language.” If callers press the H
(*) key, they hear detailed instructions about what they should do. If callers p
the Attendant (0) key, they are transferred to an attendant. They also transf
an attendant if they do not respond or if they make too many invalid choices
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The Religious Studies department menu

Introduction

From the Faculty of Arts application, you can transfer to the Religious Stud
department. The Religious Studies department observes the University of C
holidays, but it also observes holidays for each of the four religions of study
Christianity, Judaism, Islam, and Hinduism. The application for the departm
must direct callers appropriately on either a university or a religious holiday
. 

. 

Description of the Religious Studies department menu

Because callers can dial the Religious Studies department directly, the 
application routes callers in the same way that the University of City’s main
menu does for business hours, nonbusiness hours, and university holidays
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The Religious Studies Department also directs callers on religious holidays
During business hours and on religious holidays that do not coincide with 
university holidays, callers reach the department’s secretary. Before callers
transfer to one of the department’s four professors, the menu checks wheth
day is a holiday. If it is, callers transfer to the department mailbox where the
leave a message. All the professors use the mailbox. If the day is not a holi
callers transfer to the professor for the selected religion.

Callers also transfer to the department mailbox if any transfer fails or if a lin
busy.
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Section B: Applications for a hospital

In this section
 The Mount Sinai Hospital main menu 386

 The Mount Sinai Hospital menu for nurses 388
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The Mount Sinai Hospital main menu

Introduction

The main menu of Mount Sinai Hospital directs calls from both external call
and staff. The application contains two distinct flows. The flow for staff is 
password-protected.
. 

. 

Description of the hospital’s main menu

The Mount Sinai Hospital main menu greets callers and directs external ca
to press 1 and staff to press 2. Because staff need access to different inform
they must enter a password to identify themselves before hearing their opti
386 CallPilot
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After external callers press 1, they can choose to dial a patient by extension
number or a staff member by extension number or name. As well, they can
choose to hear a list of departments in the hospital. All of the departmental 
information, which is made up of many menus, is contained in an imported 
application.

After staff enter a password which identifies them as a doctor or a nurse, the
passed to the appropriate imported application. Both the application for doc
and the application for nurses contain similar functionality.

Throughout the application, callers press the Attendant (0), Help (*), and Ca
(#) keys. In the application, invalid choices and no responses pass to an 
attendant.
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The Mount Sinai Hospital menu for nurses

Introduction

If Mount Sinai staff members enter the password for nurses in the main me
they pass to the imported application titled “nurses.” This application contai
more Menu blocks. The application also represents the types of options ava
in the “doctors” imported application. The “nurses” application ensures that
nursing staff can retrieve and communicate essential information.
. 

. 
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Description of the menu for nurses

From their menu, nurses can access their mailboxes and leave messages f
other staff members via Express Voice Messaging. They can also hear an 
announcement that highlights daily information, such as a staff shortage in 
particular department. Nurses can call from a faxphone and retrieve the we
schedule for a department by fax.

Because nurses use the menu daily, no Help is provided. However, if nurse
make too many invalid choices, do not respond, or press the Attendant (0) 
they pass to the attendant.

If nurses press the Cancel (#) key while in the Menu block titled “choices,” t
go to the Menu block titled “external callers” in the main menu application. 
Canceling lets them go to a menu from which they can dial staff members.
Application Builder Guide 389



Sample applications  Standard 1.0
390 CallPilot



April  2000 Sample applications 
Section C: Application for a sales 
company

In this section
 The ABC Company main menu 392
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The ABC Company main menu

Introduction

Customers call the main menu of ABC Company to receive product informa
or speak to staff. Staff often call the menu to place toll-free calls when they 
on the road. The main menu allows various types of Thru-Dials and gives 
customers and staff access to different information.
. 

. 

Description of ABC Company’s main menu

The first Menu block, “mainmenu,” greets callers and ensures they identify 
themselves as either customers or staff. Customers are then directed to a l
options. Staff must enter a password to use their area of the application.
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The application presents customers with two options: to contact staff memb
by dialing their extension numbers or names, or to retrieve a list of ABC 
Company’s products.

After staff enter their password, they choose between two options. They ca
receive one of the various lists of information. Like  customers, staff can obta
product list. However, their product list contains more sensitive information,
such as wholesale prices and the names of third-party manufacturers. Staff
also retrieve information about inventory and customers.

As their second option, staff can dial a number. Before they dial the numbe
they enter a password that determines the type of Thru-Dial they are allowe
For example, salespeople can make only local calls while the manager can 
international calls.

Both the customer and staff menus let callers dial an attendant or reach an
attendant if they make too many invalid choices or do not respond. Unlike th
staff menu, the customer menu gives callers help if they press the appropri
key.
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A
access

controlling, 174
adding

voice recordings to applications, 57
affirmative statements, in voice recordings, 58
and, 214
annotations

call flow, 77
purpose, 76, 77
using, 76

Announcement block, 92, 167, 168
caller interaction, 96
configuring pause before exiting, 95
connecting, 92
example, 92
key buffering, 95
links to other blocks, 96
menu keys, 95
Parameters tab, 202

announcements
creating, 93, 95
keys to interrupt, 95
migrating from Meridian Mail Voice 

Services, 240, 268
application

accessing, 48
audience, 48, 49
call flow, 70, 71
complete, 68, 318
considerations, 49
create, 68
deleting, restrictions, 304
examples, 70, 71
making available to callers, 68
naming, 67
planning, 48, 49, 50
purpose, 48, 49
questions, 49

save, 69
Application Builder

accessing, 30
starting, 30

application building
Announcement block, 92
assigning an application ID, 67
associating fax items, 186
associating voice items, 185
blocks, description, 88
blocks, purpose, 84
blocks, types, 86, 87
Call Transfer block, 98
channels, 48
closing an application, 69
Continue block, 160, 169
creating a fax item, 51
creating a voice item, 51
creating an application, 50, 67
creating fax-on-demand applications, 171
customizing lines, 187, 188
customizing outputs, 187, 188
Date Control block, 101
Day Control block, 104
denoting keys for responses, 55
describing character keys, 54
End block, 106, 177
examples, 43, 44, 45, 55
Express Fax Messaging block, 151
Express Voice Messaging block, 149
Fax Item Maintenance block, 153
fax items, 266
Fax Select block, 108, 171
Fax Send block, 116, 171
guidelines for creating applications, 54
guidelines for creating faxes, 60
guidelines for creating voice recordings, 57, 

58
identifying the application, 54
Imported Application block, 161, 169, 170
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importing sound files, 246
importing WAV files, 246
Language Select block, 118
Menu block, 120
menu guidelines, 56
Multimedia Messaging block, 154
naming an application, 49, 50, 67
opening an application, 70
palettes, 84
Password Check block, 125
placing blocks, 182
process, 50
putting applications into service, 51, 318
resolving block name conflicts, 195
reusing applications, 51
Rotary Dial block, 130
rotary dial callers, 54
routing callers, 319
samples for a sales company, 390
samples for education, 376, 378, 380
samples for medicine, 384, 386
saving an application, 50, 51
scenarios, 43, 44, 45, 376, 378, 380, 384, 386, 

390
service directory number, 48
Service Directory Number (SDN) Table, 51
Start block, 132
stubbing lines, 188
testing applications, 51, 326
text notes, 76, 77
Thru-Dial block, 133
Time Control block, 140
Unavailable block, 143
Voice Item Maintenance block, 157

application IDs
assigning, 67

application scenarios, 43, 44, 45
application window, 41, 71

arranging multiple, 36
cascading, 36
change the default appearance of text notes, 

79
changing size, 34
changing the appearance of a text note, 78
compared to Meridian Mail Voice Services, 

40

deleting a text note, 78
hiding page breaks in, 33
increasing size, 34
moving a text note, 78
overlapping, 36
resizing a text note, 78
setting zoom magnification, 35
showing page breaks in, 33
stacking, 36
text notes, 77
tiling, 36
viewing at full screen, 34

application windows, 70, 71
applications

adding voice recordings, 57
application administration, 330
application windows, 71
archive types, 360
archiving, 360
assigning an application ID, 67
audience, 48
blocks, description, 88
blocks, purpose, 84
blocks, types, 86, 87
call flow, 71
channels for, 48
choosing what to archive, 360
closing, 69
connecting, 170
containing migrated fax, 269
containing migrated voice, 241, 242
creating, 50, 67
deleting, 74
denoting keys for responses, 55
describing character keys, 54
destination, 169
editing, 70
example of an open application, 71
examples, 43, 44, 45, 55
exporting, 169, 300, 301
exporting, precautions, 303
exporting, purpose, 310
fax items in, 266
guidelines for creating, 54
guidelines for creating faxes, 60
guidelines for creating menus, 56
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guidelines for creating voice recordings, 57, 
58

help for users, 55
identifying the application, 54
imported, restrictions, 304
importing, 86, 169, 170, 300, 301
importing, precautions, 303, 304
importing, purpose, 312
irretrievable, 144
locking, 70, 73
maintaining, 330, 331, 332, 336
maintaining, overview, 330
maintaining, using telset maintenance, 331
multiple

working with, 36
naming, 49, 67
opening, 70
overview, 50
palette, 84
pasting into other applications, 290
planning, 48
process, 50
purpose, 48
putting into service, 51, 318
questions, 48
resolving block name conflicts, 195
resolving fax item ID conflicts, 294
resolving fax item name conflicts, 294
resolving voice item ID conflicts, 260
resolving voice item naming conflicts, 260
restoring, 144, 360
restoring after client PC crash, 73
restoring after server crash, 73
reusing, 51
reusing functionality, 300
reusing functionality, precautions, 303
rotary dial callers, 54
routing callers, 319
sample, for a sales company, 390
sample, for education, 376, 378, 380
sample, for medicine, 384, 386
saving, 51, 67
saving under other names, 300, 308
saving under other names, precautions, 303
scenarios, 43, 44, 45
source, 169

storing on server, 67, 70
telephone numbers for, 48
telset administration, 330
testing, 51, 326
unlock, 69
unlocking, 70
unsuccessful exports, 304
unsuccessful imports, 304
updating, 330

online, example, 253
using text notes, 76, 77

applicaton
close, 69

archiving
applications, 360
choosing types, 360
choosing what to archive, 360
restoring from archives, 360

arranging
multiple application windows, 36

assembling blocks, 50
associating

fax items, 50, 109
voice items, 50

Attendant key, 112
attendant, default, for caller transfer, 99
audience

for application, 48, 49
audience considerations, 48
automated attendant

example, 44

B
basic blocks, 86

example, 86, 87
purpose, 86

blocks
annotations, 77
Announcement block, 92, 95, 167, 168, 202
assembling, 50
associating fax items, 50
associating voice items, 50
basic blocks, 86, 87
block palette, 84
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Call Transfer block, 98, 176, 205
configuring, 89, 201
configuring, definition, 89
connecting, 50, 89
connecting, definition, 89
Continue block, 160, 169, 170
copying, 258
Date Control block, 101, 174, 208
Day Control block, 104, 174, 208, 210, 211
description, 88
End block, 106, 170, 177
Express Fax Messaging block, 151, 230
Express Voice Messaging block, 149, 228
Fax Item Maintenance block, 153
fax items and, 186
Fax Select block, 108, 171, 213
Fax Select block, copying, 290
Fax Send block, 116, 171
for voice recording, 92, 98, 101, 104, 106, 108, 

116, 118, 120, 125, 130, 132, 133, 140, 
143

imported application, 86, 87, 160, 161
Imported Application block, 161, 169, 170
importing, 87
knowing which to configure, 183
Language Select block, 118, 216
Menu block, 120, 168, 218
Multimedia Messaging block, 154
opening, 201
output, 88
Password Check block, 125, 221
pink border, 88
placing, 50, 182
purpose, 84
resolving name conflicts, 195
reusing, 300
Rotary Dial block, 130, 176
Speech Activated Messaging block, 155, 232
Start block, 132
system blocks, 86, 149, 151, 153, 154, 155, 

157
text notes, 77
Thru-Dial block, 133, 168, 224
Time Control block, 140, 174, 208, 211
types, 86
Unavailable block, 143

understanding function, 50
viewing outputs, 201
viewing properties, 201
Voice Item Maintenance block, 157
voice items and, 185

C
call flow, 70, 71
Call Transfer block, 98, 176

caller interaction, 99
configuring, 98
connecting, 98
example, 98
Parameters tab, 205

callback, for fax delivery, 109, 171, 267, 321
caller interaction, configuring, 96, 99, 103, 112, 

122, 128, 137
caller’s choice delivery, 267
callers

routing to services, 319
to application, 48
transfer to specific extension, 99
using rotary dial, 54

Cancel key, for Fax Select block, 111
cascading application windows, 36
change the default appearance of text notes in

application window, 79
changing

size of application window, 34, 35
telset maintenance passwords, 352, 357

changing the appearance of a text note, 78
channels

for applications, 48
checking application details, 331
client crash, restarting Application Builder after, 

366
closing an application, 69
complete application, 318

compared to saved application, 67
required elements, 68

configuring
blocks, 89, 201
blocks, definition, 89
Call Transfer block, 98
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caller interaction, 96, 99, 103, 122, 128, 137
Date Control block, 101, 208
date period, 102
Day Control block, 104, 208, 211
Express Fax Messaging block, 151
Express Voice Messaging block, 149
fax cover page used, 324, 325
fax delivery, 322, 323
Fax Select block, 108
Fax Send block, 116
holidays, using Day Control block, 104
Language Select block, 118
Menu block, 120
Password Check block, 125
pause before exiting, 95
Service Directory Number (SDN) Table, 321
session profiles, 320
Thru-Dial block, 133
Time Control block, 140, 208
time period, 141
transmission order for fax cover page, 325

confirmation prompts, 354, 356
blank, 274
creating for faxes, 274
definition, 266
editing, 282
for faxes, 274
for faxes, blank prompts, 274
purpose, 109

conflict
when pasting a fax item, 291

connecting
Announcement block, 92
applications, 170
blocks, 50, 89
blocks, definition, 89
Call Transfer block, 98
Continue block, 170
Date Control block, 101
Day Control block, 104
Fax Select block, 108
Imported Application block, 162
Language Select block, 118
Menu block, 120
Password Check block, 125
Rotary Dial block, 130

Start block, 132
Thru-Dial block, 133
Time Control block, 140

Continue block, 160, 169, 170
connecting, 170
links to other blocks, 160

controlling
access, 174

copying
blocks, 258
blocks, to reuse, 300
fax items, 290
Fax Select block, 290
into Define Fax Items dialog box, 290
using Define Voice Items dialog box, 258
voice items, 258

cover page, including on faxes, 60
create an application, 68
creating

application, 50
fax ID, 272
fax items, 272
voice items, overview, 244
voice recordings, 93

creating a menu
application window, 41
compared to Meridian Mail Voice Services, 

40
overview, 40, 41, 42
planning, 42

creating text notes in an application window, 77
customized prompts

definition, 238
customizing

lines, 187, 188
outputs, 187, 188

D
Date Control block, 101, 174

configuring, 101, 208
connecting, 101
example, 101
links to other blocks, 103
Parameters tab, 208
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date period
calls at other times, 102
configuring, 102, 208
definition, 101

date subperiod
definition, 102

dates
controlling fax delivery, 174

Day Control block, 104, 174
caller interaction, 103
configuring, 104, 208, 211
configuring holidays, 104
connecting, 104
example, 104
links to other blocks, 105
Parameters tab, 210

day, configuring, 208
defaults

attendant, for caller transfer, 99
attendant, transferring callers to, 99
fax delivery, 98, 107, 150, 152, 153, 154, 155, 

157
Define Fax Items dialog box

copying fax items into, 290
pasting fax items into, 290

Define Voice Items dialog box
copying with, 258

defining
voice items, 247

delayed prompts, 111
deleting

application, 74
application, restrictions, 304
fax items, 282

deleting a text note in an application window, 78
denoting keys for responses, 55
describing voice items, 245
desktop, arranging, 36
destination application, 169
dialing options

name dialing, 135
number, 135

dialog boxes
copying into Define Fax Items dialog box, 290
Define Voice Items dialog box, copying with, 

258

Import..., 313
pasting into Define Fax Items dialog box, 290
Save As, 308
Specify Phoneset dialog box, 245
Undo Import, 314
Voice Recorder dialog box, 246

disabled key buffering, 165
disconnecting

after creating voice item, 246
display

changing application window size, 34
enlarging application window, 34
full screen window, 34
setting zoom magnification, 35

displaying
page breaks, in application window, 33
palette, 32
parts of main window, 31
toolbar, 33

document transmission, 356
DTMF capability, 176

E
editing

applications, 70
confirmation prompts, 282
fax items, 282

editing text notes in an application window, 77
eliminating Unavailable block, 144
enabled key buffering, 164
End block, 106, 170, 177

links to other blocks, 107
purpose, 106

examples
adding menus, 43
automated attendant, 44
fax options, 44
key buffering, 165
main menu, 45
of applications, 43, 44, 45

exiting
from Fax Item Maintenance, 357
from Voice Item Maintenance, 352

exiting from the Application Builder, 30
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exporting applications, 169, 300, 301
precautions, 303, 304
prerequisite for importing, 310
purpose, 310
unsuccessful transfers, 304

Express Fax Messaging block, 151
configuring, 151
fax phone for, 151
Parameters tab, 230
requirements, 151

Express Voice Messaging block, 149, 228
configuring, 149

extension numbers
fixed length, 134
fixed-length, purpose, 134
number sign, 135
variable, 134

F
fax delivery

dates, 174
default, 98, 107, 150, 152, 153, 154, 155, 157
times, 174

fax ID
creating, 272

Fax Item Maintenance, 349
document transmission, 356
exiting, 357
logging in, 354, 355
prerequisites, 354
setting passwords, 354

Fax Item Maintenance block, 153
fax items

associating, 109
associating with blocks, 186
blank confirmation prompts, 274
confirmation prompt definition, 266
confirmation prompts for, 274
confirmation prompts for, creating, 274
conflict, 291
copying, 290
creating, 272
custom cover page, 110, 171, 321
defining maximum length, 109, 171, 321

defining maximum number, 109, 171, 321
definition, 108, 266
deleting, 282
editing, 282
fax delivery method, 109, 171, 321
identifying, 355
IDs for, 291
importing, 273
including in application, 266
migrated formats, 269
migrating from Meridian Mail Voice 

Services, 240, 268, 269
multiple, 109
naming, 272, 291
pasting, 290, 291
saving, 272, 273
scanning documents for, 355
scanning faxes, 273
selecting, 356
selecting another application, 356
session profile and, 109, 171, 266, 321
sponsor fax items, 110, 171, 321
TIFF-F format, 273
transmission errors, 110, 171, 321

Fax Select block, 108, 171
caller interaction, 112
configuring, 108
connecting, 108
copying, 290
example, 108
links to other blocks, 112
Parameters tab, 213
pasting into other applications, 290

Fax Send block, 116, 171
configuring, 116
links to other blocks, 116

fax verification number, 354
faxes

callback delivery, 267
caller’s choice delivery, 267
checking spelling in, 61
configuring callback delivery, 322
configuring cover page, 324
configuring custom cover page, 325
configuring for caller’s choice delivery 

method, 323
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configuring same-call delivery, 322
configuring transmission order for fax cover 

page, 325
confirmation prompts, 354, 356
cover page, 60
creating, 51
delivery in application, 110, 172
delivery types, 267
fax verification number, 354
formatting, 60
guidelines for creating, 60
header on, 60
logo on, 60
margins in, 60
maximum per call, 266
migrated, recognizing, 268
option example, 44
requirements, 109
restoring fax functionality, 144
same-call delivery, 267
trimtab on, 60
typefaces for, 61

fax-on-demand applications
creating, 171, 214
definition, 171

fixed-length extension numbers, 134
format

migrated announcements, 241
migrated fax, 269
migrated menus, 240
migrated voice, 241

formatting
faxes, 60

G
getting started

overview, 42
greetings

system prompts, 136
Thru-Dial, 136

guidelines
for creating faxes, 60
for creating menus, 56
for creating recordings, 57, 58

guidelines for creating applications, 54

H
header, on faxes, 60
Help

for users, 55
for users, in voice recordings, 58
online, 20

hiding
block outputs, 187
page breaks, in application window, 33
parts of main window, 31

hiding page breaks in an application window, 33
hiding the palette, 33
hiding the toolbar, 33
holidays, configuring for, 104

I
ID conflicts, resolving, 260, 294
identifying

fax items, 355
migrated fax, 268
migrated voice, 240

IDs
assigning, 67
defaults for fax items, 291
defaults for voice items, 239
for voice items, 244

Import... dialog box, 313
Imported Application block, 161, 169, 170

connecting, 162
imported application blocks, 86

Continue block, 160
example, 87
Imported Application block, 161
purpose, 87

importing
application blocks, 87
applications, 169, 170
fax items, 273
sound files, 246
voice items, 250
WAV files, 246, 250
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importing applications, 300, 301
precautions, 303, 304
purpose, 312
restrictions, 304
unsuccessful transfers, 304

interface
overview, 41

interrupting an announcement, 96
invalid passwords, 127

K
key buffering, 95

definition, 164
disabled, 165
disabled, effect, 166
effect, 164, 165
enabled, 164
examples, 165

keys
for Help, 55
for responses, 55
menu, 95, 120, 164
on telephone pad, 54
to interrupt an announcement, 95

L
Language Select block, 118

configuring, 118
connecting, 118
effect on application, 118
example, 118
Parameters tab, 216

limits
on number of faxes per call, 266

lines
customizing, 187, 188
stubbing, 188

locking an application, 70
after server crash, 73

logo
including on faxes, 60

M
main menu

example, 45
main window

hiding parts, 31
moving palette from, 33
showing parts, 31

maintaining applications, 330, 331, 332
checking application details, 331, 336
printing application flow document, 336
printing applications, 336
printing applications, benefits, 337
printing block details document, 337
printing voice and fax item documents, 337
responsibility, 330
using telset maintenance, 331

making voice recordings, guidelines, 57, 58
margins, in faxes, 60
meaning of Unavailable block, 368
Menu block, 120, 168

caller interaction, 122
configuring, 120
connecting, 120
example, 120
invalid response prompt, 121
links to other blocks, 122
menu choices greeting, 121
no response prompt, 121
Parameters tab, 218

menu keys, 95, 120, 164
menus

completing, 121
creating, 40, 41, 42
guidelines for creating, 56
migrating from Meridian Mail Voice 

Services, 240, 268
options, 56
options in, 56

Meridian Mail Voice Services
compared to Application Builder, 40
interface, 40
migrating announcements, 240, 268
migrating fax items, 240, 268, 269
migrating menus, 240, 268
migrating voice items, 241, 242
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migrated announcements
format, 241
from Meridian Mail Voice Services, 240, 268

migrated fax
applications using, 269
format, 269
recognizing, 268

migrated fax items
from Meridian Mail Voice Services, 240, 268, 

269
migrated menus

format, 240
from Meridian Mail Voice Services, 240, 268

migrated voice
applications using, 241, 242
formats, 241
recognizing, 240

migrated voice items
from Meridian Mail Voice Services, 241

migrating
fax items from Meridian Mail Voice Services, 

269
voice items from Meridian Mail Voice 

Services, 242
modifying

size of application window, 34
zoom magnification for application window, 

35
moving

palette, 33
moving a text note in an application window, 78
Multimedia Messaging block, 154
multiple fax items, 109

N
name dialing, 135

configuring, 135, 136
configuring with number dialing, 136
disabling, 136

naming
applications, 49, 50
blocks, 195
defaults for fax items, 291
defaults for voice items, 239

fax items, 272
voice items, 244

naming conflicts, resolving, 260, 294
navigating

through multiple applications, 36
number dialing, 135

configuring, 135
configuring with name dialing, 136

number sign
effect on extension numbers, 135

O
online Help, 20
online updating, 252, 282, 332

example, 253
opening

application, 70
Application Builder, 30
blocks, 201

options
in menus, 56
sequence in menus, 56

output
blocks, 88

outputs
blocks, 88
customizing, 187, 188
hiding, 187

overlapping application windows, 36

P
paced speech recognition, 155
page breaks

hiding, in application window, 33
showing, in application window, 33

palette
moving, 33
showing, 32

Password Check block, 125, 127
caller interaction, 128
configuring, 125
connecting, 125
defining passwords, 126
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example, 125
greeting, 126
Parameters tab, 221

passwords
defining, 126
duplicating, 126
for Fax Item Maintenance, 354
for telset maintenance, 350
for telset maintenance, changing, 352
invalid, 127
retaining, 127
telset maintenance, changing, 357

pasting
blocks, to reuse, 300
fax items, 290, 291
Fax Select block, into other applications, 290
into Define Fax Items dialog box, 290
into other applications, 290
voice items, 258

pause before exiting, configuring, 95
pink border, blocks, 88
placing blocks, 50, 182
planning

an application, 50
application, 48, 49, 50
menu, overview, 42

positioning blocks, 182
printing

application details, 252, 282, 331
application flow document, 336
applications, 336
applications, benefits, 337
block details document, 337
fax item details, 282
voice and fax item documents, 337
voice item details, 252

prompts, delayed, 111
prompts, system, 136
putting applications into service, 51

R
recording

disconnecting after, 246
specifying the telephone set, 245

voice items, 246, 248, 352
voice items, using a telephone, 245

recordings, voice
active voice in, 57
adding to applications, 57
affirmative statements in, 58
goal-action sequence, 57
guidelines for creating, 57, 58
Help

for users, 58
language in, 57
recording guidelines, 57, 58
scripting guidelines, 57

recovering
from client crash, 366
from server crash, 364, 366

Related information products, 18
resizing a text note, 78
resolving

block name conflicts, 195
fax item ID conflicts, 294
fax item naming conflicts, 294
voice item ID conflicts, 260
voice item naming conflicts, 260

responses, keys for, 55
restarting Application Builder

after client crash, 366
after server crash, 364, 366

restoring
after server crash, 366
applications, 73, 331, 360

restoring the contents of an application window
to default size, 34

restriction/permission list, 135
restrictions

deleting applications, 304
imported applications, 304

returning the palette to the main window, 33
reusing

application functionality, 300
application functionality, precautions, 303
blocks, 300

reusing applications, 51
exporting, 300, 301, 310
exporting, precautions, 303
importing, 300, 301, 312
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importing, precautions, 303, 304
saving under other names, 300, 308
saving under other names, precautions, 303

Rotary Dial block, 130, 176
connecting, 130
example, 130
links to other blocks, 131

rotary dial callers, 54
routing callers, 319
running Application Builder, 30

S
same-call delivery, 109, 171, 267, 321
sample applications

for a sales company, 390
for education, 376, 378, 380
for medicine, 384, 386

Save As dialog box, 308
saving

applications, 50, 51
applications, compared to completed 

applications, 67
applications, using other names, 300, 308
applications, using other names, precautions, 

303
fax items, 272
in TIFF-F format, 273
voice items, 245

saving an application, 69
scanning

documents, for fax items, 355
faxes, for fax items, 273

scenarios, 43, 44, 45
adding menus, 43
automated attendant, 44
fax options, 44
main menu, 45

seeing an application, 70
selecting

fax items, 356
voice items, 352

sequence in menus, 56
server

storing applications, 67, 70

server crash
effect on applications, 73
meaning of Unavailable block, 368
restarting Application Builder, 364
restoring applications, 73

server crash, restarting Application Builder 
after, 366

Service Directory Number (SDN) Table
configuring applications in, 48
configuring session profiles, 320
configuring transmission order for fax cover

page, 325
defining fax items in, 109, 171, 321
SA Messaging block, 155
selecting a cover page, 324
selecting a custom cover page, 325
services controlled, 321
SR channel, 155

session profile
configuring, 320
defining invalid password entries, 127
definition, 320
effect on fax items, 266
examples, 320
fax items and, 109, 171, 321
multiple, 320
purpose, 321
setting maximum number of faxes per call, 

266
setting

date, 208
day, 208
password, for Fax Item Maintenance, 354
time, 208

showing
page breaks, in application window, 33
palette, 32
parts of main window, 31
toolbar, 33

shrinking the contents of an application window, 
34

sound files
importing, 246

source application, 169
specific extension, transferring callers to, 99
Specify Phoneset dialog box, 245
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Speech Activated Messaging block, 155
Parameters tab, 232

speech recognition
paced, 155

stacking
application windows, 36

Start block, 132
connecting, 132

starting
Application Builder, 30
applications, 318

starting Application Builder
troubleshooting, 364

stubbing lines, 188
system blocks, 86

Express Fax Messaging block, 151
Express Voice Messaging block, 149
Fax Item Maintenance block, 153
Multimedia Messaging block, 154
purpose, 86
Speech Activated Messaging block, 155
Voice Item Maintenance block, 157

system prompts, 93, 136
available prompts, 93
definition, 238

T
telephone numbers

for applications, 48
telephone pad

key names, 54
keys for responses, 55
keys to interrupt an announcement, 95

telephone, Rotary Dial, 176
telset maintenance

changing passwords, 352, 357
Fax Item Maintenance, 349
password, 348, 350
purpose, 348
Voice Item Maintenance, 348

testing applications, 51, 326
text note

deleting, 78
move, 78

text notes
call flow, 77
change the default appearance, 79
changing the appearance, 78
creating, 77
editing, 77
purpose, 76, 77
resizing, 78
using, 76

Thru-Dial
greeting, 136
system prompt, 136

Thru-Dial block, 133, 168
caller interaction, 137
configuring, 133
connecting, 133
example, 133
links to other blocks, 137
Parameters tab, 224

TIFF-F
for fax image file exchange, 273
saving in, 273

tiling
application windows, 36

Time Control block, 140, 174
configuring, 140, 208
connecting, 140
example, 140
links to other blocks, 142
Parameters tab, 211

time period
configuring, 141, 208
definition, 140
overlapping, 141

time subperiod
definition, 141

times
controlling fax delivery, 174

toolbar
showing, 33
Voice Recorder, 244

Touch tone capability, 176
transferring callers

to a default attendant, 99
to a specific extension, 99

transmission errors, for fax items, 110, 171, 321
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transmitting fax, 356
trimtab on faxes, 60
troubleshooting

after required service crash, 364
after server crash, 366
Application Builder does not run, 364
fax item ID conflicts, 294
fax item naming conflicts, 294
irretrievable imported applications, 144
lost fax functionality, 144
lost imported applications, 144
starting Application Builder, 364
Unavailable block, 360, 361, 368
unsuccessful application exports, 304
unsuccessful application imports, 304
voice item ID conflicts, 260
voice item naming conflicts, 260

typefaces
for faxes, 61

U
Unavailable block, 143

after server crash, 368
eliminating, 144
meaning, 360, 361, 368

Undo Import dialog box, 314
unlocking an application, 70
unlocking applications, 69
updating

applications, 330
online, 252, 282, 332

updating online, 332
example, 253

users
feedback, 58
for application, 48

users, for application, 48
using

text notes, 76, 77
using text notes, 76, 77

V
variable extension numbers, 134

viewing
block outputs, 201
block properties, 201
enlarging application window, 34
full screen window, 34
setting zoom magnification, 35

Voice Item Maintenance, 348
exiting, 352
logging in, 351
prerequisites, 351

Voice Item Maintenance block, 157
voice items, 93

associating with blocks, 185
copying, 258
creating, overview, 244
defining, 247
definition, 238
describing, 245
ID for, 244
identifying, 352
importing, 250
migrated formats, 241
migrated, recognizing, 240
migrating from Meridian Mail Voice 

Services, 241, 242
naming, 244
pasting, 258
recording, 246, 248, 352
recording, using a telephone, 245
saving, 245
selecting, 352
selecting another application, 352
WAV format, 185

Voice Recorder dialog box, 246
Voice Recorder toolbar, 244
voice recordings

active voice in, 57
adding to applications, 57
affirmative statements in, 58
Announcement block, 92
Announcement block example, 92
Call Transfer block, 98
Call Transfer block example, 98
confirmation prompts, 354, 356
confirmation prompts for faxes, 274
creating, 51, 93
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customized prompts, 238
Date Control block, 101
Date Control block example, 101
Day Control block, 104
Day Control block example, 104
End block, 106
Fax Select block, 108
Fax Select block example, 108
Fax Send block, 116
goal-action sequence, 57
guidelines for creating, 57, 58
help for users, 58
language in, 57
Language Select block, 118
Language Select block example, 118
Menu block, 120
Menu block example, 120
Password Check block, 125
Password Check block example, 125
purpose, 238
recording guidelines, 57, 58
Rotary Dial block, 130
Rotary Dial block example, 130
scripting guidelines, 57
Start block, 132
system prompts, 93, 238
Thru-Dial block, 133
Thru-Dial block example, 133
Time Control block, 140
Time Control block example, 140
types, 238
Unavailable block, 143
voice items, 93, 238
Voice Recorder toolbar, 244

Voice Services
compared to Application Builder, 40

W
WAV files

importing, 246, 250
WAV format, for voice items, 185
windows

building an application, 41
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